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Preface 
 
This document list all the fields and features available in the Wavewin software 

 
 
This document is intended for use by individuals working in protection, engineering, and system operations.
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C H A P T E R  

Fields & Features
 
This chapter describes all of the fields and features available in the software.  They are listed alphabetically 
for your convenience. 

ACTIVE TOPIC - HELP 
Location: All child windows 
 
Description: Display the active window
 
Activation: Menu: Alt-H, T 

ADJUST FILES TIME 
Location: Analysis  
 
Description: The Adjust Files Time 

Time” dialog select the "Adjust Files Time" menu option under the "Data" menu. You can 
specify to add or subtract a give
desired time increment for the hour, minutes, seconds and milliseconds. If there is no 
adjustment needed on a specific time field enter 0.

 
Activation: Menu: Alt-D, J 
 
Comments: To always have the fil

a file check the "Adjust Open Time" check box. To show the file’s original date and time 

click on the “Restore Original” button 
under the “Data” menu

 
See Also: Adjust Files Time in Chapter 1

ALIGN CHANNEL DATA 
Location: Analysis (Universal Viewer)
 
Description: The Align Channel Data option allows for aligning the 

Order All-Pass Fractional filter. To open the “Align Channel Data” dialog select the "Align 
Channel Data" menu option under the "Channel" menu. Enter the phase shift for each 
analog channel. If the filter does not apply to
field blank. Click the “Run Thiran Filter” to apply the filter.

 
Activation: Menu: Alt-C, T 
 
Fields: Phase Shift:  

A0:   
A1:   
A2:   
A3:   
Always Apply:  
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Fields & Features 
the fields and features available in the software.  They are listed alphabetically 

Display the active window’s Help file. 

The Adjust Files Time allows for adjusting the time of the open file. To open the “Adjust File 
Time” dialog select the "Adjust Files Time" menu option under the "Data" menu. You can 
specify to add or subtract a given time increment from the files current time. Enter the 
desired time increment for the hour, minutes, seconds and milliseconds. If there is no 

needed on a specific time field enter 0. 

To always have the file's time automatically adjusted when a specific driver is used to open 
a file check the "Adjust Open Time" check box. To show the file’s original date and time 

click on the “Restore Original” button  or select the “Restore Original Data” menu option 
the “Data” menu 

Adjust Files Time in Chapter 1 

(Universal Viewer) 

The Align Channel Data option allows for aligning the channel data using the Thiran 3
Pass Fractional filter. To open the “Align Channel Data” dialog select the "Align 

Channel Data" menu option under the "Channel" menu. Enter the phase shift for each 
If the filter does not apply to a specific analog channel, e

. Click the “Run Thiran Filter” to apply the filter. 

The phase shift angle for each analog channel. 
The Thiran A0 coefficient for each analog channel.

 The Thiran A1 coefficient for each analog channel.
 The Thiran A2 coefficient for each analog channel.
 The Thiran A3 coefficient for each analog channel.
 Always apply the filter when opening files for the active 

Chapter 1 – Fields & Features 
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the fields and features available in the software.  They are listed alphabetically 

allows for adjusting the time of the open file. To open the “Adjust File 
Time” dialog select the "Adjust Files Time" menu option under the "Data" menu. You can 

time increment from the files current time. Enter the 
desired time increment for the hour, minutes, seconds and milliseconds. If there is no 

e's time automatically adjusted when a specific driver is used to open 
a file check the "Adjust Open Time" check box. To show the file’s original date and time 

or select the “Restore Original Data” menu option 

channel data using the Thiran 3rd 
Pass Fractional filter. To open the “Align Channel Data” dialog select the "Align 

Channel Data" menu option under the "Channel" menu. Enter the phase shift for each 
a specific analog channel, enter 0 or leave the 

 
og channel. 

The Thiran A1 coefficient for each analog channel. 
The Thiran A2 coefficient for each analog channel. 
The Thiran A3 coefficient for each analog channel. 
Always apply the filter when opening files for the active driver. 
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Coefficients:  
 
Options: Calculate Coefficients

Run Thiran Filter: 
Esc/Cancel:  

 
Comments: To always have the filter automatically applied when a specific driver is used to open a file 

check the "Always Apply" check box. To show the file’s original date and time click on the 

“Restore Original” button 
“Data” menu. 

 
See Also: Align Channel Data in Chapter 1

AMETEK TR*/DL*/PQR128 DRIVER

Location: File Manager (Universal Viewer)
 
Description: Change the driver at the cursor position to the Ametek TR*/DL*/PQR128 driver.
 
Activation: Menu: Alt-D, P 
 
Comments: An error message is displayed if the selected file is not a valid Ametek file. Files that have a 

“.AMT” extension or files 
has no extension are automatically tagged as Ametek files.

 
See Also: Display Oscillography in Chapter 1

Associating File Types in Chapter 1

ANALOG MARK/UNMARK ALL 
Location: Analysis 
 
Description: Mark all analog channels if there are no analog channels marked 

marked channels. 
 
Activation: Menu: Alt-C, N 
 
Comments: The channels ID and titles a

unmark all the analog and digital channels.

ANALOG TABLE VIEW  
Location: Analysis  
 
Description: Displays the channel titles, ASV, units, and
 
Comments: Use the  button or the shift

button is located to the right of the analog table headers.
 
See Also: Viewing Analog Data in Analysis Quick Start.

 Calculate coefficients at run or use the entered coefficients

Calculate Coefficients: Calculate the Thiran coefficients for each analog channel.
Run the Thiran filter. 
Exit the dialog without executing the command. 

To always have the filter automatically applied when a specific driver is used to open a file 
check the "Always Apply" check box. To show the file’s original date and time click on the 

“Restore Original” button  or select the “Restore Original Data” menu option under the 

Align Channel Data in Chapter 1 

RIVER 
File Manager (Universal Viewer) 

Change the driver at the cursor position to the Ametek TR*/DL*/PQR128 driver.

An error message is displayed if the selected file is not a valid Ametek file. Files that have a 
“.AMT” extension or files that have the first 2 characters in the name as “ZQ” and the file 
has no extension are automatically tagged as Ametek files. 

Display Oscillography in Chapter 1 
Associating File Types in Chapter 1 

all analog channels if there are no analog channels marked otherwise

The channels ID and titles are displayed in light red when marked. Press F8 to mark or 
unmark all the analog and digital channels. 

Displays the channel titles, ASV, units, and associated data values. 

button or the shift-right/left arrow keys to scroll the columns in the table.  This 
button is located to the right of the analog table headers. 

Viewing Analog Data in Analysis Quick Start. 

Calculate coefficients at run or use the entered coefficients. 

Calculate the Thiran coefficients for each analog channel. 

 

To always have the filter automatically applied when a specific driver is used to open a file 
check the "Always Apply" check box. To show the file’s original date and time click on the 

ct the “Restore Original Data” menu option under the 

Change the driver at the cursor position to the Ametek TR*/DL*/PQR128 driver. 

An error message is displayed if the selected file is not a valid Ametek file. Files that have a 
that have the first 2 characters in the name as “ZQ” and the file 

otherwise unmark all the 

re displayed in light red when marked. Press F8 to mark or 

right/left arrow keys to scroll the columns in the table.  This 
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ANIMATED CAD- DXF 
Location: Device Manager 
 
Description: Display the DXF window to periodically execute the device’s assigned drivers and update 

the parsed information into the appropriate graphical DXF drawing. 
 

Activation: Direct: F8 – menu button  
Menu: Alt-O, D 

 
Comments: Information parsed by the device drivers can be used to populate a CAD-DXF drawing.  In 

order to populate the drawing, control points must be added to offset the parsed data.  The 
word “Device”, the associated device number, and/or the device title (optional) indicates a 
control point.  For example, if the CAD-DXF reader encounters the text “Device 12 SEL-
321” in the DXF file, the information parsed by the assigned driver is offset at the upper left 
corner of the letter “D” in the word “Device”.  Refer to Appendix B for more information on 
setting up DXF control points. 
 
DXF drawings can be created using an off the shelf program such as AutoCAD, Turbo CAD, 
Technical Visio, Drafix, or MEDUSA.  The animated CAD-DXF reader also supports layered 
objects and multiple paging views.  To activate the animated CAD-DXF display, click the 
DXF menu button or press F8. 

 
See Also: Animated CAD-DXF in the Device Manager Quick Start. 

APPEND LOGS 
Location: File Manager 
 
Description: Combine a number of log files (ABB Load Profile, Comtrade Logs and SDC Logs), of the 

same types (the columns match), into one comma delimited file with the extension .CSV.    
 
Activation: Menu: Alt-O, R, A 
 
Comments: The files must be of the same type (columns must be equal and data extracted from the 

same device).  The save file can be displayed in a table or plotted in the log data viewer. 
 
See Also: Combine Logs 

APPEND OPEN FILES 
Location: Analysis  
 
Description: Combine a number of open files of the same type (the analog/digital channel titles must 

match) in time.  All of the currently open waveform files will be appended into a new 
analysis window. 

 
Activation: Menu: Alt-F, F, D (Append the open files by Discarding the common times) 

Menu: Alt-F, F, B (Append the open files Back-to-Back) 
 
Comments: The files must be of the same type (the analog/digital channel titles must match).  The 

results in the new analysis window can be saved in a Comtrade file for archiving. 
 
See Also: Append Waveform Files 

Append Open Files in Analysis Quick Start 
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APPEND WAVEFORM FILES 
Location: File Manager 
 
Description: Combine a number of waveform files of the same types (the analog/digital channel titles 

must match) in time into an analysis window. 
 
Activation: Menu: Alt-O, W, A, D (Append waveform files by Discarding the common times) 

Menu: Alt-O, W, A, B (Append waveform files Back-to-Back) 
 
Comments: The files must be of the same type (the analog/digital channel titles must match).  The 

results in the data analysis window can be saved in a Comtrade file for archiving. 
 
See Also: Append Open Files 

Append Waveform Files in File Manager Quick Start 

ASCENDING SORT 
Location: All Tables 
 
Description: Sort the device columns in ascending order with respect to the selected sort field.   
 
Activation: Menu: Alt-S, A 
 
Comments: To change the sort field, place the cursor in the desired column and select “Set Sort Field” 

in the “Sort” menu.  The sort field is displayed in the status bar at the bottom of the window.  
To sort the columns directly press the column header button.  The header buttons toggle 
between ascending and descending order. 

 
See Also: Descending Sort  

Sorting in the Quick Starts 

ASCII DRIVER 
Location: File Manager 
 
Description: Display the file at the cursor position in the ASCII text editor. 
 
Activation: Menu: Alt-D, 1 
 
See Also: ASCII Editor 

ASCII EDITOR 
Location: File Manager 
 
Description: Edit the ASCII file at the cursor position.  
 
Activation: Direct: F2 

Menu: Alt-O, A (Options menu) or Alt-D, 1 (Driver menu) 
 
Comments: The file content is displayed in text format.  Use the up arrow, down arrow, left arrow, right 

arrow, page up, page down, home, end, Ctrl-home and Ctrl-end keys or the scroll bar to 
navigate through the data and the Edit menu options to cut, copy, or paste text.  A 
maximum of ten ASCII Editors may be opened simultaneously.  



 

ASCII EVENT FILES 
Location: Device Manager 
 
Description: View the selected device event file in an 

table indicates the type of editor 
is defined in the device record.  To open the device record

 

Activation: Direct: F6 – menu button 
Menu: Alt-O, E 

 
Comments: The file content is displayed in text format.  Use the up arrow, down arrow, left arrow, right 

arrow, page up, page down, home, end, Ctrl
navigate through the data and the Edit menu options to cut, copy,
maximum of ten event files

ASCII TERMINAL MODE 
Location: Device Manager 
 
Description: Display the ASCII terminal mode window to transmit ASCII characters, escape sequences 

and/or Function key definitions to the output device.
 

Activation: Direct: <Enter> – menu button 
Menu: Alt-O, T 

 
Comments: The type of terminal mode window displayed is determined by the type field (ASCII or 

Binary) defined in the device record.  To communicate with an ASCII device place the 
cursor on the desired device and press <enter> or click the 
transmitted to the output device by pressing the predefined function keys or by manually 
pressing the numeric and letter keys.  If the device does not respond, check the device’s 
communication parameters (F2) or the device connection.  Use the up arro
right arrow, left arrow, page up, and page down keys to browse the data and the <esc> key 
to exit. 

 
See Also: Function Keys 

Binary Terminal Mode

AS STATUS FIELD 
Location: Analysis (Status Bar) 
 
Description: Displays the current state of the Auto Scaling feature (ON, OFF or ++).
 
Comments: To toggle through the Auto Scaling options (ON, OFF or ++), press F6 or select 

Scale” menu option from the 
channel data is scaled to the maximum value allocated for display from the zero reference 
line. When auto scaling is in the “++” state the 
allocated for display,
maximum position and the smallest value is plotted at the lowest position
shows the full profile 
are scaled according 

 
See Also: ASV Column 

Chapter 1

View the selected device event file in an ASCII editor.  The “Type” column
the type of editor displayed: ASCII or Binary (Hexadecimal)

is defined in the device record.  To open the device record, select the device and press F2.

menu button  

The file content is displayed in text format.  Use the up arrow, down arrow, left arrow, right 
arrow, page up, page down, home, end, Ctrl-home and Ctrl-end keys or the scroll bar to 
navigate through the data and the Edit menu options to cut, copy, or paste text.  A 

vent files may be opened simultaneously.  

ASCII terminal mode window to transmit ASCII characters, escape sequences 
unction key definitions to the output device. 

menu button  

The type of terminal mode window displayed is determined by the type field (ASCII or 
Binary) defined in the device record.  To communicate with an ASCII device place the 
cursor on the desired device and press <enter> or click the Terminal menu button.  Dat
transmitted to the output device by pressing the predefined function keys or by manually 
pressing the numeric and letter keys.  If the device does not respond, check the device’s 
communication parameters (F2) or the device connection.  Use the up arro
right arrow, left arrow, page up, and page down keys to browse the data and the <esc> key 

Binary Terminal Mode 

(Status Bar)  

Displays the current state of the Auto Scaling feature (ON, OFF or ++). 

To toggle through the Auto Scaling options (ON, OFF or ++), press F6 or select 
from the “Options” menu.  When auto scaling is turned “ON”, the 

channel data is scaled to the maximum value allocated for display from the zero reference 
line. When auto scaling is in the “++” state the signals are plotted using the 
allocated for display, ignoring the zero reference line.  The highest value is plotted at the 
maximum position and the smallest value is plotted at the lowest position

profile of frequency, Vdc and load channels. In the “OFF” state all 
according to maximum and minimum values in all of the analog channels
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column in the device 
Binary (Hexadecimal). The type column 

the device and press F2. 

The file content is displayed in text format.  Use the up arrow, down arrow, left arrow, right 
keys or the scroll bar to 

or paste text.  A 

ASCII terminal mode window to transmit ASCII characters, escape sequences 

The type of terminal mode window displayed is determined by the type field (ASCII or 
Binary) defined in the device record.  To communicate with an ASCII device place the 

menu button.  Data is 
transmitted to the output device by pressing the predefined function keys or by manually 
pressing the numeric and letter keys.  If the device does not respond, check the device’s 
communication parameters (F2) or the device connection.  Use the up arrow, down arrow, 
right arrow, left arrow, page up, and page down keys to browse the data and the <esc> key 

To toggle through the Auto Scaling options (ON, OFF or ++), press F6 or select the “Auto 
menu.  When auto scaling is turned “ON”, the 

channel data is scaled to the maximum value allocated for display from the zero reference 
using the maximum value 

.  The highest value is plotted at the 
maximum position and the smallest value is plotted at the lowest position.  This feature 

In the “OFF” state all channels 
maximum and minimum values in all of the analog channels. 
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Auto Scaling 

ATFILE  
Location: File Manager (Status Field)  
 
Description: Displays the file number of the selected file in the table. 

ATREC  
Location: Device Manager (Status Field)  
 
Description: Displays the record number of the selected device in the table. 
 
See Also:  TotRecs 

TotMarks 

ATTAB  
Location: Animated CAD-DXF (Status Field)  
 
Description: Displays the currently highlighted tab number. 
 
See Also:  AtTab 

AUDIO WAVE DRIVER 
Location: File Manager 
 
Description: Changes the driver at the cursor position to the Window’s Audio Wave driver (*.WAV) and 

plots the input channels. 
 
Activation: Menu: Alt-D, V 
 
Comments: All files that have a “.WAV” extension are tagged as Microsoft Audio Wave files.  

AUTO DETECT DRIVER 
Location: File Manager 
 
Description: Infers the filename at the cursor position and activates the associated driver. 
 
Activation: Menu: Alt-D, Z 
 
See Also: Associating File Types in File Manager Quick Start. 

AUTO SCALING 
Location: Analysis  
 
Description: Turns the state of amplitude auto scaling to On, Off or ++ for all the visible analog channels. 
 



 

Activation: Direct: F6 - ASV menu button 
Menu: Alt-D, A, F-Off, O

 
Comments: The AS field displayed in the status bar indicates the auto scale’s current state, ON, OFF or 

++.  When auto scaling is turned “ON”, the channel data is scaled to the maximum value 
allocated for display from the zero reference line. When auto scaling is in
signals are plotted using the 
the zero reference line
smallest value is plotted at the lowest position
frequency, Vdc and load 
maximum and minimum values in all of the analog channels.

 
See Also: Increase Amplitude 

Decrease Amplitude 
Auto Scale Multiplier
AS Status Field 

BACKGROUND COLOR 
Location: DXF Animated CAD (Properties dialog)
 
Description: Select the background color f
 
Activation: Direct: F2 

Menu: Alt-T, D 
 
Default: Black 

BINARY EVENT FILE 
Location: Device Manager 
 
Description: View the selected device 

indicates the type of e
defined in the device record. 

 
Activation: Direct: F6 

Menu: Alt-O, E 
 
Comments: The file contents are displ

up, page down, Ctrl-home and Ctrl
scroll bar. When a hex value is over written the ASCII equivalent is displayed in the window 
to the right of the editor. 

BINARY TERMINAL MODE 
Location: Device Manager 
 
Description: Display a binary terminal mode window to transmit hex values and/or 

definitions to the output device.
 

Activation: Direct: <Enter> – menu button 
Menu: Alt-O, T 

Chapter 1

ASV menu button  
Off, O-On and P-Plus 

The AS field displayed in the status bar indicates the auto scale’s current state, ON, OFF or 
++.  When auto scaling is turned “ON”, the channel data is scaled to the maximum value 
allocated for display from the zero reference line. When auto scaling is in

using the maximum and minimum values allocated for display, ignoring 
the zero reference line. The highest value is plotted at the maximum position and the 
smallest value is plotted at the lowest position. This feature shows the full 
frequency, Vdc and load channels. In the “OFF” state all channels are scaled according to 
maximum and minimum values in all of the analog channels. 

 
 

Auto Scale Multiplier 

DXF Animated CAD (Properties dialog) 

Select the background color for the active DXF tab drawing. 

View the selected device event file in a binary editor. The “Type” column in the device table 
indicates the type of editor displayed: ASCII or Binary (Hexadecimal). The type column is
defined in the device record. To open the device record, select the device and press F2.

The file contents are displayed in a Binary (Hex) editor. Use the up arrow, down arrow, page 
home and Ctrl-end keys to navigate through the file’

When a hex value is over written the ASCII equivalent is displayed in the window 
right of the editor. A maximum of ten event windows can be simultaneously.

Display a binary terminal mode window to transmit hex values and/or Function key 
definitions to the output device. 

menu button  

Chapter 1 – Fields & Features 

7 
 

The AS field displayed in the status bar indicates the auto scale’s current state, ON, OFF or 
++.  When auto scaling is turned “ON”, the channel data is scaled to the maximum value 
allocated for display from the zero reference line. When auto scaling is in the “++” state the 

allocated for display, ignoring 
The highest value is plotted at the maximum position and the 

full profile of 
channels are scaled according to 

The “Type” column in the device table 
The type column is 

To open the device record, select the device and press F2. 

Use the up arrow, down arrow, page 
s data, or use the 

When a hex value is over written the ASCII equivalent is displayed in the window 
event windows can be simultaneously. 

unction key 
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Comments: The type of terminal mode window displayed is determined by the type field (ASCII or 

Binary) defined in the device record. To communicate with a binary device place the cursor 
on the desired device and press <enter> or click the Terminal menu button. Data is 
transmitted to the output device by pressing the predefined function keys or by manually 
pressing the hex numeric and letter keys (0..9,A..F). If the device does not respond, check 
the device’s communication parameters (F2) and/or the device connection. Use the up 
arrow, down arrow, right arrow, left arrow, page up, and page down keys to browse the data 
and the <esc> key to exit. 

 
See Also: Function Keys 

ASCII Terminal Mode 

BPRO DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the NxtPhase BPRO driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
 
Comments: NxtPhase files are displayed in the IEEE Comtrade Binary format. NxtPhase has developed 

an automatic conversion application called "AutoComtrade.exe". Wavewin calls 
"AutoComtrade.exe" to convert NxtPhase files to the Comtrade binary format for display. To 
view NxtPhase relay files double click or press enter on the original BPRO files. To obtain a 
copy of the “AutoComtrade.exe” file please contact NxtPhase. 

 
Files with the .BPR extension are automatically tagged as NxtPhase BPRO files. 

 
See Also: Tesla Files in File Manager Quick Start. 
  Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

CALIBRATION REPORT 
Location: File Manager 
 
Description: Generate a calibration report for all marked event files. 
 
Activation: Menu: Alt-O, R, C 
 
Comments: The Calibration report list the Maximum and Minimum analog summary information for the 

marked files. 
 

For this feature to work properly reports should be generated on non-fault data. The 
DVREPORT.DTB file, saved in the installed directory contains the last generated report.  To 
archive the contents of this file use the Save As option to save the file under a new name. 
 

See Also:  Waveform Summary 

CHANGE DEVICE CONFIGURATION 
Location: Device Manager 



 

 
Description: Change the active device configuration table.
 
Activation: Menu: Alt-D, G 
 
Comments: The “Open Device Configuration” dialog allows for selecting 

different directories.  Navigate to the desired directory and select the “CFG_DEVS.DTB” file 
stored in the newly selected directory.  The device table is updated with the new 
configuration and all devices are initialized.

 
See Also: New Device Configuration

Copy Device Record

CHANGE DRIVE/DIRECTORY 
Location: File Manager  
 
Description: Change the file table's active path.
 

Activation: Direct: F7, ChDir button 
Menu: Alt-F, H, Alt-F, T

 
Comments: There is a number of ways to change the file table’s active 

navigate the connected drives. To enter a 
located in the File menu. 
mouse button in the file table. To navigate back through the last 12 active 
Back menu button. T
message is displayed if the destination path is not found.  

 
See Also:  Navigating Files in the File Manager Quick Start

CHANGE DXF FILES 
Location: Device Manager 
 
Description: Display the “Change 

CAD-DXF window tabs
 
Activation: Menu: Alt-O, C 
 
Fields: DXF Files List: 

Background Color: 

Max X Pixels: 

Max Y Pixels: 

 
Options: Add:  Add one or multiple DXF file(s) to the DXF Files List

Delete:  Delete the highlighted DXF file(s) from the DXF Files List.
Clear:  Clear all the listed DXF files from the DXF Files
OK/Enter: Exit 
Esc/Cancel: Exit the dialog without saving the dialog data.

Chapter 1

Change the active device configuration table. 

The “Open Device Configuration” dialog allows for selecting configurations stored in 
different directories.  Navigate to the desired directory and select the “CFG_DEVS.DTB” file 
stored in the newly selected directory.  The device table is updated with the new 
configuration and all devices are initialized. 

Configuration 
Device Records 

Change the file table's active path. 

F7, ChDir button , Back button , Up button , Right Click, Folder Tree
F, T 

There is a number of ways to change the file table’s active folder. Use the folder tree to 
navigate the connected drives. To enter a folder use the “Change Drive/Directory
located in the File menu. To select from a list of the last 12 active folders
mouse button in the file table. To navigate back through the last 12 active 

To change to the previous folder use the “Up” menu button. 
message is displayed if the destination path is not found.   

Navigating Files in the File Manager Quick Start 

the “Change DXF Files” dialog to change the DXF files displayed in the Animated 
tabs. 

Lists the currently selected DXF files to display in the Animated 
CAD-DXF window.  

 Select the background color for the highlighted DXF file in the DXF 
Files List. 
Set the Max X Pixels for the highlighted DXF file in the DXF Files 
List.  
Set the Max Y Pixels for the highlighted DXF file in the DXF Files 
List. 

Add one or multiple DXF file(s) to the DXF Files List. 
Delete the highlighted DXF file(s) from the DXF Files List.
Clear all the listed DXF files from the DXF Files List. 
Exit and save the dialog then open the animated CAD-DXF window
Exit the dialog without saving the dialog data. 
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configurations stored in 
different directories.  Navigate to the desired directory and select the “CFG_DEVS.DTB” file 
stored in the newly selected directory.  The device table is updated with the new 

, Right Click, Folder Tree 

. Use the folder tree to 
Change Drive/Directory” dialog 

folders click the opposite 
mouse button in the file table. To navigate back through the last 12 active folders use the 

” menu button. An error 

change the DXF files displayed in the Animated 

display in the Animated 

Select the background color for the highlighted DXF file in the DXF 

Set the Max X Pixels for the highlighted DXF file in the DXF Files 

Pixels for the highlighted DXF file in the DXF Files 

Delete the highlighted DXF file(s) from the DXF Files List. 

DXF window. 
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Comments: To add a new file, click the “Add” button. A file select dialog is displayed. To select multiple 

files use the Ctrl+click or Shift+Up/Down arrows. All selected files will be added to the DXF 
files list. To delete file(s) mark the file(s) in the DXF files list and click the “Delete” button. To 
clear the list, click the “Clear” button.   

 
The DXF drawing fields for each listed file can be defined in the dialog prior to opening the 
DXF drawing window. To set up the DXF drawing fields for each listed file select the file and 
tab to the drawing fields defined below the list. This dialog will be displayed if there are no 
DXF files selected before the animated CAD-DXF option is activated. 

 
See Also: Change DXF Files in the Device Manager Quick Start. 

CHANGE FREQUENCY 
Location: Analysis 
 
Description: Change the current sampling frequency. 
 

Activation: Direct: Change Frequency menu button  
Menu: Alt-D, F 

 
Fields: Current Sampling Frequency:  The current sampling frequency. 
  Enter the New Sampling Frequency: The new sampling frequency. 
  Open Frequency:   Sets the driver to open with the new frequency. 
 
Options: Enter/Ok:    Changes frequency. 

Esc/Cancel:    Exits the dialog without executing the command. 
 
Comments: The “Open Frequency” field will set the current display driver to always convert the files to 

the new frequency before displaying. 

CHANGE PASSWORDS 
Location: Device Manager 
 
Description: Activate the Change Passwords feature to verify modem connections and to automatically 

change the password on devices directly or remotely connected to the Wavewin system. 
 
Activation: Menu: Alt-O, P 
 
Comments: This feature secures all the existing modem and network connections to digital relays, 

communication processors, port switches and/or any other type of remotely accessible 
device used in the company. Upon activation change passwords performs the following 
steps for each connected device: 
 

• As applicable dial, switch to, or Ethernet connect and logon. 
• Generate a new random password, 6 characters in length. 
• Change the old password to the new one using the appropriate communication 

driver. 
• Confirm the password was successfully changed. 
• Upon confirmation, update the password file (SETPSW.CSV), the database file 

(CFG_SHOT.DTB) and the device table. 



 

• Logout from the active device and as applicable hang
the Ethernet connection.

• Retry failures if any errors where encountered (up to 3 retries per failure).
 

A small summary file is created in the system directory containi
It is saved to the company network if any failed connections or logon attempts were 
detected. 
 
The random password generator is seeded once upon initial execution to ensure even 
distribution across a 6 character spectrum.  The 
SETPSW.CSV.  Before activation the existing SETPSW.CSV file is renamed using the IEEE 
long file naming format including the current date and time and the company name
only, example: 040909,123456789,,,,South Electric,,,,.

 
See Also: Change Passwords in the Device Manager Quick Start.

CHANGE QUERY OPERATORS 
Location: Query Fields 
 
Description: Change the operator for the active query field.
 
Activation: Direct: F9 

Menu: Alt-Q, O 
 
Comments: To change the operator press F9 or click the mouse button on the operator symbol.
 
See Also:  Equal To (=),  

Greater Than (>),  
Less Than (<) 

CHANNEL BACKGROUND COLOR 
Location: Analysis 
 
Description: Change the background colors for the 

listed in the “Window Properties” dialog under the “Colors” tab.
 
Activation: Menu: Alt-F, T, Color

CHANNEL INFORMATION (ON/OFF

Location: Analysis 
 
Description: Show or hide the channel information 

and digital traces. 
 
Activation: Direct: Analog table close button 

Menu: Alt-V, C 
 
Comments: The channel information frame can be resized by selecting the vertical separator bar and 

dragging it to the right or left. The cursor changes to the vertical res
mouse is positioned over the separator bar.

Chapter 1

Logout from the active device and as applicable hang-up, switch out or terminate 
the Ethernet connection. 
Retry failures if any errors where encountered (up to 3 retries per failure).

A small summary file is created in the system directory containing the performance results.  
It is saved to the company network if any failed connections or logon attempts were 

The random password generator is seeded once upon initial execution to ensure even 
distribution across a 6 character spectrum.  The new passwords are stored in 
SETPSW.CSV.  Before activation the existing SETPSW.CSV file is renamed using the IEEE 
long file naming format including the current date and time and the company name

: 040909,123456789,,,,South Electric,,,,.CSV”. 

in the Device Manager Quick Start. 

Change the operator for the active query field. 

To change the operator press F9 or click the mouse button on the operator symbol.

 

Change the background colors for the analysis window. The background colors fields are 
in the “Window Properties” dialog under the “Colors” tab. 

F, T, Color’s Tab 

FF) 

Show or hide the channel information table displayed in the frame to the right of the analog 

Analog table close button  

The channel information frame can be resized by selecting the vertical separator bar and 
dragging it to the right or left. The cursor changes to the vertical resize cursor when the 
mouse is positioned over the separator bar. 
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up, switch out or terminate 

Retry failures if any errors where encountered (up to 3 retries per failure). 

ng the performance results.  
It is saved to the company network if any failed connections or logon attempts were 

The random password generator is seeded once upon initial execution to ensure even 
new passwords are stored in 

SETPSW.CSV.  Before activation the existing SETPSW.CSV file is renamed using the IEEE 
long file naming format including the current date and time and the company name fields 

To change the operator press F9 or click the mouse button on the operator symbol. 

. The background colors fields are 

displayed in the frame to the right of the analog 

The channel information frame can be resized by selecting the vertical separator bar and 
ize cursor when the 
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CLEAR ANALOG COLORS 
Location: Analysis 
 
Description: Set the analog channel colors to the default color, black. 
 
Activation: Menu: Alt-C, C 
 
Comments: To change the color of an analog channel click the right mouse button on the channel ID or 

channel title. 

CLEAR QUERY AREA 
Location: Query Fields 
 
Description: Set all the query fields to blanks and default the query operators to equal (=). 
 
Activation: Direct: F8 

Menu: Alt-Q, C 

COMBINE LOGS 
Location: File Manager 
 
Description: Combine a number of log files (ABB Load Profile, Comtrade Logs and SDC Logs), of 

different types (different columns), into one comma delimited file with the extension .CSV.   
 
Activation: Menu: Alt-O, R, L 
 
Comments: The files can be of different types (columns do not have to be equal).  The substation and 

device names for the data will be added as the first two columns in the file.  The result file 
can be displayed in a table. 

 
See Also: Append Logs 

COMBINED VIEW 
Location: Analysis 
 
Description: Display all the selected information contained in the analog table in a condensed form. 
 
Activation: Direct: F4 

Menu: Alt-V, A 
 
Comments: Use the F4 key to toggle between the tabular view and the combination view.  The 

combination view is only available if there is enough space between the analog channels to 
display three lines of text.  To change the position of the data values select the “Window 
Properties” option from the “File” menu, then click on the “Analog Combination” tab. 

 
See Also: Viewing Analog Information in the Analysis Quick Start. 

COMMA DELIMITED TABLE DRIVER  
Location: File Manager 
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Description: Display the selected comma delimited file in a table format.  Comma delimited files have 

textual fields separated by commas, such as 0001,7834,872. 
 
Activation: Menu: Alt-D, 3, C 
 
Comments: The file data is presented in tabular form.  An unlimited number of rows and columns can be 

displayed. 
 
See Also: Viewing ASCII Files in Database Format in the File Manager Quick Start. 

Double Quotes/Comma Delimited Table Driver 
Tab Delimited Table Driver 

COMNAME PROPERTIES  
Location: File Manager 
 
Description: Setup the fields not available in the supported waveform files for the IEEE long file naming 

format. 
 
Activation: Menu: Alt-F, O 
 
Fields: Company Name: Enter the Company name that will be used in the long naming 

format. 
Time Code: Enter the time code for the device files to rename. 

  User Field 1:  Enter the 1st User Field. 
  User Field 2:  Enter the 2nd User Field. 
 
Options: Enter/Ok:  Save the entered data. 

Esc/Cancel:  Exit the dialog without saving. 
 
Comments: These fields are used for all the files renamed to the IEEE long file naming format.  Update 

this dialog for file with different time code, latitude and longitude coordinates. 
 
See Also: ComName(s) Rename in the File Manager Quick Start 

ComName Properties in the File Manager Quick Start 
ComName(s) Rename 

COMNAME(S) RENAME  
Location: File Manager 
 
Description: Rename all the marked time sequenced data file to the IEEE long file naming format. 
 
Activation: Menu: Alt-F, A 
 
Comments: A message box will be prompted before renaming the file to insure the execution of the 

rename feature.  This feature will permanently rename the files.  It is advisable to back up 
the files before renaming.  Some proprietary applications may not be able to read the files 
once they are renamed. 

 
See Also: ComName(s) Rename in the File Manager Quick Start. 

ComName Properties 
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COMPANY COLUMN  
Location: File Manager 
 
Description: Displays the company name associated with the long file name.  The sixth field in the file 

name defines the company field for the IEEE long file-naming format. 
 
See Also: Long File Naming Format in the File Manager Quick Start. 

COMPANY NAME (SAVE & ARCHIVE) 
Location: Device Manager - Save & Archive Dialog 
 
Description: The name of the company where the connected devices are installed.  The company name 

is used in the IEEE long file naming format.  The sixth field in the file name defines the 
company name. 

 
Comments: The following characters are not permitted in a file name. :  ?  “  /  \  <  >  *  |  @  # and 

cannot be part of the company name. 
 
See Also: Long File Naming Format in the Device Manager Quick Start. 

COMPRESS COMTRADE FILES  
Location: File Manager 
 
Description: Convert all the marked COMTRADE ASCII files to COMTRADE Binary files. 
 
Activation: Menu: Alt-O, C 
 
Comments: This feature compresses the COMTRADE ASCII file size.  It is useful for porting files to 

floppy or transferring files through a medium. 
 
See Also: Compressing COMTRADE Files in the File Manager Quick Start. 

COMTRADE DRIVER 
Location: File Manager 
 
Description: Change the driver at the cursor position to the COMTRADE driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, 5 
 
Comments: All files that have a “.DAT” or ‘’D##” file extension, and a corresponding “.CFG” file are 

tagged as COMTRADE files.  If the selected file does not have a corresponding “.CFG” file 
an error message is generated.  Both the COMTRADE ASCII and Binary formats are 
supported. 

CONDENSE TIME 
Location: Analysis 
 
Description: Condense the time scale for all visible channels.  



 

 

Activation: Direct: Ctrl-Page Down or the Condense menu button 
Menu: Alt-D, C  

 
See Also: Expand Time 

COPY/CUT/PASTE FILES 
Location: File Manager 
 
Description: Copy or Cut the marked files to the 

the files. 
 

Activation: Direct: Ctrl-X (Cut) 
Menu: Alt-E, T (Cut), Alt

 
Comments: Marked files are displayed in red.  The TotMarks a

bar are updated accordingly.  To copy/cut/paste files use the Edit menu options, the 
shortcut keys or right click in the file table and select the desired option. 

 
See Also:  Copy File 

Move Files 
Mark/Unmark File 

COPY DEVICE RECORDS 
Location: Device Manager 
 
Description: Copy the marked device records to the system clipboard files.
 
Activation: Menu: Alt-D, Y 
 
Comments: Device records can be 

mark the desired records in the device table (marked devices are displayed in red) then 
select the “Copy” menu option under “Device” menu.  The marked records will be copied to 
the “DEV_CLIPBOARD.CLP” and the devices function keys will be copied to the 
“LOG_CLIPBOARD.CLP”.  These files are cleared before each copy operation.

 
See Also: Change Device Configuration

New Device Configuration
Paste Device Records

COPY FILES 
Location: File Manager 
 
Description: Copy the marked files to the specified destination path.  If the path does not exist, type the 

directory name in the edit box.  The system prompts prior to creating the directory.
 

Activation: Direct: F8 or the Copy menu button 
Menu: Alt-F, C 
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Page Down or the Condense menu button  

Copy or Cut the marked files to the clipboard.  Navigate to the destination folder and Paste 

, Ctrl-C (Copy) , Ctrl-V (Paste) 
E, T (Cut), Alt-E, C (Copy), Alt-E, P (Paste) 

Marked files are displayed in red.  The TotMarks and MrkSize fields displayed in the status 
bar are updated accordingly.  To copy/cut/paste files use the Edit menu options, the 
shortcut keys or right click in the file table and select the desired option.  

Copy the marked device records to the system clipboard files. 

Device records can be copied from one configuration to another.  To copy device records 
mark the desired records in the device table (marked devices are displayed in red) then 
select the “Copy” menu option under “Device” menu.  The marked records will be copied to 

BOARD.CLP” and the devices function keys will be copied to the 
“LOG_CLIPBOARD.CLP”.  These files are cleared before each copy operation.

Change Device Configuration 
Configuration 

Paste Device Records 

Copy the marked files to the specified destination path.  If the path does not exist, type the 
directory name in the edit box.  The system prompts prior to creating the directory.

F8 or the Copy menu button  
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clipboard.  Navigate to the destination folder and Paste 

 

nd MrkSize fields displayed in the status 
bar are updated accordingly.  To copy/cut/paste files use the Edit menu options, the 

 

copied from one configuration to another.  To copy device records 
mark the desired records in the device table (marked devices are displayed in red) then 
select the “Copy” menu option under “Device” menu.  The marked records will be copied to 

BOARD.CLP” and the devices function keys will be copied to the 
“LOG_CLIPBOARD.CLP”.  These files are cleared before each copy operation. 

Copy the marked files to the specified destination path.  If the path does not exist, type the 
directory name in the edit box.  The system prompts prior to creating the directory. 
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Fields: Directory Name: The destination path where the marked files are to be copied.  To 
specify a new path type the path directly into this edit box. 

Directories: Displays a tree of the system’s directories, double click to open a 
node in the tree and click on the desired directory to highlight it. 

  Files:   Displays a list of the files in the highlighted directory. 
  Drives:   A list of all the connected drives.  Select the desired drive. 
 
Options: Enter/Ok:  Copy the marked files to the destination path. 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: Marked files are displayed in red.  The TotMarks and MrkSize fields displayed in the status 

bar are updated accordingly.  Files that where unsuccessfully copied are marked and 
grouped at the top of the table. 

 
See Also:  Move Files 

Mark/Unmark File 

COPY TEXT 
Location: ASCII Event File 
 
Description: Copy the blocked text to the clipboard. 
 

Activation: Direct: Ctrl-C, Ctrl-Ins - Copy menu button  
Menu: Alt-E, C 

 
Comments: To block text use the shift key plus the up arrow, down arrow, page up and page down keys 

or the drag the mouse. 
 
See Also:  Cut Text 

Paste Text 

CREATE DIRECTORY 
Location: File Manager 
 
Description: Create a new directory. 
 
Activation: Menu: Alt-F, E 
 
Fields: Directory: The new directory's name. 
 
Options: Enter/Ok: Create the new directory. 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: If there is no path defined the new directory is placed in the active directory. 

CUT TEXT 
Location: ASCII Event File 
 
Description: Copy the blocked text to the Windows clipboard then delete the blocked text. 
 
Activation: Direct: Ctrl-X, Shift-Del - Cut menu button  



Chapter 1 – Fields & Features 
 

17 
 

Menu: Alt-E, T 
 
Comments: Use the shift keys and the up arrow, down arrow, page up and page down keys to block 

text. 
 
See Also:  Copy Text 

Paste Text 

CYCLE HOP 
Location: Analysis  
 
Description: Move the data bar (vertical black solid line) one cycle forward or backward in time. 
 
Activation: Direct: Shift-Ctrl-Left arrow and Shift-Ctrl-Right arrow 
 
Comments: Use the shift+ctrl left/right keys to move one cycle in time.  The number of cycles is 

displayed in the status bar with the Reference bar (vertical blue dotted line) as the reference 
position. 

 
See Also:  Data Bar 

D&T 
Location: Analysis (Status Field)  
 
Description: Displays the data and time of the sample at the data bar. 
 
See Also:  Delta X Field 

DATA BAR 
Location: Analysis 
 
Description: Displays the channel’s instantaneous sample value.  The data bar is the solid black line that 

runs vertically across the analog and digital channels.   
 
Comments: The data bar is used to view channel information (such as analog sample values, RMS 

values, digital information, data and time…).  The information is displayed in the channel 
frame positioned to the right of the traces and in the status bar. The Ctrl-Left/Right keys 
moves the data peak to peak and the Shift-Ctrl-Left/Right keys moves the data one cycle in 
time. 

 
See Also:  RMS bar 

Reference bar 
Horizontal Bars 
Cycle Hop 
Peak Hop 
Fault Bar 

DECREASE AMPLITUDE 
Location: Analysis 
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Description: Decrease the amplitude of all or marked analog channels.
 
Activation: Direct: Ctrl-Down Arrow or the AmpDn menu button 

Menu: Alt-D, D 
 
Comments: When the channels’ amplitude is decreased the Trace Scale Multiplier is divided into the 

Pixsdisp value.  To change the 
“File” menu then select the “Display Settings” tab

 
See Also: Increase Amplitude 

Trace Scale Multiplier 

DELETE DEVICES 
Location: Device Manager 
 
Description: Tag all the marked device records
 
Activation: Direct: Delete 

Menu: Alt-D, D 
 
Comments: Marked records are displayed in red.  The TotMarks field displayed in the status bar 

updated accordingly.  
the top of the table. 

 
Restrictions: The marked records are tagged as deleted 

They are not physically removed from the device database 
marked as deleted. 

 
See Also: Mark/Unmark Records

DELETE FILES 
Location: File Manager 
 
Description: Remove all the marked files and empty directories from the active 
 
Activation: Direct: Delete 

Menu: Alt-F, D 
 
Comments: Marked files and directories are displayed in red.  The TotMarks and MrkSize fields 

displayed in the status bar are updated accordingly.  Files and directories that were 
unsuccessfully deleted are marked and grouped at the top of the table.

 
Restrictions: A marked directory must be empty in order to remove it from the file table.
 
See Also: Mark/Unmark File 

DELETE TEXT 
Location: ASCII Event File 
 
Description: Delete the blocked text from the 
 

e amplitude of all or marked analog channels. 

Down Arrow or the AmpDn menu button  

When the channels’ amplitude is decreased the Trace Scale Multiplier is divided into the 
Pixsdisp value.  To change the Trace Scale Multiplier, select “Window Properties” from the 
“File” menu then select the “Display Settings” tab. 

 
Trace Scale Multiplier  

device records as deleted records. 

are displayed in red.  The TotMarks field displayed in the status bar 
y.  Records that were unsuccessfully deleted are marked and grouped at 
 

The marked records are tagged as deleted records and will not show up in the table again.  
They are not physically removed from the device database (CFG_DEVS.DTB) 

 

Records 

Remove all the marked files and empty directories from the active directory.

Marked files and directories are displayed in red.  The TotMarks and MrkSize fields 
displayed in the status bar are updated accordingly.  Files and directories that were 

deleted are marked and grouped at the top of the table. 

A marked directory must be empty in order to remove it from the file table.

Delete the blocked text from the file. 

When the channels’ amplitude is decreased the Trace Scale Multiplier is divided into the 
Trace Scale Multiplier, select “Window Properties” from the 

are displayed in red.  The TotMarks field displayed in the status bar is 
that were unsuccessfully deleted are marked and grouped at 

and will not show up in the table again.  
(CFG_DEVS.DTB) file but are 

directory. 

Marked files and directories are displayed in red.  The TotMarks and MrkSize fields 
displayed in the status bar are updated accordingly.  Files and directories that were 

A marked directory must be empty in order to remove it from the file table. 
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Activation: Direct: Del 
Menu: Alt-E, D  

 
Comments: Use the shift keys and the up arrow, down arrow, page up and page down keys to block 

text. 
 
See Also:  Cut Text 

DELTA X 
Location: Analysis (Status Field)  
 
Description: Displays the time in microseconds, milliseconds, or seconds between the RMS bar and the 

data bar.  The number of cycles is also displayed if the samples in the file are microseconds 
or milliseconds apart. 

 
See Also:  D&T Field 

RMS bar 

DELTA Y 
Location: Analysis (Status Field)  
 
Description: Displays the difference between the data horizontal bar and the reference horizontal bar. 
 
See Also:  Delta X Field 

DESCENDING SORT 
Location: All Tables 
 
Description: Sort the device columns in descending order with respect to the selected sort field. 
 
Activation: Menu: Alt-S, D 
 
Comments: To change the sort field, place the cursor in the desired column and select “Set Sort Field” 

in the Sort menu.  The sort field is displayed in the status bar at the bottom of the window.  
To sort the table columns directly press the column header button.  The header buttons 
toggle between ascending and descending order. 

 
See Also: Ascending Sort  

Sorting Devices in the Quick Starts 

DEVICE COLUMN  
Location: File Manager 
 
Description: Displays the device name associated with the long file name.  The fifth field in the file name 

defines the device field for the IEEE long file-naming format.  It represents the name or code 
of the device that originated the file.   

 
See Also: Long File Naming Format in the File Manager Quick Start. 
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DEVICE FIELD 
Location: IEEE Long File Name  
 
Description: The 5th field in the IEEE long file naming format.  The title and device number columns are 

used for the device field in the long naming format.  The device number is concatenated to 
the title by the #, example SEL 351#83. 

 
See Also: Long File Naming Format in the Device Manager Quick Start. 

DFR I II IIB & 2000 DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Hathaway DFR I II IIB and 2000 driver. 
 
Activation: Menu: Alt-D, 6 
 
Comments: An error message is displayed if the system cannot find the files DAU header file or there 

was a problem reading the file. 
 
See Also: Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

DIGITAL MARK/UNMARK ALL 
Location: Analysis 
 
Description: Marked all digital channels if there are no digital channels marked else unmark all the 

marked digital channels. 
 
Activation: Menu: Alt-C, I 
 
Comments: The channels ID and titles are displayed in light red when marked.  Press F8 to mark or 

unmark all the analog and digital channels. 

DISPLAY DIALOG 
Location: All Tables 
 
Description: Reposition the columns in the table. 
 
Activation: Menu: Alt-O, I 
 
Fields: File Column List: A list of all the columns in the table. 

Table Font Size: A list of the font sizes for the table. 
 
 
Options: Move Up: Move the highlighted column before the previous column. 

Move Down: Move the highlighted column after the next column. 
Reset: Default the order of the columns to how they were when the software was 

first installed. 
OK:  Change the order of the columns and redraw the device table. 
Cancel:  Exit the dialog without executing the command. 
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Comments: To resize the table columns place the mouse over the column separator and drag the 
mouse to the left or the right or double click on the column separator to expand to the 
maximum area for that column. 

 
See Also:  Customizing the Table in the Quick Starts 

Resize Columns 

DISTURBANCE REPORT  
Location: File Manager (Universal Viewer) 
 
Description: Create a disturbance report from the defined fault files. 
 
Activation: Menu: Alt-O, R, D 
 
Fields: Destination File:  The folder and filename where the report is saved. 

Source Folder(s):  The source folder(s) where the event files are located. 
  Filter: Faulted Phases:  Enter the valid faulted phases (separated by commas). 
  Filter: Fault Location:  Enter the maximum % of the line length to detect. 

Filter: Voltage Class: Enter the voltage kv value that is above the phase to 
ground level. 

Filter: Fault Current: Enter the minimum magnitude value. 
Filter: System Frequency: Enter the deviation from the line frequency to detect. 

 
Options: Process:   Process the report and display the results. 

Save Script:   Save the entered values to the Disturbance.ini script file. 
Edit Script:   Edit the Disturbance.ini script file. 
Show Help:   Show the help file below the buttons. 
Close:    Close the disturbance dialog without saving. 

 
Comments: The result disturbance report is saved to the defined destination file and displayed in a 

comma delimited table. The table allows for sorting, querying, deleting of rows and saving. 
 
See Also: Disturbance Report in the File Manager Quick Start. 

DLP1/DLP3 DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Plot the contents of the oscillography file using the DLP1/DLP3 driver.  If the driver 

encounters an error while reading the file an “Invalid Driver Message” is displayed indicating 
the line number in which the error was encountered.  Use the ASCII or Hexadecimal editors 
to locate and correct the error.  The ASCII and hexadecimal editors display the cursor’s line 
and character number in the lower left corner of the window. 

 
Activation: Menu: Alt-D, C 
 
Comments: An error message is displayed if the file is not a valid DLP file.  All files that have an “.OSC” 

extension are tagged as DLP files.  

DOUBLE QUOTES/COMMA DELIMITED TABLE DRIVER  
Location: File Manager 
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Description: Display the double quote delimited file in a table format.  Double quote-delimited files have 
textual fields separated by double quotes and commas, such as 
“CHANNEL”,”DATE”,”TIME”. 

 
Activation: Menu: Alt-D, 3, Q 
 
Comments: The file data is presented in tabular form.  An unlimited number of rows and columns can be 

displayed. 
 
See Also: Viewing ASCII Files in Database Format in the File Manager Quick Start. 

Comma Delimited Table Driver 
Tab Delimited Table Driver 

DRAWING PROPERTIES 
Location: DXF Animated CAD 
 
Description: Display the DXF “Drawing Properties” dialog to define the background color and Zoom X & 

Y resolution values. 
 

Activation: Direct: F2, menu button  
Menu: Alt-T, D 

 
Fields: Background Color: Set the DXF drawings background color. 

Max X Pixels: Set the DXF drawings max X pixels for display. 
Max Y Pixels: Set the DXF drawings max Y pixels for display. 

 
Options: Apply:  Apply and save the changes made without exiting the dialog. 

Enter/OK: Exit, apply and save the changes made. 
Esc/Cancel: Exit the dialog without executing or saving the changes made. 

 
Comments: Use the tab or shift+tab keys to navigate between the fields and the up and down arrow 

keys to view the selectable options. 
 
See Also: Drawing Properties in Chapter 1 

DRIVER COLUMN  
Location: File Manager 
 
Description: Displays the display driver associated with the file. 
 
See Also: Associating File Types in Chapter 1. 

DRIVER CONFIGURATION DIALOG 
Location: File Manager 
 
Description: Display the driver configuration dialog.  The driver configuration dialog allows for setting 

certain features pertaining to a specific driver. 
 
Activation: Menu: Alt-O, N 
 
Fields: Driver List:  A list the supported drivers in the system. 



 

  Devices Data Type: 
Device Header Dir: 

Default Frequency: 

 
Options: Ok:   

Cancel:   
 
Comments: The file data is presented in tabular form.  An unlimited number of rows and columns can be 

displayed. 
 
See Also: Driver Configuration in the 

DRIVER DATA TYPE 
Location: Analysis 
 
Description: Set the active display driver’s data type.
 

Activation: Direct: Window Properties menu button 
  Menu: Alt-F, T, Driver Data Type Tab
 
Comments: The data stored in the displayed file can be instantaneous values or RMS values.  The 

default setting for all drivers is instantaneous values.  If the display d
values as RMS calibrated then 
data type is RMS Calibrated and the data type is 
analog column data will be displayed incorrectly.

DUPLICATE CYCLES 
Location: Analysis 
 
Description: Duplicate the cycle between the Data bar and the RMS bar.
 

Activation: Direct: Duplicate Cycles menu button 
  Menu: Alt-D, L 
 
Fields: # Cycles: Enter the number of time to dupl
 
Options: Enter/Ok: Duplicate the highlighted cycle(s) .

Esc/Cancel: Exit the dialog without executing the command.
 
Comments: This feature is useful for creating test set files or for creating file to play back into simulat

or modeling applications.
 
See Also:  Duplicate cycles in the Analysis Quick Start.

Truncate Cycles 

DUPLICATE DEVICE RECORD 
Location: Device Manager 
 

Chapter 1

 Select the type of data that the device saves (RMS or Peak).
 Enter a localized directory for all support files needed to display the 

files. 
 Enter the default frequency to display the device’s file when the 

files are first displayed. 

Save the changes made and close the dialog. 
Ignore any changes made and close the dialog. 

The file data is presented in tabular form.  An unlimited number of rows and columns can be 

Driver Configuration in the File Manager Quick Start.  

Set the active display driver’s data type. 

Window Properties menu button  
iver Data Type Tab 

The data stored in the displayed file can be instantaneous values or RMS values.  The 
default setting for all drivers is instantaneous values.  If the display device
values as RMS calibrated then select RMS Calibrated Type from the drop down list

RMS Calibrated and the data type is not set to RMS calibrated 
analog column data will be displayed incorrectly. 

Duplicate the cycle between the Data bar and the RMS bar. 

Duplicate Cycles menu button  

Enter the number of time to duplicate the highlighted cycle(s)

Duplicate the highlighted cycle(s) . 
Exit the dialog without executing the command. 

This feature is useful for creating test set files or for creating file to play back into simulat
or modeling applications. 

Duplicate cycles in the Analysis Quick Start. 
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the device saves (RMS or Peak). 
a localized directory for all support files needed to display the 

o display the device’s file when the 

 

The file data is presented in tabular form.  An unlimited number of rows and columns can be 

The data stored in the displayed file can be instantaneous values or RMS values.  The 
evice saves the sample 

librated Type from the drop down list.  If the 
RMS calibrated type then the 

icate the highlighted cycle(s). 

This feature is useful for creating test set files or for creating file to play back into simulation 
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Description: Duplicate the selected device record in the table.  
 
Activation: Menu: Alt-D, U 
 
Fields: Device Settings:  

Device Number: Set the number of the device. Each device must have a unique 
number.  The device number is used in the IEEE long file naming 
format. 

Address: Set the address of the device. The address can be the port number 
off a 2020/2030 or a modbus address. 

Station ID: Set the ID number for the station each station must have a unique 
number. 

Data Type: Select the type of data being polled (ASCII/Binary). 
Print : Select if the data polled is sent to the connected printer (On/Off). 
Title: Set the device title. 
Driver: Select the main driver that will poll the device. 
Station Name: Set the station name. 
Time Code: Select the main driver that will poll the device. 
EscSeq: The EscSeq field contains 7 separate fields separated by a blank. 

Set the appropriate information in the appropriate fields.  The fields 
can contain passwords, phone numbers, file names, FTP settings, 
TCP/IP settings for a specific device refer to the “Device 
Configuration” document. 

Port Settings:  
Port Number: Select the COM port number from the list of COM ports registered 

on the machine or enter a new COM port number.  For TCP/IP and 
FTP connections each device must have a unique COM port 
number. 

Baud Rate: Select the port’s baud rate. 
Parity: Select the port’s parity (None, ODD, Even, Mark). 
Data Bits: Select the port’s Data Bits (7 or 8). 
Stop Bits: Select the port’s stop bits (1 or 2). 
Flow Control: Select the port’s flow control (None, Software or Hardware). 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or none 

in terminal mode. 
Local Echo: Select if the transmitted text is echoed to the terminal window. 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or none 

in terminal mode. 
TX Delay:  
Inter Char Delay: Enter the number of milliseconds to wait when transmitting 

characters to the device. 
 
Options: Save/Enter: Exit and save the dialog fields. 

Esc/Cancel: Exit the dialog without saving the dialog fields. 
 
Comments: The selected device in the table is duplicated as a new record at the end of the table.  The 

device number must be changed.  All device numbers must be unique.  An error message 
will be displayed if any invalid fields are encountered.  The Title and Substation fields are 
used in the IEEE long file naming format.  The following characters (:  ?  “  /  \  <  >  *  |  @  
#) are not valid in file names and cannot be used in the title and substation fields. 

 
See Also: New Device Record 

Edit Device Record 
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DXF ANIMATED CAD 
Location: Device Manager 
 
Description: Poll the devices defined in a graphical one line diagrams and display the parsed data. 
 
Activation: Menu: Alt-O, D 
 
Comments: For the DXF window to poll the connected devices the polling drivers must be written and 

configured and the DXF drawings must have the device control points defined.  Refer to 
Appendix A for an example of polling drivers and Appendix B for setting control points in a 
DXF file. 

 
See Also:  Animated CAD/DXF in the Device Manager Quick Start. 

Appendix A 
Appendix B 

DXF CONTROL DIALOG 
Location: DXF Animated CAD 
 
Description: Display the “DXF Control” dialog to communicate directly to a device. 
 

Activation: Direct: menu button  
Menu: Alt-T, O 

 
Fields: Control Menu List: Select the DXF tab containing the device to communicate with, 

select the device then select the communication driver. 
 
Options: Operate/Enter: Exit the dialog and execute the selected communication driver. 

Esc/Cancel: Exit the dialog without executing the communication driver. 
 
Comments: The “Control Menu” list box to the right contains all tab names displayed in the DXF window.  

Select the tab to send commands to.  Once a tab is selected the list is updated with all the 
devices defined the tab’s drawing.  Select the device to communicate with.  The list again is 
updated with the available communication drivers defined in the “Drivers.ini” file.  The 
“Control Level” window is updated upon entry into each level. Once the communication 
driver is selected the “DXF Control” dialog is closed and the command is sent to the 
selected device.  The device’s response is parsed and updated in the selected DXF tab. 

 
See Also: DXF Control in the Device Manager Quick Start. 

DXF DRIVER 
Location: File Manager 
 
Description: Displays the file(s) drawing information in graphical form. 
 
Activation: Menu: Alt-D, 4, S or M 
 
Comments: An error message is displayed if the file is not a valid DXF file.  All files that have the “.DXF” 

extension are tagged as DXF files.  A single file can be opened or multiple files can be 
opened at the same time.  For multiple files first mark the files then select Marked files from 
the DXF submenu option. 
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EDIT DAU-DEF 
Location: File Manager 
 
Description: Display the DAU-DEF editor for Hathaway DAU-DEF files.  The DAU-DEF editor allows for 

changing certain fields defined in the DAU-DEF records.  A Windows file selection dialog is 
display to select the DAU-DEF to edit.  Navigate to the desired directory and double click on 
the DAU-DEF file to edit. 

 
Activation: Menu: Alt-O, E 
 
Fields: DAU-DEF Records: A list the all DAU-DEF records defined in the selected file. 
  Analog Channels: A list of all the analog channels defined for the selected record. 

Analog Name: Edit the analog name for the selected analog channel. 
Analog Full Scale: Edit the analog full scale value for the selected analog channel. 
Analog Prefix: Edit the analog prefix for the selected analog channel. 
Analog Unit: Edit the analog unit for the selected analog channel. 
Event Channels: A list of all the event channels defined for the selected record. 
Event #: Edit the event’s number for the selected event channel. 
Event Name: Edit the event name for the selected event channel. 
Event NoNc: Edit the event’s normally open normally close value for the selected 

event channel. 
Sensor Channels: A list of all the sensors channels defined for the selected record. 
Sensor #: Edit the sensor number for the selected sensor channel. 
Sensor Name: Edit the sensor name for the selected sensor channel. 
Sensor NoNc: Edit the sensor’s normally open normally close value for the 

selected sensor channel. 
 
Options: Save:   Save the selected DAU-DEF record. 

Ok:   Save all changes made and close the dialog. 
Cancel:   Ignore any changes made and close the dialog. 
Default Sensor #8:  Checking this option will always default Sensor channel #8;s NoNc 

value to be 1.  
 
Comments: When this feature is activated a Windows file selection dialog is display, navigate to the 

desired directory and double click on the DAU-DEF file to edit. 
 
See Also: Edit DAU-DEF in the File Manager Quick Start. 

EDIT DEVICE RECORD 
Location: Device Manager 
 
Description: Edit the selected device record in the table. 
 

Activation: Direct: F2 –menu button  
Menu: Alt-D, E 

 
Fields: Device Settings:  

Device Number: Set the number of the device. Each device must have a unique 
number.  The device number is used in the IEEE long file naming 
format. 

Address: Set the address of the device. The address can be the port number 
off a 2020/2030 or a modbus address. 
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Station ID: Set the ID number for the station each station must have a unique 
number. 

Data Type: Select the type of data being polled (ASCII/Binary). 
Print : Select if the data polled is sent to the connected printer (On/Off). 
Title: Set the device title. 
Driver: Select the main driver that will poll the device. 
Station Name: Set the station name. 
Time Code: Select the main driver that will poll the device. 
EscSeq: The EscSeq field contains 7 separate fields separated by a blank. 

Set the appropriate information in the appropriate fields.  The fields 
can contain passwords, phone numbers, file names, FTP settings, 
TCP/IP settings for a specific device refer to the “Device 
Configuration” document. 

Port Settings:  
Port Number: Select the COM port number from the list of COM ports registered 

on the machine or enter a new COM port number.  For TCP/IP and 
FTP connections each device must have a unique COM port 
number. 

Baud Rate: Select the port’s baud rate. 
Parity: Select the port’s parity (None, ODD, Even, Mark). 
Data Bits: Select the port’s Data Bits (7 or 8). 
Stop Bits: Select the port’s stop bits (1 or 2). 
Flow Control: Select the port’s flow control (None, Software or Hardware). 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or none 

in terminal mode. 
Local Echo: Select if the transmitted text is echoed to the terminal window. 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or none 

in terminal mode. 
TX Delay:  
Inter Char Delay: Enter the number of milliseconds to wait when transmitting 

characters to the device. 
 
Options: Save/Enter: Exit and save the dialog fields. 

Esc/Cancel: Exit the dialog without saving the dialog fields. 
 
Comments: An error message will be displayed if any invalid fields are encountered.  The Title and 

Substation fields are used in the IEEE long file naming format.  The following characters (:  
?  “  /  \  <  >  *  |  @  #) are not valid in file names and cannot be used in the title and 
substation fields. 

 
See Also: New Device Record 

Duplicate Device Record 

EMAIL FILES 
Location: File Manager and  Analysis 
 
Description: Email a group of files or a single file using the users default email application.  All support 

files needed to display the selected files will be automatically attached.  Support files include 
Comtrade configuration (*.CFG), header (*.HDR) & information (*.INF) files, DFR’s analog 
and digital information files such as: Hathaway DAU files, Rochester preamble and header 
files, Faxtrax/Director CTL files, Transcan SCF and TCF files. 
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Activation: Menu: File Manager: Alt
 
Fields: To:   

From: 
Subject: 
Attachment: 

 
Comments: Files can be email either in the file table or in the 

mark the desired files in the file table and select the “Email Marked Files” option from the 

“File” menu or right click on the file table and select the “
pop-up menu.  To email a file from the 
under the “File” menu.  All support files needed to display the file(s) are automatically 
attached. 

 
See Also: Email Files and Email Activ

EMAX LONG TERM DRIVER 
Location: File Manager (Universal Viewer)
 
Description: Change the driver at the cursor position to the

channels. 
 
Activation: Menu: Alt-D, Q 
 
Comments: If the selected file is not a valid EMAX Long Term file an error message is generated.  All 

files that have the “.DAT” extension along with a corresponding .SET file
EMAX Long Term files.

 
See Also: Display Oscillography in the File Manager Quick Start

Associating File Types in the File Manager Quick Start

EQUAL TO (=) 
Location: Query Fields 
 
Description: Search the active configuration
 
Comments: To change the query operator press F9 or click the mouse button on the operator symbol.
 
See Also:  Greater Than (>) 

Less Than  (<) 

EXPAND TIME 
Location: Analysis 
 
Description: Expand the time scale of all visible analog channels.
 

Activation: Direct: Ctrl-Page Up or the Expand menu button 
Menu: Alt-D, E 

 
See Also: Condense Time 

File Manager: Alt-F, L  Analysis: Alt-F, E 

Recipient of the email, initially empty. 
Sender, automatically defaulted. 
Empty. 
All selected files and their support files automatically attached.

Files can be email either in the file table or in the analysis window. To email a set of files, 
mark the desired files in the file table and select the “Email Marked Files” option from the 

“File” menu or right click on the file table and select the “Email”  
up menu.  To email a file from the analysis window select the “Email Active File” option 

under the “File” menu.  All support files needed to display the file(s) are automatically 

Email Files and Email Active File in the File Manager and Analysis Quick Starts.

(Universal Viewer) 

Change the driver at the cursor position to the Emax Long Term driver and plot the input 

If the selected file is not a valid EMAX Long Term file an error message is generated.  All 
files that have the “.DAT” extension along with a corresponding .SET file 
EMAX Long Term files. 

Display Oscillography in the File Manager Quick Start 
Associating File Types in the File Manager Quick Start 

configuration for records that match the entered criteria.

To change the query operator press F9 or click the mouse button on the operator symbol.

Expand the time scale of all visible analog channels. 

Page Up or the Expand menu button  

All selected files and their support files automatically attached. 

. To email a set of files, 
mark the desired files in the file table and select the “Email Marked Files” option from the 

 option from the 
window select the “Email Active File” option 

under the “File” menu.  All support files needed to display the file(s) are automatically 

e File in the File Manager and Analysis Quick Starts. 

Emax Long Term driver and plot the input 

If the selected file is not a valid EMAX Long Term file an error message is generated.  All 
 are tagged as 

that match the entered criteria. 

To change the query operator press F9 or click the mouse button on the operator symbol. 
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EXPORT 
Location: Device Manager 
 
Description: Export all or marked devices to a tab delimited ASCII file. 
 
Comments: This feature is useful for changing common information for all devices quickly. For example 

if a COM port number has changed for a number of devices then those devices can be 
exported. The export file can be opened in “Excel” and all of the Com port fields can be 
changed easily. To import the changes back into the device configuration table use the 
“Import” menu option under the “Device” menu. 

 
See Also:  Import 

F-TYPE COLUMN  
Location: File Manager 
 
Description: Displays the file type.  The “/dr” indicates that the file is a sub-directory.  The DAU ID 

number is displayed for DFR I, II, IIB and 2000 files and the extension of the file is displayed 
for all other files. 

 
Comments: If the active directory is a sub-directory then the first 2 rows of the table are reserved for the 

“.” and “..” navigation shortcuts.  The “.” is a shortcut to the root directory and the “..” is a 
shortcut to the previous directory.   

FAULT BAR 
Location: Analysis 
 
Description: The Fault bar is the red dotted line that runs vertically across the analog and digital 

channels.   
 
Comments: The fault bar is fixed and positioned at the fault time defined in the configuration file. The 

fault bar can be shown or hidden by selecting “Yes” or “No” for the “Show Vertical Fault Bar” 
field in the properties dialog under the “Display Settings” tab.   
 

See Also:  Data bar 
RMS Bar 
Reference Bar 

FAULT DATE COLUMN  
Location: File Manager 
 
Description: Displays the fault date of the oscillography files.  This column is left blank if the file is not a 

valid oscillography file or the fault date and time is not available in the file name.   
 
See Also: Fault Time Column 

FAULT REFERENCE TIME BAR 
Location: Analysis 
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Description: Displays the time difference from the fault time defined in the displayed file.  The units are 
displayed in the Delta X status field. 

 
Comments: The fault reference time bar is displayed between the analog channels and the digital 

channels.  To show or hide the fault reference time bar open the “Window Properties” dialog 
under the “File” menu.  Click the “Display Settings” tab and toggle the “Show Reference 
Time Bar” field. 

 
See Also: Fault Reference Time Bar in the Analysis Quick Start 

FAULT TIME COLUMN  
Location: File Manager 
 
Description: Displays the fault time of the oscillography files.  This column is left blank if the file is not a 

valid oscillography file or the fault date and time is not available in the file name.   
 
See Also: Fault Date Column 

FAXTRAX II (12-BIT) & DIRECTOR DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Faxtrax II (12-bit) driver or the Director format 

depending on the format of the file. 
 
Activation: Menu: Alt-D, 8 
 
Comments: If the selected file does not have a corresponding “.CTL” file an error message is generated.  

All files that have the “.RCD”, “.RCL” and “.RCU” extensions, and there is a corresponding 
“.CTL” file in the same directory, are tagged as Faxtrax/Director files. 

FILE NAME COLUMN  
Location: File Manager 
 
Description: Displays the name of the files/directories in the active directory. 
 
Comments: If the active directory is a sub-directory then the first 2 rows of the table are reserved for the 

“.” and “..” navigation shortcuts.  The “.” is a shortcut to the root directory and the “..” is a 
shortcut to the previous directory. 

 
See Also: F-Type Column 

FLIP MARKS 
Location: All Tables 
 
Description: Mark all the unmarked records and unmark all the marked records. 
 
Activation: Menu: Alt-M, F  
 
Comments: Marked records are displayed in red.  The TotMarks field displayed in the status bar is 

updated accordingly. 
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See Also: Unmark Marked Records 

Mark/Unmark Records 

FOLDER TREE 
Location: File Manager 
 
Description: Displays all connected drives and folders in a tree structure. 
 
Activation: Menu: Alt-F, T – Toggle Show/Hide Tree  
 
Comments: To show/hide the folder tree select the “Show/Hide Folder Tree” option under the “Files” 

menu.  Folders can be renamed by left mouse clicking on the folder name until the editor is 
displayed. Also, folders that reside on the computer can be sent to the recycle bin by 
selecting the “Delete” option under the folder tree’s right click pop-up menu. If the folders 
reside on external drives then they are permanently deleted. 

 
See Also: Navigating in the File Manager Quick Start 

Change Drive/Directory 

FPRO DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the NxtPhase FPRO driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
 
Comments: NxtPhase files are displayed in the IEEE Comtrade Binary format. NxtPhase has developed 

an automatic conversion application called "AutoComtrade.exe". Wavewin calls 
"AutoComtrade.exe" to convert NxtPhase files to the Comtrade binary format for display. To 
view NxtPhase relay files double click or press enter on the original FPRO files. To obtain a 
copy of the “AutoComtrade.exe” file please contact NxtPhase. 

 
Files that have an “.FPR” extension are automatically tagged as NxtPhase FPRO files. 

 
See Also: Tesla Files in the File Manager Quick Start 
  Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

FREE   
Location: File Manager (Status Field)  
 
Description: Displays the amount of free hard disk space on the active drive, displayed in Kbytes. 
 
See Also:  Size 

MrkSize 

FS 
Location: Analysis (Status Field)  
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Description: Displays the sampling frequency of the sample at the data bar.

FST 
Location: Waveform Summary (Events/Sensors Activity Summary) 
 
Description: Displays the status of the first digital samples in the file.  Fst is the first column in the 

Events/Sensors Activity Summary.  A=Alarm, N=Normal.
 
Comments: This data is also displayed in the second column of the digital in

FST-CHANGE   
Location: Waveform Summary (Events/Sensors Activity Summary) 
 
Description: Displays the date and time the channel first changed state.  Fst

in the Events/Sensors Activity Summary.
 
Comments: This data is also displayed in the forth column of the digital information table view.

FTP CONNECTION 
Location: Device Manager 
 
Description: Define the selected device to collect fault records using the FTP protocol.
 

Activation: Direct: Ethernet configuration 
 

Fields: Ethernet Connections

Connection Properties
Port Number: 

IP Address: 
User Name: 
Password: 
Remote Path: 
Local Path: 

File Types: 
File Names: 

 
Options: OK/Enter:  

Cancel/Esc:  
 
Comments: If the Local Path does not exist then the directory will be created
 
See Also: New Device Record 

Displays the sampling frequency of the sample at the data bar. 

Waveform Summary (Events/Sensors Activity Summary)  

Displays the status of the first digital samples in the file.  Fst is the first column in the 
Events/Sensors Activity Summary.  A=Alarm, N=Normal. 

This data is also displayed in the second column of the digital information table view.

Waveform Summary (Events/Sensors Activity Summary)  

Displays the date and time the channel first changed state.  Fst-Change is the third 
in the Events/Sensors Activity Summary. 

This data is also displayed in the forth column of the digital information table view.

device to collect fault records using the FTP protocol.

Ethernet configuration button  in the Device Configuration dialog.

Ethernet Connections: Select the FTP client option from the list box.  The fields in the 
connection properties changes according to the selection in the 
connections list box. 

Connection Properties:  
Set the FTP port number. 21 is designated as the FTP port 
number. 
Set the device’s IP address. 
Set the FTP sessions user name. 
Set the FTP sessions password. 
Set the device’s FTP remote path to poll. 
Set the path on the local machine where the downloaded file are 
saved. 
Set the type of file to download, leave blank to check all files
Set how to name the downloaded files, (0 – Don’t change, 1 
change to the IEEE long file naming format maintaining the original 
file’s extension, 2 – change to the IEEE long file naming format and 
make the file’s extension to the Tesla *.TLR). 

Exit and update the Device’s EscSeq field. 
Exit the dialog without saving the changes made

does not exist then the directory will be created. 

 

Displays the status of the first digital samples in the file.  Fst is the first column in the 

formation table view. 

Change is the third column 

This data is also displayed in the forth column of the digital information table view. 

device to collect fault records using the FTP protocol. 

in the Device Configuration dialog. 

The fields in the 
connection properties changes according to the selection in the 

FTP port number. 21 is designated as the FTP port 

the downloaded file are 

, leave blank to check all files. 
Don’t change, 1 – 

change to the IEEE long file naming format maintaining the original 
change to the IEEE long file naming format and 

changes made. 
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Duplicate Device Record 
Edit Device Record 
TCP/IP Client 
TCP/IP Server 

FUNCTION KEYS 
Location: Device Manager 
 
Description: Setup the device’s Function keys to be displayed in the terminal mode window. 
 

Activation: Direct: F5, menu button  
Menu: Alt-O, F 

 
Fields: F1-9 : name: The function key name displayed in the Terminal Mode window. 

TX: A string of ASCII characters or hexadecimal values transmitted to 
the connected device. 

 
Options: Enter/Save:  Exit the dialog and save the function keys (CFG_SHOT.DTB). 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: Programmable function keys allow for a string of ASCII characters or hexadecimal values to 

be transmitted to the output device through a single keystroke.  The function keys are active 
in ASCII and hexadecimal terminal emulators.  Each device contains up to nine function 
keys. 

 
See Also: ASCII Terminal Mode 

Binary Terminal Mode 

GROUP MARKED ANALOG CHANNELS 
Location: Analysis 
 
Description: Group all the marked analog channels and move them to the top of the display area. 
 
Activation: Menu: Alt-C, G 
 
See Also: Mark/Unmark Channels 

GROUP MARKED ROWS 
Location: All Tables 
 
Description: Group all the marked rows and move them to the top of the table. 
 
Activation: Menu: Alt-M, G 
 
See Also: Unmarked Marked Rows 

Toggle Marked Rows 
Mark/Unmark Row 
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HARMONICS TABLE 
Location: Analysis  
 
Description: View the harmonics table.
 
Activation: Direct: F11, Right click on phasor diagram or information header

Menu: Alt-V, T 
 
Comments: The harmonics table displays the 

frequency with a maximum of 200 harmonics supported. The table displays one channel at 
a time.  It will display the 1
first visible channel.  The harmonic calculation is performed on one cycle of data, starting at 
the RMS bar to the data bar.  The display values include DFT Peak, DFT RMS, DFT 
Angles, % of fundamental and % of TrueRMS. 
plotting window the harmonics values will be automatically updated.  To view the harmonics 

in a histogram click on the harmonics toggle 
 
See Also: Harmonics in the Analysis 

Histogram 
Harmonics Vectors 

HARMONIC VECTORS 
Location: Analysis  
 
Description: View the harmonics vectors in the phasor diagram.
 
Activation: Menu: Alt-V, H 
 
Comments: The harmonics of the first marked analog channel, or if no channels are marked then the 

first visible analog channel, is displayed in a vector format in the phasor diagram.  The 
harmonic calculation is performed on one cycle of data.  It starts at the RMS bar and goes
forward one cycle.  To hide/show the harmonic vectors toggle the "Vector Harmonics" menu 
option under the "View" menu from checked=ON to unchecked=OFF.

 
See Also: Harmonics in the Analysis Quick Start

Histogram 
Harmonics Table 

HELP 
Location: All Child Windows.  
 
Description: Displays the help file for the active child window.
 
Activation: Direct: F1 

Menu: Alt-H, T 
 
Comments: The information contained in the help window is organized in the following fashion: 

Specific Features for 
Function Keys, 
Menu Options, 
Button Menu Bar, 
Cursor Keys, 

View the harmonics table. 

F11, Right click on phasor diagram or information header 

The harmonics table displays the number of harmonics according to the file’s sampling 
maximum of 200 harmonics supported. The table displays one channel at 

a time.  It will display the 1st marked analog channel, or if no channels are marked then the 
first visible channel.  The harmonic calculation is performed on one cycle of data, starting at 
the RMS bar to the data bar.  The display values include DFT Peak, DFT RMS, DFT 
Angles, % of fundamental and % of TrueRMS.  When the data bar is moved in the data 
plotting window the harmonics values will be automatically updated.  To view the harmonics 

in a histogram click on the harmonics toggle  button located next to the channel name.

Harmonics in the Analysis Quick Start 

View the harmonics vectors in the phasor diagram. 

s of the first marked analog channel, or if no channels are marked then the 
first visible analog channel, is displayed in a vector format in the phasor diagram.  The 
harmonic calculation is performed on one cycle of data.  It starts at the RMS bar and goes
forward one cycle.  To hide/show the harmonic vectors toggle the "Vector Harmonics" menu 
option under the "View" menu from checked=ON to unchecked=OFF. 

Harmonics in the Analysis Quick Start 

 

Displays the help file for the active child window. 

The information contained in the help window is organized in the following fashion: 
Specific Features for the active window, 

file’s sampling 
maximum of 200 harmonics supported. The table displays one channel at 

r if no channels are marked then the 
first visible channel.  The harmonic calculation is performed on one cycle of data, starting at 
the RMS bar to the data bar.  The display values include DFT Peak, DFT RMS, DFT 

When the data bar is moved in the data 
plotting window the harmonics values will be automatically updated.  To view the harmonics 

button located next to the channel name. 

s of the first marked analog channel, or if no channels are marked then the 
first visible analog channel, is displayed in a vector format in the phasor diagram.  The 
harmonic calculation is performed on one cycle of data.  It starts at the RMS bar and goes 
forward one cycle.  To hide/show the harmonic vectors toggle the "Vector Harmonics" menu 

The information contained in the help window is organized in the following fashion:  
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Mouse Actions and 
Status Bar 

HEXADECIMAL EDITOR 
Location: File Manager 
 
Description: Edit the file at the cursor position in a binary editor. 
 
Activation: Direct: F3 

Menu: Alt-O, X 
 
Comments: The file contents are displayed in a Hex editor.  Use the up arrow, down arrow, page up, 

page down, Ctrl-home and Ctrl-end keys to navigate through the file’s data, or use the scroll 
bar.  When a hex value is over written the ASCII equivalent is displayed in the window to the 
right of the editor.  A maximum of 10 viewing windows can be simultaneously.  The F4 and 
F3 function keys allow for searching ASCII data or Hex values.  To search for hex values 
insert the “#” character before the hex value in the “Find Text” field. 

HEXADECIMAL DRIVER 
Location: File Manager 
 
Description: Change the driver at the cursor position to the Hexadecimal driver and display the file in 

binary format. 
 
Activation: Menu: Alt-D, 2 
 
See Also: Hexadecimal Editor 

HIDE MARK(S)  
Location: Analysis  
 
Description: Hide all the marked analog channels and re-space the unmarked channels.  
 
Activation: Direct: Delete 

Menu: Alt-C, H 
 
Comments: To mark/unmark an analog channel, click the channel ID or the channel data. 
 
See Also: View Mark(s) 

Show All Hidden 
Restore Mark(s) 

HISTOGRAM 
Location: Analysis  
 
Description: View the harmonics histogram. 
 
Activation: Direct: F11, Right click on phasor diagram or information header 

Menu: Alt-V, T 
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Comments: The histogram displays the 
with a maximum of 200 harmonics supported. The histogram displays one channel at a 
time.  It will display the 1
first visible channel.  The harmonic calculation is performed on one cycle of data, starting at 
the RMS bar to the data bar.  The display values can be DFT Peak, DFT RMS, DFT Angles, 
% of fundamental and % of TrueRMS. The

data displayed click on the drop down menu button 
the data bar is moved in the data plotting window the harmonics values will be automatically 

updated.  To view the harmonics 
located next to the channel name.

 
See Also: Harmonics in the Analysis Quick Start

Harmonics Table 
Harmonics Vectors 

HORIZONTAL BARS 
Location: Analysis  
 
Description: Displays a solid black line that follows the data bar and displays a dotted blue line that 

follows the reference bar.  
 
Activation: Menu: Alt-V, B 
 
Comments: The bars will be positioned at the first marked analog channel (displayed i

channels are marked then they are positioned at the first displayed channel.  The Delta Y 
field in the status bar shows the difference between the two bars.

 
See Also:  RMS bar 
  Data Bar 
  Reference Bar 

HP-DIF   
Location: Waveform Summary
 
Description: Displays the absolute value of the HPeak

divided by the OneBit value.
 
Comments: The Hpeak-Up value is the highest positive peak in the channel.  The 

highest negative peak in the channel.  The OneBit value is the channel's full
divided by the channel's resolution.

 
See Also: Viewing Waveform Summaries in the File Manager Quick Start

HPEAK-DN   
Location: Waveform Summary
 
Description: The highest negative peak value in the channel.
 
See Also: Viewing Waveform Summaries in the Analysis Quick Start

The histogram displays the number of harmonics according to the file’s sampling frequency 
maximum of 200 harmonics supported. The histogram displays one channel at a 

time.  It will display the 1st marked analog channel, or if no channels are marked then the 
first visible channel.  The harmonic calculation is performed on one cycle of data, starting at 
the RMS bar to the data bar.  The display values can be DFT Peak, DFT RMS, DFT Angles, 
% of fundamental and % of TrueRMS. The default view is % of fundamental. To change the 

data displayed click on the drop down menu button and select from the list. When 
the data bar is moved in the data plotting window the harmonics values will be automatically 

updated.  To view the harmonics in a table click on the harmonics toggle 
located next to the channel name. 

Harmonics in the Analysis Quick Start 

Displays a solid black line that follows the data bar and displays a dotted blue line that 
follows the reference bar.   

The bars will be positioned at the first marked analog channel (displayed i
channels are marked then they are positioned at the first displayed channel.  The Delta Y 
field in the status bar shows the difference between the two bars. 

Waveform Summary 

Displays the absolute value of the HPeak-Up minus the absolute value of the HPeak
divided by the OneBit value. 

Up value is the highest positive peak in the channel.  The Hpeak
highest negative peak in the channel.  The OneBit value is the channel's full
divided by the channel's resolution. 

Viewing Waveform Summaries in the File Manager Quick Start 

Waveform Summary 

The highest negative peak value in the channel. 

Viewing Waveform Summaries in the Analysis Quick Start 

file’s sampling frequency 
maximum of 200 harmonics supported. The histogram displays one channel at a 

if no channels are marked then the 
first visible channel.  The harmonic calculation is performed on one cycle of data, starting at 
the RMS bar to the data bar.  The display values can be DFT Peak, DFT RMS, DFT Angles, 

default view is % of fundamental. To change the 

and select from the list. When 
the data bar is moved in the data plotting window the harmonics values will be automatically 

in a table click on the harmonics toggle  button 

Displays a solid black line that follows the data bar and displays a dotted blue line that 

The bars will be positioned at the first marked analog channel (displayed in red).  If no 
channels are marked then they are positioned at the first displayed channel.  The Delta Y 

Up minus the absolute value of the HPeak-Dn 

Hpeak-Dn is the 
highest negative peak in the channel.  The OneBit value is the channel's full-scale value 



 

HPEAK-UP   
Location: Waveform Summary
 
Description: The highest positive peak value in the channel.
 
See Also: Viewing Waveform Summaries in the File Manager Quick Start

IEEE LONG FILE NAMING FORMAT

Location: IEEE Long File Name
 
Description: All data polled from the connected devices are saved to files using the IEEE long file 

naming format.  The start date and time comes from the data polled and the time code, 
substation name, device name, and company name comes from the fields in the device 
record. 

 
See Also: Long File Naming Format in 

IMPORT 
Location: Device Manager 
 
Description: Import all changes made to the exported tab delimited ASCII file.
 
Comments: The import feature is u

ASCII file. It is advisable to always keep a backup of the existing Device Configuration files 
before using the import feature. This allows for a quick recovery if any of the changes made
to the export file were incorrect. The 3 files to backup are the 
CFG_SHOT.DTB & DRIVERS.INI files located in the Wavewin directory.

 
To import a previously exported file select the “Import” menu option under the “Device” 
menu. Enter the exported files path and filename or use the “Browse” button to select the 
file. All device information contained in the imported file will be updated in the active device 
configuration table. 

 
See Also:  Export 

INCREASE AMPLITUDE 
Location: Analysis  
 
Description: Increase the amplitude of all or marked analog channels.
 
Activation: Direct: Ctrl-Up arrow or the AmpUp menu button 

Menu: Alt-D, I 
 
Comments: When the channels’ amplitude is incr

Pixsdisp value.  To change the Trace Scale Multiplier select “Window Properties” from the 
“File” menu then select the “Display Settings” tab. 

 
See Also: Decrease Amplitude 

Auto Scale Multiplier

Chapter 1

Waveform Summary 

The highest positive peak value in the channel. 

Viewing Waveform Summaries in the File Manager Quick Start 

ORMAT 
IEEE Long File Name 

from the connected devices are saved to files using the IEEE long file 
naming format.  The start date and time comes from the data polled and the time code, 
substation name, device name, and company name comes from the fields in the device 

Long File Naming Format in the Device Manager Quick Start. 

Import all changes made to the exported tab delimited ASCII file. 

The import feature is used to import all device information from the exported tab delimited 
ASCII file. It is advisable to always keep a backup of the existing Device Configuration files 
before using the import feature. This allows for a quick recovery if any of the changes made
to the export file were incorrect. The 3 files to backup are the CFG_DEVS.DTB

& DRIVERS.INI files located in the Wavewin directory.

To import a previously exported file select the “Import” menu option under the “Device” 
exported files path and filename or use the “Browse” button to select the 

file. All device information contained in the imported file will be updated in the active device 

Increase the amplitude of all or marked analog channels. 

Up arrow or the AmpUp menu button  

When the channels’ amplitude is increased the Trace Scale multiplier is multiplied into the 
Pixsdisp value.  To change the Trace Scale Multiplier select “Window Properties” from the 
“File” menu then select the “Display Settings” tab.  

 
Multiplier 
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from the connected devices are saved to files using the IEEE long file 
naming format.  The start date and time comes from the data polled and the time code, 
substation name, device name, and company name comes from the fields in the device 

sed to import all device information from the exported tab delimited 
ASCII file. It is advisable to always keep a backup of the existing Device Configuration files 
before using the import feature. This allows for a quick recovery if any of the changes made 

CFG_DEVS.DTB, 
& DRIVERS.INI files located in the Wavewin directory. 

To import a previously exported file select the “Import” menu option under the “Device” 
exported files path and filename or use the “Browse” button to select the 

file. All device information contained in the imported file will be updated in the active device 

eased the Trace Scale multiplier is multiplied into the 
Pixsdisp value.  To change the Trace Scale Multiplier select “Window Properties” from the 
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INSTPEAK COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the peak value measured between the two reference crossings surrounding the 

data bar (black solid line).  The value is displayed as Peak type.  If the data type for the 
loaded driver is set to RMS calibrated then the value is multiplied by the square root of 2. 

 
Comments: The value is displayed as Peak type.  If the data type for the loaded driver is set to RMS 

calibrated then the value is multiplied by the square root of 2. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

INSTVAL COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the instantaneous sample value at the data bar. 
 
Comments: This value is multiplied by the square root of 2 if the driver’s data type is set to RMS 

calibrated. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

Data Bar 

INTELLIRUPTER DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the S&C IntelliRupter driver. 
 
Activation: Menu: Alt-D, S 
 
Comments: An error message is displayed if the selected file is not a valid IntelliRupter file. Files that 

have a “.WFC” extension are automatically tagged as IntelliRupter files. 
 
See Also: Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

LATITUDE FIELD 
Location: IEEE Long File Name  
 
Description: An optional field in the IEEE long file naming format.  The latitude defines the geographical 

position of the substation associated with the file name.  The letter N indicates latitude in the 
Northern Hemisphere. 

 
See Also: Long File Naming Format in Chapter 1. 

LESS THAN (<) 
Location: Query Fields 
 
Description: Search the active configuration for records that are less than the entered criteria. 
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Comments: To change the operator press F9 or click the mouse button on the operator symbol. 
 
See Also:  Equal To (=) 

Greater Than (>) 

LP-DIF 
Location: Waveform Summary 
 
Description: Displays the absolute value of the LPeak-Up minus the absolute value of the LPeak-Dn 

divided by the OneBit value. 
 
Comments: The Lpeak-Up value is the lowest positive peak in the channel.  The Lpeak-Dn is the lowest 

negative peak in the channel.  The OneBit value is the channel's full-scale value divide by 
the channel's resolution. 

 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

LPEAK-DN   
Location: Waveform Summary 
 
Description: The lowest negative peak value in the channel. 
 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

LPEAK-UP   
Location: Waveform Summary 
 
Description: The lowest positive peak value in the channel. 
 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

LPRO DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the NxtPhase LPRO driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
 
Comments: NxtPhase files are displayed in the IEEE Comtrade Binary format. NxtPhase has developed 

an automatic conversion application called "AutoComtrade.exe". Wavewin calls 
"AutoComtrade.exe" to convert NxtPhase files to the Comtrade binary format for display. To 
view NxtPhase relay files double click or press enter on the original LPRO files. To obtain a 
copy of the “AutoComtrade.exe” file please contact NxtPhase. 

 
Files that have an “.LPR” extension are automatically tagged as NxtPhase LPRO files. 

 
See Also: Tesla Files in the File Manager Quick Start 
  Display Oscillography in the File Manager Quick Start 
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Associating File Types in the File Manager Quick Start 

LST   
Location: Waveform Summary (Events/Sensors Activity Summary)  
 
Description: Displays the status of the last digital samples in the file.  Lst is the second column in the 

Events/Sensors Activity Summary.  A=Alarm, N=Normal. 
 
Comments: This data is also displayed in the third column of the digital information table view. 

LST-CHANGE 
Location: Waveform Summary (Events/Sensors Activity Summary)  
 
Description: Displays the date and time the digital channel last changed state.  Lst-Change is the forth 

column in the Events/Sensors Activity Summary.   
 
Comments: This data is also displayed in the fifth column of the digital information table view. 

MARK ALL ROWS 
Location: All Tables 
 
Description: Mark all the rows in the table. 
 

Activation: Direct: Mark menu button (if no files are marked).  
Menu: Alt-M, A 

 
Comments: Marked rows are displayed in red.  The TotMarks field displayed in the status bar is updated 

accordingly.  The Mark menu button toggles between marking and unmarking all rows in the 
table. 

 
See Also: Unmarked Marked Rows 

Flip Marks 
Group Marked Rows 

MARK/UNMARK ALL CHANNELS 
Location: Analysis 
 
Description: Unmark all analog & digital channels if the total number of marked channels is less than the 

total number of displayed channels otherwise mark all the channels. 
  
Activation: Direct: F8 

Menu: Alt-C, M 
 
Comments: When an analog channel is marked the ID, title, ASV, and units are displayed in light red.  

When a digital channel is marked the ID and titles are displayed in light red.  To mark or 
unmark a channel click the channel’s corresponding ID number or title, or use the space 
bar. 
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MARK/UNMARK ROW 
Location: All Tables 
 
Description: Toggle the row at the cursor position between the marked and unmarked state. 
 
Activation: Direct: Spacebar, Ctrl-Left Mouse Click 

Menu: Alt-M, M 
 
Comments: Marked rows are displayed in red.  The TotMarks field displayed in the status bar is updated 

accordingly.  The Mark menu button toggles all the rows in the table between the marked 
and unmarked state. 

MARK CHANGE IN SIGN 
Location: Analysis 
 
Description: Mark all positions in the analog channels where the waveform changes in sign. 
  
Activation: Menu: Alt-A, H 
 
Comments: A small gray triangle marks the change in sign position. 
 
See Also: Mark Raw Values 

Mark Peak Values 

MARK PEAK VALUES 
Location: Analysis 
 
Description: Mark all positive and negative peaks on the analog channels. 
  
Activation: Menu: Alt-A, H 
 
Comments: A small gray square marks the positive and negative peaks. 
 
See Also: Mark Change in Sign 

Mark Raw Values 

MARK RAW VALUES 
Location: Analysis 
 
Description: Mark all the raw samples read from the active waveform file. 
  
Activation: Menu: Alt-A, M 
 
Comments: A small hollow blue circle is placed at the raw samples read from the file. 
 
See Also: Mark Change in Sign 

Mark Peak Values 
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MAX X PIXELS  
Location: DXF Animated CAD (Drawing Properties Dialog)  
 
Description: Displays the total number of X pixels allocation for the active DXF drawing. 
 

Activation: Direct: F2 – drawing properties menu button  
Menu: Alt-T, D 

 
Comments: This value changes automatically when the Zoom In/Out features are used and is updated 

accordingly in the DXF status bar. 
 
See Also: Zoom In 

Zoom Out 
Zoom X, Y Resolution Properties 

MAX Y PIXELS  
Location: DXF Animated CAD (Drawing Properties Dialog)  
 
Description: Displays the total number of Y pixels allocation for the active DXF drawing. 
 

Activation: Direct: F2 – drawing properties menu button  
Menu: Alt-T, D 

 
Comments: This value changes automatically when the Zoom In/Out features are used and is updated 

accordingly in the status bar. 
 
See Also: Zoom In 

Zoom Out 
Zoom X, Y Resolution Properties 

MAXPEAK COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the maximum peak value of the channel. 
 
Comments: If the active driver’s data type is set to RMS calibrated then the files maxpeak value is 

multiplied by Root 2. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

MAXVAL COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the maximum value of the channel. 
 
Comments: This column is displayed if the active driver’s data type is set to Non-Sinusoidal-Log Files. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 



 

MAXWIN COLUMN 
Location: Analysis (Analog Table) 
 
Description: Displays the absolute maximum value between the RMS bar (black dotted line) and the data 

bar (black solid line).
 
Comments: This column is displayed if the active driver’s data type is set to Non
 
See Also: Viewing Analog Data in the Analysis Quick Start

Data Bar 
RMS Bar 

MDAR REL 301/302 DRIVER 
Location: File Manager (Universal Viewer)
 
Description: Change the driver at the cursor position to the MDAR REL 301/302 driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, D 
 
Comments: If the selected file is not a valid REL file an error message is generated.  All files that have 

the “.REL” extension are tagged as MDAR REL files.  The MDAR REL driver uses circular 
interpolation techniques to convert the input sampling frequency to a higher frequency 
suitable for display.  The input sampling frequency is 8 samples per cycle (45 degrees 
apart). 

MEDIUM DISPLAY 
Location: Analysis 
 
Description: Display the analog channel using the maximum pixels allowed with no zero reference point.  

The medium display is activated through the Auto Scale feature

Activation: Direct: F6, - Auto Scale button 
Menu: Alt-D, A, P 

 
Comments: The Auto Scale toggles between (Off, On and ++).  ++ plots the signal using the number of 

maximum pixels allowed for the channel.  The highest value is plotted at the maximum 
position allowed and the smallest value is plotted at the 
feature was added to clearly show the profile of frequency, Vdc and load data channels.

 
See Also: Scaling Analog Channels in the Analysis Quick Start
 AS Status Field 
 Auto Scaling 

MERGE OPEN FILES 
Location: Analysis 
 
Description: Merge the visible or marked channels from all the open 

window.  There are three Merge options ava
the common times in the open files.  Merge files “Manually” will merge the data according to 

Chapter 1

(Analog Table)  

Displays the absolute maximum value between the RMS bar (black dotted line) and the data 
bar (black solid line). 

This column is displayed if the active driver’s data type is set to Non-Sinusoidal

Viewing Analog Data in the Analysis Quick Start 

File Manager (Universal Viewer) 

Change the driver at the cursor position to the MDAR REL 301/302 driver and plot the input 

If the selected file is not a valid REL file an error message is generated.  All files that have 
sion are tagged as MDAR REL files.  The MDAR REL driver uses circular 

interpolation techniques to convert the input sampling frequency to a higher frequency 
suitable for display.  The input sampling frequency is 8 samples per cycle (45 degrees 

Display the analog channel using the maximum pixels allowed with no zero reference point.  
The medium display is activated through the Auto Scale feature. 

Auto Scale button  

uto Scale toggles between (Off, On and ++).  ++ plots the signal using the number of 
maximum pixels allowed for the channel.  The highest value is plotted at the maximum 

tion allowed and the smallest value is plotted at the lowest position allowed.  This 
feature was added to clearly show the profile of frequency, Vdc and load data channels.

Scaling Analog Channels in the Analysis Quick Start 

Merge the visible or marked channels from all the open analysis windows into a new data 
window.  There are three Merge options available.  Merge files “By Time” will merge only 
the common times in the open files.  Merge files “Manually” will merge the data according to 
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Displays the absolute maximum value between the RMS bar (black dotted line) and the data 

Sinusoidal-Log Files. 

Change the driver at the cursor position to the MDAR REL 301/302 driver and plot the input 

If the selected file is not a valid REL file an error message is generated.  All files that have 
sion are tagged as MDAR REL files.  The MDAR REL driver uses circular 

interpolation techniques to convert the input sampling frequency to a higher frequency 
suitable for display.  The input sampling frequency is 8 samples per cycle (45 degrees 

Display the analog channel using the maximum pixels allowed with no zero reference point.  

uto Scale toggles between (Off, On and ++).  ++ plots the signal using the number of 
maximum pixels allowed for the channel.  The highest value is plotted at the maximum 

lowest position allowed.  This 
feature was added to clearly show the profile of frequency, Vdc and load data channels. 

windows into a new data 
ilable.  Merge files “By Time” will merge only 

the common times in the open files.  Merge files “Manually” will merge the data according to 
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the positions of the data bars in each open window.  Merge files “By Sample” will merge the 
files by lining up the samples in each open window. 

 
Activation: Menu: Alt-F, G, B-“By Time”, M-“Manually”, S-“By Sample” 
 
Comments: To distinguish between the merged channels the station name is placed before each 

channel merged.  To deactivate this feature open the “Window Properties” dialog, select the 
“Append/Merge” tab and click the “Merge Files” option.  If the files have different sampling 
frequencies a dialog will be display to select the frequency for the new window. 

 
See Also: Merge Open Files in the Analysis Quick Start 
 Merge Waveform Files 

MERGE WAVEFORM FILES 
Location: File Manager 
 
Description: Merge all the channels from the marked waveform file into a analysis window.  There are 

two Merge options available.  Merge files “By Time” will merge only the common times in 
the open files.  Merge files “By Sample” will merge the files by lining up the samples in each 
open window. 

 
Activation: Menu: Alt-O, W, M, B-“By Time”, S-“By Sample” 
 
Comments: To distinguish between the merged channels the station name is placed before each 

channel merged.  To deactivate this feature open the analysis “Window Properties” dialog, 
select the “Append/Merge” tab and click the “Merge Files” option.  If the files have different 
sampling frequencies a dialog will be display to select the frequency for the new window. 

 
See Also: Merge Waveform Files in the File Manager Quick Start 
 Merge Open Files 

MINPEAK COLUMN 
Location: Analysis (Analog Table)  
 
Description: MinPeak is the column that displays the minimum peak value of the channel. 
 
Comments: If the active driver’s data type is set to RMS calibrated then the files minpeak value is 

multiplied by Root 2. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

MINVAL COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the minimum value of the channel. 
 
Comments: This column is displayed if the active driver’s data type is set to Non-Sinusoidal-Log Files. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 



 

MOVE FILES 
Location: File Manager 
 
Description: Copy the marked files to the specified

directory.  If a file is not copied successfully it is marked and grouped at the top of source 
directory.  To create a new destination directory enter the name into the Directories edit box.  
The system prompts prior to creating the new directory.

 

Activation: Direct: F9, - Move menu button 
Menu: Alt-F, M 

 
Fields: Directory Name: 

Directories: 

  Files:   
  Drives:   
 
Options: Enter/Ok:  

Esc/Cancel:  
 
Comments: Marked files are displayed in red.  The TotMarks and MrkSize fi

bar are updated accordingly.  
 
See Also:  Copy Files 

Mark/Unmark File 

MOVE RMS BAR TO REFERENCE 

Location: Analysis 
 
Description: Move the RMS bar (black dotted line) to the sample at the Reference bar position (blue 

dotted line). 
 
Activation: Direct: Ctrl-Z – Set RMS bar menu button 

Menu: Alt-V, R 
 
Comments: The RMS and Data bars define the RMS sliding window.
 
See Also: Setting the Cursor Bars in the Analysis Quick Start

RMS Bar 

MOVE REFERENCE BAR TO DATA 

Location: Analysis 
 
Description: Move the Reference bar (blue dotted line) to the 

line). 
 
Activation: Direct: Ctrl-A – Set Reference Bar menu button 

Menu: Alt-V, M 
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Copy the marked files to the specified destination path then delete the files from the source 
directory.  If a file is not copied successfully it is marked and grouped at the top of source 
directory.  To create a new destination directory enter the name into the Directories edit box.  

em prompts prior to creating the new directory. 

Move menu button  

The destination path where the marked files are to be moved.  To 
specify a new path, type the path directly into this edit
Displays a tree of the system’s directories, double click to open a 
node in the tree and click on the desired directory to highlight it.
Displays a list of the files in the highlighted directory.

 A list of all the connected drives.  Select the desired drive.

Move the marked files to the selected destination path.
Exit the dialog without executing the command. 

Marked files are displayed in red.  The TotMarks and MrkSize fields displayed in the status 
bar are updated accordingly.   

EFERENCE BAR 

the RMS bar (black dotted line) to the sample at the Reference bar position (blue 

Set RMS bar menu button  

The RMS and Data bars define the RMS sliding window. 

ursor Bars in the Analysis Quick Start 

ATA BAR 

Move the Reference bar (blue dotted line) to the sample at the Data bar position (black solid 

Set Reference Bar menu button  
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destination path then delete the files from the source 
directory.  If a file is not copied successfully it is marked and grouped at the top of source 
directory.  To create a new destination directory enter the name into the Directories edit box.  

The destination path where the marked files are to be moved.  To 
specify a new path, type the path directly into this edit box. 
Displays a tree of the system’s directories, double click to open a 
node in the tree and click on the desired directory to highlight it. 
Displays a list of the files in the highlighted directory. 

connected drives.  Select the desired drive. 

Move the marked files to the selected destination path. 
 

elds displayed in the status 

the RMS bar (black dotted line) to the sample at the Reference bar position (blue 

sample at the Data bar position (black solid 
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Comments: The Delta time field (Delta X) in the status bar at the bottom of the screen displays the time 
difference between the reference bar and the data bar.  If the time difference between the 
samples is in milliseconds or microseconds then the number of cycles between the two bars 
is also displayed.   

 
See Also: Setting the Cursor Bars in the Analysis Quick Start 

Data Bar 
Reference Bar 

MRKSIZE   
Location: File Manager (Status Field)  
 
Description: Displays the combined size  (in Kbytes) for all marked files. 
 
See Also:  Size 

Free 

MULTIPORT INTERROGATION DISPLAY (MID) 
Location: Device Manager 
 
Description: Display the MID window to periodically execute the device’s assigned drivers and updates 

the parsed information into the device panel. 
 

Activation: Direct: F7 – menu button  
Menu: Alt-O, M 

 
Comments: The Multiport Interrogation Display (MID) contains four device panels per page.  A 

maximum of 999 device panels can be opened at one time.  To activate the MID window 
press F7.  If no devices are marked, all devices assigned a driver are displayed and polled.  
Use the up, down, page up, and page down keys to view the device panels.  When F7 is 
pressed the device’s TXCOMMAND assigned in the DRIVERS.INI file is periodically sent to 
the output device.  The response data is parsed by the RXSTRIP commands and updated 
in the device panel.  Each panel displays the device title (Hdr), the assigned active device 
drive (Drv), the device number (Dev#), and the number of times the driver executed (Cycle). 

 
See Also: Multiport Interrogation Display in the Device Manager Quick Start 

NEW DEVICE CONFIGURATION 
Location: Device Manager 
 
Description: Open a new device configuration table with 0 devices defined in the table and database 

files. 
 
Activation: Menu: Alt-D, W 
 
Comments: A “Select Directory” dialog allows for selecting an existing directory or for creating a new 

directory for the new configuration.  To create a new directory type the directory name in the 
“Directory Name” field.  If the directory does not exists the system prompts a message for 
confirmation to create the directory.  The “CFG_DEVS.DTB” and “CFG_SHOT.DTB” files 
are created with zero records.  If these files exist in the selected directory then they are 
cleared.  The system will prompt a message asking to copy the existing “DRIVERS.INI” file 



 

to the new configuration directory   Select “Yes” to use 
new configuration or “No” to create a new “DRIVERS.INI” file.

 
See Also: System Files in the Device Manager Quick Start

New Device Record 
Duplicate Device Record

NEW DEVICE RECORD 
Location: Device Manager 
 
Description: Create a new device record in the table.
 

Activation: Direct: F4 –menu button 
Menu: Alt-D, N 

NEW DEVICE CONFIGURATION 
Location: Device Manager 
 
Description: Open a new device configuration table with 0 devices defined in the table and database 

files. 
 
Activation: Menu: Alt-D, W 
 
Fields: Device Settings:  

Device Number: 

Address: 

Station ID: 

Data Type: 
Print : 
Title: 
Driver: 
Station Name: 
Time Code: 
EscSeq: 

Port Settings:  
Port Number: 

Baud Rate: 
Parity: 
Data Bits: 
Stop Bits: 
Flow Control: 
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to the new configuration directory   Select “Yes” to use the existing “DRIVERS.INI” for the 
new configuration or “No” to create a new “DRIVERS.INI” file. 

the Device Manager Quick Start  
 

Duplicate Device Record 

Create a new device record in the table. 

menu button  

Open a new device configuration table with 0 devices defined in the table and database 

Set the number of the device. Each device must have
number.  The device number is used in the IEEE long file naming 
format. 
Set the address of the device. The address can be the port number 
off a 2020/2030 or a modbus address. 
Set the ID number for the station each station mus
number. 
Select the type of data being polled (ASCII/Binary).
Select if the data polled is sent to the connected printer (On/Off).
Set the device title. 
Select the main driver that will poll the device. 
Set the station name. 
Select the main driver that will poll the device. 
The EscSeq field contains 7 separate fields separated by a blank. 
Set the appropriate information in the appropriate
can contain passwords, phone numbers, file names, FTP settings, 
TCP/IP settings for a specific device refer to the “Device 
Configuration” document. 

Select the COM port number from the list of COM ports registered 
on the machine or enter a new COM port number.  For TCP/IP and 
FTP connections each device must have a unique COM port 
number. 
Select the port’s baud rate. 
Select the port’s parity (None, ODD, Even, Mark).
Select the port’s Data Bits (7 or 8). 
Select the port’s stop bits (1 or 2). 
Select the port’s flow control (None, Software or Hardware).
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the existing “DRIVERS.INI” for the 

Open a new device configuration table with 0 devices defined in the table and database 

Set the number of the device. Each device must have a unique 
number.  The device number is used in the IEEE long file naming 

Set the address of the device. The address can be the port number 

Set the ID number for the station each station must have a unique 

Select the type of data being polled (ASCII/Binary). 
Select if the data polled is sent to the connected printer (On/Off). 

7 separate fields separated by a blank. 
appropriate fields.  The fields 

rds, phone numbers, file names, FTP settings, 
TCP/IP settings for a specific device refer to the “Device 

Select the COM port number from the list of COM ports registered 
M port number.  For TCP/IP and 

FTP connections each device must have a unique COM port 

Select the port’s parity (None, ODD, Even, Mark). 

Select the port’s flow control (None, Software or Hardware). 
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Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or none 

in terminal mode. 
Local Echo: Select if the transmitted text is echoed to the terminal window. 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or none 

in terminal mode. 
TX Delay:  
Inter Char Delay: Enter the number of milliseconds to wait when transmitting 

characters to the device. 
 
Options: Save/Enter: Exit and save the dialog fields. 

Esc/Cancel: Exit the dialog without saving the dialog fields. 
 
Comments: A “Select Directory” dialog allows for selecting an existing directory or for creating a new 

directory for the new configuration.  To create a new directory type the directory name in the 
“Directory Name” field.  If the directory does not exists the system prompts a message for 
confirmation to create the directory.  The “CFG_DEVS.DTB” and “CFG_SHOT.DTB” files 
are created with zero records.  If these files exist in the selected directory then they are 
cleared.  The system will prompt a message asking to copy the existing “DRIVERS.INI” file 
to the new configuration directory   Select “Yes” to use the existing “DRIVERS.INI” for the 
new configuration or “No” to create a new “DRIVERS.INI” file. 

 
Comments: Some of the fields are set to default values such as: port number, baud rate, parity, data 

bits, stop bits and flow control.  The device number is a required field and must be unique.  
An error message will be displayed if any invalid fields are encountered. 

 
See Also: New Device Record  

Edit Device Record 
Duplicate Device Record 

NEW FILE 
Location: ASCII Editor 
 
Description: Open a new empty ASCII edit window with the title defaulted to Untitled. 
 
See Also: Open File 

ONEBIT   
Location: Waveform Summary 
 
Description: Displays the analog channel's full-scale value divide by the channel's resolution. 
 
Comments: The OneBit value is used to calculate the HP-Dif and the LP-Dif. 
 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

HP-Dif 
LP-Dif 

OPEN ALL MARKED WAVEFORM FILES 
Location: File Manager 
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Description: Open all the marked waveform files in the file table and minimize the file table. 
 
Activation: Menu: Alt-O, W, F 
 
Comments: All the marked waveform files are opened, tiled and the file table is minimized.  A maximum 

of 10 data windows can be open at one time. 
 
See Also: Open All Marked Files in the File Manager Quick Start 

OPEN FILE   
Location: ASCII Editor 
 
Description: Open the window open file dialog box to select an existing file.  The open file will be put in a 

new ASCII edit window. 
 
See Also: New File 

OPTIONAL COLUMNS  
Location: File Manager 
 
Description: The IEEE PSRC long file naming convention allows for user defined fields appended at the 

end of the filename.  The file table reserves 4 columns for the first 4 user defined fields.  
The columns are named Optional-1 to Optional-4. 

 
See Also: Long File Naming Format in the File Manager Quick Start 

PASTE DEVICE RECORDS 
Location: Device Manager 
 
Description: Paste the device records from the system clipboard files to the active device configuration. 
 
Activation: Menu: Alt-D, T 
 
Comments: Device records copied to the system clipboard files (“DEV_CLIPBOARD.CLP”, 

“LOG_CLIPBOARD.CLP”) can be pasted into the active device configuration files.  After 
each paste operation the device table is updated and all devices are initialized. 

 
See Also: Change Device Configuration 

New Device Configuration 
Copy Device Records 

PASTE TEXT 
Location: ASCII Editor 
 
Description: Paste the contents of the clipboard into the document at the cursor position.  Existing 

blocked text is overwritten with the contents of the clipboard. 
 

Activation: Direct: Ctrl-V, Shift-Ins - Paste menu button  



Chapter 1 – Fields & Features 
 

50 
 

Menu: Alt-E, P 
 
Comments: Use the shift keys and the up, down, page up and page down keys to block file text. 
 
See Also:  Copy Text 

Cut Text 

PATH/FILENAME (NO EXT.)  
Location: Save as COMTRADE Dialog (ASCII/Binary)  
 
Description: Displays the destination path and filename of the new COMTRADE file. 
 
Comments: The oscillography file at the cursor position is saved in COMTRADE format to the specified 

filename.  When specifying a filename do not enter an extension, the “.CFG” and “.DAT” 
files are automatically created.  If a path is not specified the files are saved to the active 
directory. 

 
Restrictions: The filename cannot contain an extension. 

PHASOR/CIRCULAR CHART SCALE MULTIPLIER (ASM) 
Location: Analysis (Window Properties Dialog)  
 
Description: Used as a multiplier to increase/decrease the length of a vector in the phasor diagram or to 

increase/decrease the circular chart data. 
 
Activation: Menu: Alt-F, T, “Display Settings” Tab 
 
Range: Greater Than 1.00 
 
Default: 2.00 
 
Comments: When a channel's amplitude is increased, the phasor/circular chart scale value is multiplied 

with the Pixsdisp value, and when the channel's amplitude is decreased the phasor/circular 
chart scale value is divided by the Pixsdisp value . 

PIXSDISP COLUMN 
Location: Analysis 
 
Description: Displays the number of pixels allocated for the channels.   

 
Comments: When a channels’ amplitude is increased or decreased the trace scale multiplier, set in the 

“Window Properties” dialog, is multiplied or divided with the PixsDisp values in the analog 
information table.  To increase or decrease the channels’ amplitude, select “Increase 
Amplitude” or “Decrease Amplitude” from the Data menu.  If no channels are marked, all 
channels are scaled accordingly. 

 
See Also: Trace Scale Multiplier  

Auto Scaling 
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PLAY CHANNELS AUDIO 
Location: Analysis 
 
Description: Plays the audio of the first marked analog channel. If no channels are marked then it plays 

the audio of the first displayed channel. 
 
Activation: Menu: Alt-D, P 
 
Fields: Analog Channel: Title of the active analog channel. 

Save Audio: Active saving the analog channel data to the window’s .WAV 
format. 

  Audio Filename: The path and name of the saved .WAV file. 
  Drives:   A list of all the connected drives.  Select the desired drive. 
 
Options: Play:   Play the active analog channels data. 

Volume:  Decrease/Increase the volume of the output. 
 
Comments: Marked channels are displayed in red. The “Active Channel” section displays the active 

analog channel in the analysis window. The “Audio Controls” section allows for playing the 
active analog channel’s data through the computers speakers and for increasing/decreasing 
the volume of the output. The “Save .WAV File” section allows for saving the analog 
channel data in the Window’s .WAV format. Click the folder button  to select and 
destination directory and to enter a new “.WAV” file or for selecting an existing “.WAV” file. 
The selected file path and name will be updated in the “Audio Filename” field. 

 
See Also:  Play Channels Audio in the Analysis Quick Start 

PRIMARY VALUES 
Location: Analysis (Analog Table)  
 
Description: The values displayed in the analog table are either in primary or secondary quantities. If the 

file defines the type of values saved then the type is displayed in the window header. Also, if 
the CT and PT ratios are defined in the configuration file then the values can be changed 
from primary to secondary and vice versa. To change the values open the properties dialog 
and click on the “Driver Data Type” tab, select the Primary or Secondary radio button to 
switch between values. 

  
See Also: Changing Analog Values in the Analysis Quick Start 

Secondary Values 

PRINT ALL DATA 
Location: Analysis 
 
Description: Print all the data for the visible analog and digital channels. 
 
Activation: Menu: Alt-F, P, A 
 
Comments: The printer must be registered in the system's WIN.INI file.  The printed pages include the 

page number and the date/time of the first sample in the page.  The channel information is 
printed at the end of the data.  Use the print page option to print only the contents of the 
data window. 
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See Also: Printer Setup 

PRINT ALL ROWS 
Location: All Tables 
 
Description: Print all the rows in active table. 
 
Activation: Menu: Alt-F, P, A  
 
Comments: The printer must be registered in the system's WIN.INI file.  Use the Print Marked option to 

print only the marked files. 
 
See Also:  Printer Setup 

PRINT DXF FILE 
Location: DXF Animated CAD 
 
Description: Print the contents of the active DXF file. 
 
Activation: Menu: Alt-T, P, F 
 
Comments: The printer must be registered in the system's WIN.INI file.  Use the Print DXF Page option 

to print only the contents displayed in the window. 
 
See Also:  Printer Setup 

PRINTER SETUP 
Location: All child windows. 
 
Description: Change the printer type and setup the current printer. 
 
Activation: Menu: Alt-F, S – Device Manager/ASCII/Binary Event Editor 

Menu: Alt-T, S – DXF Display 

PRINT FILE 
Location: ASCII/Binary Event File 
 
Description: Print all pages in the open file. 
 
Activation: Menu: Alt-F, P, F 
 
Comments: The printer must be registered in the system's WIN.INI file.  In the ASCII/Binary editors, use 

the “Print/File Page” option to print the current page. 
 
See Also:  Printer Setup 

QUERY ALL ROWS 
Location: Query Fields 



Chapter 1 – Fields & Features 
 

53 
 

 
Description: Compare the entered criteria to all the records in the active configuration. 
 
Activation: Direct: F6, <enter> 

Menu: Alt-Q, A 
 
Comments: All the records in the active configuration are compared to the entered query criteria.  A 

marked record that does not meet the query requirements is unmarked.  The records that 
meet the query requirements are marked and grouped at the top of the table.  Marked 
records are displayed in red. 

 
The Enter key searches all the records in the table. 

 
See Also: Query Marked Records 

Query Unmarked Records 
Clear Query Criteria 

QUERY MARKED ROWS 
Location: Query Fields 
 
Description: Compare the entered criteria to the marked records in the active configuration. 
 
Activation: Direct: F5 

Menu: Alt-Q, M 
 
Comments: The marked records that meet the query requirements are marked and grouped at the top of 

the table.  All other marked records are unmarked.  Marked records are displayed in red. 
 
See Also: Query Unmarked Records 

Query All Records 

QUERY UNMARKED ROWS 
Location: Query Fields 
 
Description: Compare the entered criteria to the unmarked records in the active configuration. 
 
Activation: Direct: F7 

Menu: Alt-Q, U 
 
Comments: The unmarked records that meet the query requirements are marked and grouped below 

previous marked records.  Marked records are displayed in red. 
 
See Also: Query Marked Records 

Query All Records 

RECORDED CHANNELS 
Location: Analysis 
 
Description: Display the following information for the active oscillography file: 

Channel # Analog Channel Titles  Full Scale Values 
SAC #  SAC Titles   Full Scale Values 
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Channel # Digital Channel Titles
SDC #  SDC Titles

 
 

Activation: Direct: F2 - Channel menu button 
Menu: Alt-F, R 

 
Comments: Triggered digital channel 

displayed. 

REFERENCE BAR 
Location: Analysis 
 
Description: Displays the instantaneous sample value at the reference bar position (dotte

runs vertically across the analog and digital channels).  This value is displayed in the RefVal 
column of the analog table view.

 
Comments: The reference bar is used to resize the RMS sliding window and display the instantaneous 

value at the sample position.  To resize the sliding window, click the right mouse button to 
set the reference bar position and the left mouse button to set the data bar position then 
select the Set RMS Bar

 
The Delta time (Delta X) field, displayed
the reference bar and the data bar.  If the time difference between the samples is in 
milliseconds or microseconds then the number of cycles between the two bars is also 
displayed. 
 
The default position of the reference bar is at the fault time.

 
See Also:  Data Bar 

RefVal 
Fault Bar 

REFRESH 
Location: File Manager 
 
Description: Update the contents of the active directory from the operating sy
 

Activation: Direct: Refresh menu button 
Menu: Alt-F, F 

REFVAL COLUMN 
Location: Analysis (Analog Table) 
 
Description: Displays the sample value at the Reference bar (blue 
 
Comments: If the active driver’s data type is set to RMS calibrated, the sample value at the data bar 

position is multiplied by the square root of 2.
 
See Also: Viewing Analog Data in the Analysis Quick Start

Digital Channel Titles  Original State Values 
SDC Titles   Original State Values 

Channel menu button  

Triggered digital channel titles are displayed in red.  All valid and invalid channels are 

Displays the instantaneous sample value at the reference bar position (dotte
runs vertically across the analog and digital channels).  This value is displayed in the RefVal 
column of the analog table view. 

The reference bar is used to resize the RMS sliding window and display the instantaneous 
he sample position.  To resize the sliding window, click the right mouse button to 

set the reference bar position and the left mouse button to set the data bar position then 
Set RMS Bar  menu button.   

The Delta time (Delta X) field, displayed in the status bar shows the time difference between 
the reference bar and the data bar.  If the time difference between the samples is in 
milliseconds or microseconds then the number of cycles between the two bars is also 

of the reference bar is at the fault time. 

Update the contents of the active directory from the operating system's allocation table.

Refresh menu button  

(Analog Table)  

Displays the sample value at the Reference bar (blue dotted line). 

If the active driver’s data type is set to RMS calibrated, the sample value at the data bar 
position is multiplied by the square root of 2. 

Viewing Analog Data in the Analysis Quick Start 

titles are displayed in red.  All valid and invalid channels are 

Displays the instantaneous sample value at the reference bar position (dotted blue line that 
runs vertically across the analog and digital channels).  This value is displayed in the RefVal 

The reference bar is used to resize the RMS sliding window and display the instantaneous 
he sample position.  To resize the sliding window, click the right mouse button to 

set the reference bar position and the left mouse button to set the data bar position then 

in the status bar shows the time difference between 
the reference bar and the data bar.  If the time difference between the samples is in 
milliseconds or microseconds then the number of cycles between the two bars is also 

stem's allocation table. 

If the active driver’s data type is set to RMS calibrated, the sample value at the data bar 
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Reference Bar 

RENAME FILE/DIRECTORY 
Location: File Manager 
 
Description: Rename the file or directory at the cursor position. 
 
Activation: Menu: Alt-F, N 
 
Fields: From: The current name of the file. 

To: The new name of the file. 
 
Options: Enter/Ok: Change the name. 

Esc/Cancel: Exit the dialog without executing the command. 

REOPEN WAVEFORM FILE 
Location: Analysis 
 
Description: Reopen a file that was previously viewed. 
 

Activation: Menu Bar:  Open File drop down menu button  
 
Comments: A list of the last 14 open files is displayed in a drop down menu button.  Click the on the file 

to reopen. 
 
See Also: Reopen Waveform File in the Analysis Quick Start 

REPLAY PLUS DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Hathaway Replay Plus driver and plot the 

input channels. 
 
Activation: Menu: Alt-D, R 
 
Comments: The Replay Plus driver reads and displays waveform (dfr), disturbance (css) and trend (tss) 

files. If the selected file is not a valid Replay Plus file an error message is generated.  All 
files that have the “.DAT” extension, with no corresponding “.CFG” file are tagged as Replay 
Plus files. 

 
See Also: Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

RESIZE COLUMNS 
Location: All Tables 
 
Description: Resize the columns in the table. 
 
Activation: Direct: Mouse Drag 
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Comments: To resize the table columns, place the mouse over the column separator and drag to the 

right or the left.  The cursor changes to the verti
positioned over the column separator.  Double click the mouse over the separators to make 
the column size the maximum area to display all the text in the column.

RESIZE SLIDING WINDOW 
Location: Analysis 
 
Description: Resize the RMS sliding window.
 

Activation: Direct: Resize Sliding Window menu button 
Menu: Alt-V, W 

 
Comments: To automatically resize the RMS sliding window click on the 

button  or open the “Resize Sliding Window” menu option under the “View” menu.
manually resize the RMS sliding window click the right mouse button to set the reference 
position and the left mouse button to set the ending data positi

 menu button.  The RMS bar is moved to the reference position.  The Delta time (Delta 
X) field displayed in the status bar at the bottom of the screen shows the time difference (in 
milliseconds or seconds) and the number of cycles
Use the left, right, ctrl+left, and ctrl+right keys or the horizontal scroll bar to move the sliding 
window.  

 
See Also: Setting the Cursor Bars in the Analysis Quick Start

Data Bar 
RMS Bar 
Reference Bar 

RESTORE MARK(S)  
Location: Analysis 
 
Description: Restore all the hidden analog channels.  The delete key removes the marked analog 

channels and the insert key restores the channels.
 
Activation: Direct: Insert or the ViewAll menu button 

Menu: Alt-C, R 
 
See Also: View Mark(s) 

Hide Mark(s) 
Show All Hidden 

RESTORE ORIGINAL  
Location: Analysis 
 
Description: Restore the displayed file to the original samples stored in the file.  This feature will undo all 

changes made using the change frequency, duplicate cycles and truncate cycles features.
 

Activation: Direct: Restore Original menu button 
Menu: Alt-D, R 

To resize the table columns, place the mouse over the column separator and drag to the 
right or the left.  The cursor changes to the vertical resize cursor when the mouse is 
positioned over the column separator.  Double click the mouse over the separators to make 
the column size the maximum area to display all the text in the column. 

Resize the RMS sliding window. 

Resize Sliding Window menu button  

To automatically resize the RMS sliding window click on the Resize Sliding Window

or open the “Resize Sliding Window” menu option under the “View” menu.
manually resize the RMS sliding window click the right mouse button to set the reference 
position and the left mouse button to set the ending data position then click the 

menu button.  The RMS bar is moved to the reference position.  The Delta time (Delta 
X) field displayed in the status bar at the bottom of the screen shows the time difference (in 
milliseconds or seconds) and the number of cycles between the reference and data bars. 
Use the left, right, ctrl+left, and ctrl+right keys or the horizontal scroll bar to move the sliding 

Setting the Cursor Bars in the Analysis Quick Start 

Restore all the hidden analog channels.  The delete key removes the marked analog 
channels and the insert key restores the channels. 

Insert or the ViewAll menu button  

estore the displayed file to the original samples stored in the file.  This feature will undo all 
changes made using the change frequency, duplicate cycles and truncate cycles features.

Restore Original menu button  

To resize the table columns, place the mouse over the column separator and drag to the 
cal resize cursor when the mouse is 

positioned over the column separator.  Double click the mouse over the separators to make 

Sliding Window menu 

or open the “Resize Sliding Window” menu option under the “View” menu. To 
manually resize the RMS sliding window click the right mouse button to set the reference 

on then click the SetRMS 
menu button.  The RMS bar is moved to the reference position.  The Delta time (Delta 

X) field displayed in the status bar at the bottom of the screen shows the time difference (in 
between the reference and data bars. 

Use the left, right, ctrl+left, and ctrl+right keys or the horizontal scroll bar to move the sliding 

Restore all the hidden analog channels.  The delete key removes the marked analog 

estore the displayed file to the original samples stored in the file.  This feature will undo all 
changes made using the change frequency, duplicate cycles and truncate cycles features. 
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See Also: Duplicate Cycles 

Truncate Cycles 
Change Frequency 

RFL 9300 DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the RFL 9300 driver and plot the input channels. 
 
Activation: Menu: Alt-D, F 
 
Comments: If the selected file is not a valid RFL 9300 file an error message is generated. 

RMS COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the RMS value for all samples positioned between the RMS bar (black dotted line) 

and the data bar (black solid line).  If the data is RMS calibrated, each sample value is 
multiplied by the square root of 2 before it is squared. 

  
See Also: Viewing Analog Data in the Analysis Quick Start 

RMS Bar 
Data Bar 

RMS BAR 
Location: Analysis 
 
Description: The RMS bar is the black dotted line that runs vertically across the analog and digital 

channels.  The RMS bar and data bar define the RMS sliding window.   
 
Comments: When the analysis window is initially opened the sliding window is defaulted to one cycle.  

The sliding window is used to calculate the RMS value for all samples positioned between 
the data bar and the RMS bar.  This value is displayed in the Analog View.   

 
To resize the sliding window, click the right mouse button to set the reference bar position 
and the left mouse button to set the data bar position then select the Set RMS Bar menu 
button.  This button will move the RMS bar to the reference bar. 
 

See Also:  Data bar 
RMSVal Column 
TrueRMS Column 
Fault Bar 

RUN 
Location: File Manager 
 
Description: Execute the specified command. 
 
Activation: Direct: F5 
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Menu: Alt-F, R 
 
Fields: Open:  The path and filename of the application to run. 
 
Options: Enter/Ok: Run the specified application. 

Esc/Cancel: Exit the dialog without executing the command. 
Browse: Display the Windows open dialog to browse for a file.  

SAMPLE BASED DISPLAY  
Location: Analysis 
 
Description: The sample base display plots the channel data with 1 pixel distance between each 

displayed sample.  Sample based displays are useful for showing changes in sampling 
frequency. 

 
Comments: To change the trace display settings open the “Window Properties” dialog under the “File” 

menu.  Click the “Display Settings” tab and change the “Trace Display Type” field to time 
based or sample based. 

 
See Also: Time & Sample Based Displays in the Analysis Quick Start 

SAVE & ARCHIVE DIALOG 
Location: Device Manager 
 
Description: Display the “Save & Archive” dialog to define the system and file settings. 
 
Activation: Menu: Alt-O, S 
 
Fields: System Settings:  

Station ID: Set the Station number where the system is running. 
Station Name: Set the Station name where the system is running 
Company Name: Set the company name. 
Password: Set the password to gain access to this platform from another 

station.  Refer to Interrogating a Remote Device for more 
information on using the password to gain access to the Wavewin 
platform via a remote computer. 

File Settings:  
Save Rx Data: Save all received data from the devices in a device DTB file. 
Save Path: Set the path where the device DTB files are to be saved.  Maximum 

80 characters. 
Duration (min): Set the duration of the DTB files saved. 
End With: Action to take when the duration field has been exceeded. Archive 

will rename the DTB files using the IEEE long file naming format 
and delete will delete the DTB files from disk. 

 
Options: Save/Enter: Exit and save the dialog fields. 

Esc/Cancel: Exit the dialog without saving the dialog fields. 
 
Comments: Use the tab key to navigate between fields. 

 
See Also: Change DXF Files in Chapter 1 

IEEE Long File Naming Format in Chapter 1 
Interrogating A Remote Device in Chapter 1 
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SAVE AS 
Location: ASCII/Binary Editor 
 
Description: Save the active event file to a new name. 
 
Activation: Menu: Alt-F, A 
 
See Also: Save As Text 

SAVE AS COMTRADE (ASCII/BINARY)  
Location: File Manager and Analysis 
 
Description: Save the waveform file at the cursor position or the displayed analog/digital channels to 

COMTRADE ASCII or Binary format. 
 
Activation: Menu: Alt-O, V, A – Save in COMTRADE ASCII format 

Menu: Alt-O, V, B – Save in COMTRADE Binary format 
 
Fields: Path:  The destination path. 

Filename: The filename with no extension. 
 
Options: Enter/Ok: Read the file contents and save it in COMTRADE format. 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: Do not enter a filename extension.  The COMTRADE configuration (.CFG) and data (.DAT) 

files are automatically created.  If a path is not defined, the files are saved in the active 
directory.   
 
Currently there are two Comtrade versions supported: the older 1991 format and the newer 
1999 format.  The Comtrade format can be selected from the “Window Properties” dialog in 
the analysis window.  The default format is the newer 1999 format.   
 
If the sample values in the selected file are RMS calibrated and the outcome Comtrade file 
must have instantaneous values then set the “Comtrade Settings” fields to automatically 
convert the RMS data to instantaneous values.  To set the “Comtrade Settings” fields open 
the “Window Properties” dialog in the analysis window.  Select the “Comtrade” tab then 
select “Yes” for the “Convert RMS Calibrated Data to Peak Data” field. 
 
To automatically convert the selected channels to Comtrade using the IEEE long file naming 
convention check the “Use the ComNames Naming Convention to Name the Comtrade 
File(s)” field in the “Save As Comtrade” Dialog and leave the File Name field empty.  The 
selected channels are converted to the selected Comtrade format and are named using the 
IEEE long file naming convention. 

 
Restrictions: The selected file must be a supported oscillography file. 
 
See Also: Save As Comtrade in the File Manager & Analysis Quick Start 

SAVE AS TEXT 
Location: Binary Editor 
 
Description: Save the binary values in the hex editor file to an ASCII text file. 
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Activation: Menu: Alt-F, T 
 
See Also: Save As 

SAVE DATE COLUMN 
Location: File Manager 
 
Description: Displays the date the file was last saved on disk. 
 
Comments: Click the table’s Save Date header to sort the files in ascending or descending order with 

respect to the Save Date. 
 
See Also: Fault Date/Time Column 

Save Time 

SAVE DISPLAYED VALUES (DEFAULT FORMAT) 
Location: Analysis 
 
Description: Save the displayed values in the analog table to a file or to the Windows clipboard. 
 
Activation: Menu: Alt-F, T “Values File” Tab 
 
Fields: Save To:  Where to save the values: file, clipboard or both 

Select Values File: Select the file for the displayed values. 
Save Type:  How to maintain the file: append or rewrite 
Save Format:  How to save the data: fixed ASCII or comma delimited 
Add Titles:  Add the titles to the file or no titles. 

 
Options: Enter/Ok: Set the format. 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: To save the samples values to a file select the “Mark & Save” menu option under the 

“Values” menu.  Select the format for the selected sample.  To view the values file, select 
the “Values File/Open” menu option under the “Values” menu. 

 
See Also: Save Displayed Values in the Analysis Quick Start 

SAVE TIME COLUMN  
Location: File Manager 
 
Description: Displays the time the file was last saved on disk. 
 
Comments: Click the table’s Save Time header to sort the files in ascending or descending order with 

respect to the Save Time. 
 
See Also: Fault Date/Time Column 

SAVE USER VIEWS 
Location: Analysis 
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Description: Save the displayed view information in an ASCII text file. 
 
Activation: Menu: Alt-V, S 
 
Fields: View File Path: Destination path for the file. 

View Name: The name of the view. A file extension is not needed. The “.VIW” extension 
is automatically assigned. 

 
Options: Enter/Ok: Save the view. 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: The following information is saved: 

• Displayed analog channels, 
• Analog channel order, 
• Superimposed channels, 
• Analog channel colors, 
• Digital channels displayed, 
• Sampling frequency, 
• Time scale, 
• Sliding window size (RMS bar to Data bar), 
• Phasor window size, 
• Table window size, 
• Red fault bar, 
• Auto scale and 
• Phasor or circular chart displayed 

 
See Also: Select User Views 

User Views in the Analysis Quick Start 

SECONDARY VALUES 
Location: Analysis (Analog Table)  
 
Description: The values displayed in the analog table are either in primary or secondary quantities. If the 

file defines the type of values saved then the type is displayed in the window header. Also, if 
the CT and PT ratios are defined in the configuration file then the values can be changed 
from primary to secondary and vice versa. To change the values open the properties dialog 
and click on the “Driver Data Type” tab, select the Primary or Secondary radio button to 
switch between values. 

  
See Also: Changing Analog Values in the Analysis Quick Start 

Primary Values 

SEL LOAD PROFILE DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the SEL load profile driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
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Comments: If the selected file is not a valid SEL load profile file an error message is generated.  All files 
that have the “.BSV” extension are tagged as SEL load profile files.  

SEL RELAY DRIVER 
Location: File Manager 
 
Description: Change the driver at the cursor position to
 
Activation: Menu: Alt-D, A 
 
Comments: If the selected file is not a valid SEL file an error message is generated.  All files that have 

the “.SEL”, “CEV” and “.EVE” extensions are tagged as SEL files.  Use
change the file’s SEL driver type.  All SEL relay display formats are supported.

SELECT LINES/VIEWS 
Location: Analysis 
 
Description: Select a specific line or view for 
 

Activation: Direct: Line/View drop down menu button 
Menu: Alt-C, L 

 
Comments: The DFR Transcan and Faxtrax records have predefined views

To select the predefined views click on the “Show All/ Select View” drop down menu button 
or select the “Select Views” menu option under the “Channels” menu option.  A list of the 
available lines/graphs will be displayed.  To view all the analog channels in the file press
<esc> key, the <backspace>, or click the “Show All” menu button or click the 
menu button.  

 
See Also: Selecting Predefined Views in the Analysis Quick Start

SELECT USER VIEWS 
Location: Analysis 
 
Description: Select a view file from the list of files located in the displayed view path.
 
Activation: Menu: Alt-V, V 
 
Fields: View Files:  

Analog Channels: 
Digital Channels: 

 
Options: Enter/Ok:  

Esc/Cancel:  
 
Comments: The following information is read from the selected view file and applied to the displayed file:

• Displayed analog channels,
• Analog channel order,
• Superimposed channels,
• Analog channel colors,

If the selected file is not a valid SEL load profile file an error message is generated.  All files 
hat have the “.BSV” extension are tagged as SEL load profile files.   

Change the driver at the cursor position to the SEL event driver and plot the input channels.

If the selected file is not a valid SEL file an error message is generated.  All files that have 
the “.SEL”, “CEV” and “.EVE” extensions are tagged as SEL files.  Use the Drivers menu to 
change the file’s SEL driver type.  All SEL relay display formats are supported.

Select a specific line or view for display. 

Line/View drop down menu button  

The DFR Transcan and Faxtrax records have predefined views encoded into their format.  
edefined views click on the “Show All/ Select View” drop down menu button 

or select the “Select Views” menu option under the “Channels” menu option.  A list of the 
available lines/graphs will be displayed.  To view all the analog channels in the file press
<esc> key, the <backspace>, or click the “Show All” menu button or click the 

Selecting Predefined Views in the Analysis Quick Start 

Select a view file from the list of files located in the displayed view path. 

A list of all the view files in the displayed view path.
All analog channel information defined in the view file.
All digital channel information defined in the view file.

Select the highlighted view. 
Exit the dialog without executing the command. 

information is read from the selected view file and applied to the displayed file:
Displayed analog channels, 
Analog channel order, 
Superimposed channels, 
Analog channel colors, 

If the selected file is not a valid SEL load profile file an error message is generated.  All files 

the SEL event driver and plot the input channels. 

If the selected file is not a valid SEL file an error message is generated.  All files that have 
the Drivers menu to 

change the file’s SEL driver type.  All SEL relay display formats are supported. 

encoded into their format.  
edefined views click on the “Show All/ Select View” drop down menu button 

or select the “Select Views” menu option under the “Channels” menu option.  A list of the 
available lines/graphs will be displayed.  To view all the analog channels in the file press the 
<esc> key, the <backspace>, or click the “Show All” menu button or click the ViewAll  

 

A list of all the view files in the displayed view path. 
information defined in the view file. 

All digital channel information defined in the view file. 

 

information is read from the selected view file and applied to the displayed file: 
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• Digital channels displayed, 
• Sampling frequency, 
• Time scale, 
• Sliding window size (RMS bar to Data bar), 
• Phasor window size, 
• Table window size, 
• Red fault bar, 
• Auto scale and 
• Phasor or circular chart displayed 

 
If the analog channel and digital channel names defined in the view file are not in the 
displayed file than an error message is displayed. 

 
See Also: Save User Views 

User Views in the Analysis Quick Start 

SEQUENCE OF EVENTS LIST 
Location: File Manager 
 
Description: View a table of sequence of events for a number of waveform files.  Mark all the desired 

files then press F11 or select the "SOE List" menu option from the "Reports" submenu 
under the "Options" menu.  A table will be displayed listing all the events triggered in the 
selected files. 

 
Activation: Direct: F11 

Menu: Alt-O, R, S 
 
Fields: Substation:  The substation where the device is installed. 

Device:   The device the channel came from. 
State:   The state of the channel at that time (A=Abnormal, N=Normal). 
Trigger Date:  The trigger date. 
Trigger Time:  The trigger time. 
Channel:  The channel number of the event in the file. 
Channel Title:  The title of the channel. 
File:   The file containing the event/sensor channel. 

 
Comments: The table is sorted according to the date and time.  The Query section at the bottom of the 

table allows for searching events from specific substations, devices, channels and more...  
To view the file containing the specific events press enter or double click on the event. 

SEQUENCE OF EVENTS SUMMARY 
Location: File Manager 
 
Description: View a table of summarizing the sequence of events for a number of waveform files.  Mark 

all the desired files then select the "SOE Summary" menu option from the "Reports" 
submenu under the "Options" menu.  A table will be displayed listing a summary of the 
events triggered in the selected files. 

 
Activation: Menu: Alt-O, R, O 
 
Fields: Substation:  The substation that triggered the event/sensor 

Device:   The device the channel originated from. 
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Fst-State:  The state the channel started at, A=alarm and N=normal. 
Lst-State:  The state the channel ended at, A=alarm and N=normal. 
First Change Date  The date the channel first changed state. 
First Change Time: The time the channel first changed state. 
Last Change Date  The date the channel last changed state. 
Last Change Time: The time the channel last changed state. 
Changes:  The number of times the channel changed state. 
Chan#:   The channel number in the file. 
Channel Title:  The title of the channel. 
File:   The file containing the event/sensor channel. 

 
Comments: The table is sorted according to the first change date and time.  The Query section at the 

bottom of the table allows for searching events from specific substations, devices, channels 
and more...  To view the file containing the specific events press enter or double click on the 
event. 

SET DRAWING PROPERTIES 
Location: DXF Animated CAD 
 
Description: Set the DXF drawing properties. 
 

Activation: Direct: F2 - Properties menu button  
Menu: Alt-T, D 

 
Fields: File Name:  Displays the file name for the currently select tab. 

Background Color: Set the background color for the currently select tab. 
Max X Pixel:  Set the maximum X resolution value. 
Max Y Pixel:  Set the maximum Y resolution value. 

 
Options: Enter/Ok: Exit the dialog, then save and execute the entered information. 

Esc/Cancel: Exit the dialog without saving the information. 
Apply : Apply and save the entered parameters without closing the dialog. 

 
Comments: The Max X Pixel and Max Y Pixel values cannot exceed 32000. 

SET OPENING FREQUENCY  
Location: Analysis 
 
Description: Set a driver’s open frequency.  This feature is available in the “Change Frequency” dialog. 
 

Activation: Direct: Change Frequency menu button  
Menu: Alt-D, F 

 
Fields: Open Frequency: Specify to always open the files associated with the active driver 

using the entered frequency. 
 
Options: Enter/Ok: Exit the dialog, then save and execute the entered information. 

Esc/Cancel: Exit the dialog without saving the information. 
 
Comments: Setting the Always Open field will open all files associated with the active driver using the 

entered frequency.  This feature is useful for files with low sampling frequency. 
 



Chapter 1 – Fields & Features 
 

65 
 

See Also: Change Frequency 

SET SORT FIELD 
Location: All Tables 
 
Description: Set the active sort field to the column at the cursor position. 
 
Activation: Direct: Left Mouse Click on the Column’s header 

Menu: Alt-S, S  
 
Comments: The “Ascending” and “Descending” options in the “Sort” menu sorts the table data with 

respect to the select sort field.  To sort the columns directly, click the column header button 
to toggle between ascending and descending. 

 
See Also: Sort All Rows 

SHIFT MARKS DOWN 
Location: Analysis 
 
Description: Shift all the marked analog channels down one position. 
 
Activation: Direct: "-" key 

Menu: Alt-C, D 
 
Comments: Individual channels can be marked or unmarked by clicking on the channels corresponding 

display ID or channel information or by pressing the spacebar.  Marked analog channels are 
displayed in red. 

 
See Also: Shift Marks Up 

SHIFT MARKS UP 
Location: Analysis 
 
Description: Shift all the marked analog channels up one position. 
 
Activation: Direct: "+" key 

Menu: Alt-C, U 
 
Comments: Individual channels can be marked or unmarked by clicking the channels corresponding 

display ID or channel data, or by pressing the spacebar.  Marked analog channels are 
displayed in red. 

 
See Also: Shift Marks Down 

SHOW/HIDE CHANNEL TITLES 
Location: File Manager 
 
Description: The Show/Hide Channel Titles allows for showing invalid channel titles, remove titles from 

the invalid title list and adding new titles to the invalid channel title list. 
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Activation: Menu: Alt-O, T 
 
Fields: Title List Box:  

Add Title:  
Remove Title:  

 
Options: Enter/Ok:  

Esc/Cancel:  
 
Comments: To show a title, uncheck the checkbox next to the title. All new titles are added to the end of 

the list with the checkbox automatically checked.
 
See Also: Show/Hide Channel Titles in the File Manager Quick Start

SHOW ALL DIGITAL CHANNELS 
Location: Analysis 
 
Description: Show all digital channels or just the triggered digital channels.  This menu o

between the two views.
 
Activation: Direct: F9 

Menu: Alt-V, D 
 
Comments:   Placing the mouse on the horizontal separator bar and dragging it up or down can resize the 

digital channel display area.
mouse is positioned over the bar.

SHOW ALL HIDDEN 
Location: Analysis 
 
Description: Show all hidden analog and digital chan
 
Activation: Direct: ViewAll menu button 

Menu: Alt-C, S 
 
See Also: View Mark(s) 

Hide Mark(s) 
Restore Mark(s) 

SHOW CHANNEL INFORMATION 
Location: Analysis 
 
Description: Show or hide the channel information window.  This menu option toggles between the two 

views. 
 
Activation: Menu: Alt-V, C 
 
Comments: The channel information window can be resized by placing the mouse on the vertical 

separator bar and dragging it to the right or the left.  The cursor changes to the vertical 
resize cursor when the mouse is positioned over the bar.

Lists all invalid channel titles. 
Add a new title to the list. 

 Remove a title from the list. 

Execute changes. 
Exit the dialog without executing the command. 

To show a title, uncheck the checkbox next to the title. All new titles are added to the end of 
the list with the checkbox automatically checked. 

Channel Titles in the File Manager Quick Start 

Show all digital channels or just the triggered digital channels.  This menu o
between the two views. 

Placing the mouse on the horizontal separator bar and dragging it up or down can resize the 
digital channel display area.  The cursor changes to the horizontal resize cursor when the 
mouse is positioned over the bar. 

Show all hidden analog and digital channels. 

ViewAll menu button  , the <esc> key or the <backspace> key

Show or hide the channel information window.  This menu option toggles between the two 

The channel information window can be resized by placing the mouse on the vertical 
and dragging it to the right or the left.  The cursor changes to the vertical 

resize cursor when the mouse is positioned over the bar. 

 

To show a title, uncheck the checkbox next to the title. All new titles are added to the end of 

Show all digital channels or just the triggered digital channels.  This menu option toggles 

Placing the mouse on the horizontal separator bar and dragging it up or down can resize the 
The cursor changes to the horizontal resize cursor when the 

, the <esc> key or the <backspace> key 

Show or hide the channel information window.  This menu option toggles between the two 

The channel information window can be resized by placing the mouse on the vertical 
and dragging it to the right or the left.  The cursor changes to the vertical 
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SINGLE ENDED FAULT LOCATION  
Location: Analysis 
 
Description: Display the single ended fault location dialog. The Single Ended Fault Location Dialog is 

used to interface to the SingleEndFaultLocation.dll. The SingleEndFaultLocation.dll will 
calculate the fault location, fault type and fault time. 

 
Activation: Menu: Alt-D, O 
 
Fields: ZLine:  Positive sequence impedance. 

ZLine Angle: Positive sequence angle. 
kZN:  Compensated zero sequence impedance (Z0-Z1)/(3*Z1). 
kZN Angle: Compensated zero sequence factor angle (Z0-Z1)/(3*Z1). 
kZM:  Mutual compensation factor (Z0m)/(3*Z1). 
Line Length: Line Length. 
Vnom:  Nominal phase to phase voltage. 
Inom:  Nominal current. 
Analog Chans: Select the analog channels from the drop down lists. 
Pre Cycles: Number of cycles to send before the reference bar. 
Post Cycles: Number of cycles to send after the reference bar. 
 
Advanced Dialog Fields: 
Z1 (% of Line): Zone 1 forward impedance. 
Z2 (% of Line): Zone 2 reverse impedance. 
R0:  Phase loop resistance reach. 
Rg:  Ground loop resistance reach. 
IO Threshold: Zero sequence current threshold for VTS. 
I2 Threshold: Neg. sequence current threshold for VTS. 
Ph Select Ind: Index of the sample corresponding to the fault inception. 
Average Count: Total post fault samples for averaging fault distance. 
Ph Select Mode: Phase selection mode (Internal, AG, BG, CG, AB, BC, CA). 

 
Options: Advanced: Display the Advanced dialog for fine turning the algorithms. 

Start:  Start the fault location algorithms. 
Print:  Send a screen dump of the outputs to the system's default printer. 
Show Help: Show/Hide the fault location drop down help window. 
Open:  Open a fault location (*.flt) file. 
New:  Create a new fault location file. 
Save:  Save the active fault location file. 
Save As: Save the active fault location file under a new name. 

 
Comments: The sampling frequency must be set to ensure 24 samples per cycle. The sampling 

frequency must be set prior to opening the fault location dialog. If the sampling frequency is 
not set to 1440 Hz for 60 Hz or 1200 Hz for 50 Hz then the change sampling frequency 
dialog will automatically be displayed. Click OK or press enter to change the sampling 
frequency then reopen the Fault Location dialog.  

 
All sample values sent to the DLL must be in secondary quantities. If the sample values are 
in primary values then the CT and PT ratio values must be available in the data 
configuration file. If the CT and PT ratio values are not available a message will be 
displayed asking to ignore the request or abort displaying the fault location dialog. 

 
See Also: Single Ended Fault Location in the Analysis Quick Start 
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SIZE 
Location: File Manager (Status Field)
 
Description: Displays the total size (in Kbytes) of all files in the active directory.  
 
See Also: Free 

MrkSize 

SIZE COLUMN 
Location: File Manager 
 
Description: Displays the size (in bytes) of the file.  

SIZE TO ORIGINAL COORDINATES

Location: DXF Animated CAD 
 
Description: Size the DXF drawing to the original display coordinates (coordinates of the drawing when it 

was first opened).   
 
Activation: Direct: Original Display menu button 

Menu: Alt-V, Z 
 
Comments: The Max X and Max Y Pixel values in the 

coordinates. 

SIZE TO WINDOW 
Location: DXF Animated CAD 

 
Description: Size the DXF drawing to fit in the window.
 
Activation: Direct: Fit in Window menu button 

Menu: Alt-V, W 
 

Comments: The Max X and Max Y Pixel values in the 
coordinates. 

SOFTWARE ANALOG CHANNELS 
Location: Analysis 
 
Description: Display the software analog channel dialog.
 
Activation: Direct: F5 

Menu: Alt-C, A 
 
Fields: Titles:  The titles for the

Operators: Each analog operation followed by an operator terminator “/”.
 
Options: Enter/Ok: Exit the dialog then save and execute the operators.

Esc/Cancel: Exit the dialog without saving or executing the operators.

File Manager (Status Field) 

Displays the total size (in Kbytes) of all files in the active directory.   

Displays the size (in bytes) of the file.   

OORDINATES 
DXF Animated CAD  

Size the DXF drawing to the original display coordinates (coordinates of the drawing when it 

Original Display menu button  

The Max X and Max Y Pixel values in the status bar are updated according to the new 

DXF Animated CAD  

Size the DXF drawing to fit in the window. 

Fit in Window menu button  

The Max X and Max Y Pixel values in the status bar are updated according to the new 

 

Display the software analog channel dialog. 

The titles for the software analog channels. 
Each analog operation followed by an operator terminator “/”.

Exit the dialog then save and execute the operators. 
Exit the dialog without saving or executing the operators.

Size the DXF drawing to the original display coordinates (coordinates of the drawing when it 

are updated according to the new 

are updated according to the new 

Each analog operation followed by an operator terminator “/”. 

Exit the dialog without saving or executing the operators. 
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F1/Help: Display the help window. 
Open:  Open a *.SAC file. 
New:  Create a new *.SAC file. 
Save:  Save the active SAC file. 
Save As: Save the active SAC file under a new name. 

 
Comments: Software analog channels (SAC's) are extra channels provided by the system.  These 

channels can be used to calculate a missing phase, create +, - and 0 sequence channels, 
create an envelope of a selected trace, or define an under/over-trigger values to monitor a 
given channel.  The SAC window is split into two sections: the titles and the operators.  To 
navigate between fields use the tab, up arrow and down arrow keys. 

 
See Also: Creating Virtual Channels in the Analysis Quick Start 

SOFTWARE DIGITAL CHANNELS  
Location: Analysis 
 
Description: Display the software digital channel dialog. 
 
Activation: Menu: Alt-C, D 
 
Fields: Titles:  The titles for the software digital channels. 

Operators:  Each digital operation followed by an operator terminator “/”. 
 
Options: Enter/Ok: Exit the dialog then save and execute the operators. 

Esc/Cancel: Exit the dialog without saving or executing the operators. 
F1/Help: Display the help window. 

 
Comments: Software digital channels (SDC's) are extra channels provided by the system.  The SDC 

window is split into two sections: the SDC titles, and the SDC operators.  To navigate 
between fields use the tab, up arrow and down arrow keys. 

 
See Also: Creating Virtual Channels in the Analysis Quick Start. 

SORT ALL ROWS 
Location: All Tables 
 
Description: Sort all the rows in the table in ascending or descending order. 
 
Activation: Menu:  Alt-S, A – Ascending 

Menu:  Alt-S, D – Descending 
Shortcut: Column headers 

 
Comments: All the rows in the active table are sorted with respect to the sort field displayed in the 

table’s status field. 
 
See Also: Set Sort Field 

SORT FIELD 
Location: All Tables (Status Field) 
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Description: Displays the active sort field. 
 
Activation: Direct: Mouse Click on the Column’s header 

Menu: Alt-S, S  
 
Comments: The “Ascending” and “Descending” options in the “Sort” menu sorts the table data with 

respect to the select sort field.  To sort the columns directly and to set the sort field, click the 
column header button. 

 
See Also: Sort All Rows 

SORT MARKED ROWS 
Location: All Tables 
 
Description: Sort the marked rows according to the previously selected sort order. 
 
Comments: All marked records are sorted and grouped at the top of the table. 

SR745/489 DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the GE SR745/489 driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, K 
 
Comments: If the selected file is not a valid SR745/489 file an error message is generated.  All files that 

have the “.CSV” extension, and have “CSV format” in the first line of the file are tagged as 
GE SR745/489 files. 

 
See Also: Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

START DATE FIELD 
Location: IEEE Long File Name 
 
Description: The first field in the IEEE long file naming format.  The start date is extracted from the event 

files downloaded and stored in the following format: Year (2 digits) Month Day: 040909. 
Example File Name: 
040909,113109123,+3S,Barton Substation#12,SEL421-432#34,ArkElectric,,,.DAT 

 
See Also: Start Time Field 

START TIME FIELD 
Location: IEEE Long File Name  
 
Description: The second field in the IEEE long file naming format.  The start time is extracted from the 

event files downloaded and stored in the following format: Hour Minute Second Millisecond: 
113109234. 
Example File Name: 
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040909,113109123,+3S,Barton Substation#12,SEL421-432#34,ArkElectric,,,,.DAT 
 
See Also: Start Date Field 

SUBSTATION FIELD 
Location: IEEE Long File Name  
 
Description: The fourth field in the IEEE long file naming format.  The substation name is extracted from 

the device record. 
Example File Name: 
040909,113109123,+3S,Barton Substation#12,SEL421-432#34,ArkElectric,,,,.DAT  

 
See Also: Long File Naming Format in the File & Device Managers Quick Starts 

SUPER IMPOSE 
Location: Analysis 
 
Description: Superimpose all or marked analog channels. 
 
Activation: Direct: F7 

Menu: Alt-D, S 
 
Comments: Marked channels are superimposed and grouped at the top of the display window.  The 

superimpose menu option and the F7 function key toggles superimposing on and off. 

SYNC DATA CURSORS  
Location: Analysis 
 
Description: Synchronize the data cursors for two or more open display windows by time or manually.     
 
Activation: Menu: Alt-D, Y, T – “By Time” 

Menu: Alt-D, Y, M – “Manually” 
 
Options: By Time: When the "By Time" sync cursor feature is turned ON the data cursors in the 

non-active windows are moved to the sample value time in the active window.  
For example if the active data cursor is positioned on sample time 
01:12:34.560, all non active data cursors are moved to the sample value at that 
time.  If the time is not found in the non-active window, the cursor position is 
unchanged.  The active window defines the master data cursor and all other 
cursors follow this position.   

Manually: This feature allows for selection of different cursor positions in the open data 
windows before synchronization is turned ON.  For example, open two data 
windows and tile horizontally, move the data cursors to the beginning of the 
fault cycles, and select the sync manual cursor option.  When the left, right, ctrl-
left, ctrl-right, page up, page down, ctrl-page up, ctrl-page down, home and end 
keys are pressed the data cursors move simultaneously. 

   
Comments: A check mark indicates that the sync feature is ON.  To turn synchronizing OFF click on the 

active sync menu option to remove the check mark.  When synchronizing is ON the channel 
information displayed to the right of the traces is updated for all open data windows. 

 
See Also: Synchronizing Data Cursors in the Analysis Quick Start 
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SYSTEM FILES  
Location: Device Manager 
 
Description: There are 3 system files needed for the proper operation of the system.  The 

CFG_DEV.DTB file stores the device records stored in the device table.  The 
CFG_SHOT.DTB file stores the device’s function keys and the EscSeq field in the device 
records.  The DRIVERS.INI file has all the script code for polling the connected devices and 
transferring files to a remote computer. 

TAB DELIMITED TABLE DRIVER  
Location: File Manager 
 
Description: Display the tab delimited file at the cursor position in a table format.  Tab delimited files 

have textual fields separated by blank spaces, such as: CHANNEL DATE TIME. 
 
Activation: Menu: Alt-D, 3, T 
 
Comments: The data in the file is presented in tabular form.  An unlimited number of rows and columns 

can be displayed. 
 
See Also: Viewing ASCII Files in Database Format in the File Manager Quick Start 

Double Quotes/Comma Delimited Table Driver 
Comma Delimited Table Driver 

TCODE FIELD 
Location: IEEE Long File Name 
 
Description: The third field in the IEEE long file naming format.  The TCode is extracted from the device 

record. 
Example File Name: 
040909,113109123,+3S,Barton Substation#12,SEL421-432#34,ArkElectric,,,,.DAT 

 
See Also: Long File Naming Format in the File & Device Managers Quick Starts 

TESLA DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Tesla driver and plot the input channels. 
 
Activation: Menu: Alt-D, N 
 
Comments: Tesla Files are displayed in the IEEE Comtrade Binary format. NxtPhase has developed an 

automatic conversion application called "AutoComtrade.exe". Wavewin calls 
"AutoComtrade.exe" to convert Tesla files to the Comtrade binary format for display. To 
view Tesla Files double click or press enter on the original Tesla files. To obtain a copy of 
the “AutoComtrade.exe” file please contact Tesla. 

 
Files that have a .TLR extension are automatically tagged as NxtPhase Tesla files. 

 
See Also: Tesla Files in the File Manager Quick Start. 



 

TCP/IP CLIENT 
Location: Device Manager 
 
Description: Define the selected device to communicate using the TCP/IP protocol.
 

Activation: Direct: Ethernet configuration button 
 

Fields: Ethernet Connections:

Connection Properties
Port Number: 
IP Address: 

 
Options: OK/Enter:  

Cancel/Esc:  
 
Comments: If the Local Path does not exist then the directory will be created.
 
See Also: New Device Record 

Duplicate Device Record
Edit Device Record 

TEST PORTS 
Location: Device Manager 
 
Description: Test the connected port using the loop back te
 
Activation: Direct: F3 

Menu: Alt-O, L 
 
Comments: Use the loop back plug detection test to check the port connection.  Place the loop back 

plug in the desired port, select the corresponding port, and press F3
Test” from the Options menu.  A message appears displaying the status of the port: 
back plug detected or not detected

TIME BASED DISPLAY  
Location: Analysis 
 
Description: The time base display plots the channel data in time.  Time base displays are useful for 

showing changes in line frequency.
 
Comments: To change the trace display properties open the “Window Properties” dialog under the “File” 

menu.  Click the “Display S
based or sample based.

 
See Also: Time & Sample Based Displays in the Analysis Quick Start

TIS DRIVER 
Location: File Manager 

Chapter 1

Define the selected device to communicate using the TCP/IP protocol. 

Ethernet configuration button  in the Device Configuration dialog.

Ethernet Connections: Select the TCP/IP client option from the list box.  The fields in the 
connection properties section changes according to the selection in 
the connections list box. 

Connection Properties:  
Set the TCP/IP port number. 
Set the device’s IP address. 

Exit and update the Device’s EscSeq field. 
Exit the dialog without saving the changes made.

Local Path does not exist then the directory will be created. 

 
Duplicate Device Record 

 

connected port using the loop back test option. 

Use the loop back plug detection test to check the port connection.  Place the loop back 
plug in the desired port, select the corresponding port, and press F3 or select “Loop Back 
Test” from the Options menu.  A message appears displaying the status of the port: 
back plug detected or not detected. 

The time base display plots the channel data in time.  Time base displays are useful for 
showing changes in line frequency. 

To change the trace display properties open the “Window Properties” dialog under the “File” 
menu.  Click the “Display Settings” tab and change the “Trace Display Type” field to time 
based or sample based. 

Time & Sample Based Displays in the Analysis Quick Start 
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in the Device Configuration dialog. 

Select the TCP/IP client option from the list box.  The fields in the 
connection properties section changes according to the selection in 

Exit the dialog without saving the changes made. 

Use the loop back plug detection test to check the port connection.  Place the loop back 
or select “Loop Back 

Test” from the Options menu.  A message appears displaying the status of the port: Loop 

The time base display plots the channel data in time.  Time base displays are useful for 

To change the trace display properties open the “Window Properties” dialog under the “File” 
ettings” tab and change the “Trace Display Type” field to time 
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Description: Change the driver at the cursor position to the TIS driver and plot the input channels. 
 
Activation: Menu: Alt-D, M 
 
Comments: The TIS file format is an ASCII comma delimited format with the channel information defined 

in the first line of the file. If the selected file is not an ASCII comma delimited file then an 
error message is generated.  All files that have a “.TIS” extension are tagged as TIS files. 

 
See Also: Associating File Types in the File Manager Quick Start 

TOTAL HARMONICS DISTORTION 
Location: Analysis (Harmonics Dialog)  
 
Description: The "Total Harmonic Distortion" field displays the square root of the summation of the 

squares of DFT Magnitudes for harmonics 2 to n divided by square root of 2 and that 
quantity divided by the DFT Magnitude of the Fundamental.  

 
See Also:  Harmonics 

Histogram 

TOTFILES 
Location: File Manager (Status Field)  
 
Description: Displays the total number of hidden and unhidden files/directories in the active directory.  

The ”.” and “..” navigation shortcuts are included in the unhidden total.  
 
See Also:  TotMarks 

TOTMARKS 
Location: All Tables (Status Field)  
 
Description: Displays the total number of marked rows in the active table.  Marked rows are displayed in 

light red.  

TOTRECS 
Location: Device Manager (Status Field)  
 
Description: Displays the total number of records in the active configuration. 
 
See Also:  AtRec 

TotMarks 

TOTTABS 
Location: Animated CAD-DXF(Status Field)  
 
Description: Displays the total number of tabs in the Animated CAD-DXF window. 
 



Chapter 1 – Fields & Features 
 

75 
 

See Also:  AtTab 

TPRO DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the NxtPhase TPRO driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
 
Comments: NxtPhase files are displayed in the IEEE Comtrade Binary format. NxtPhase has developed 

an automatic conversion application called "AutoComtrade.exe". Wavewin calls 
"AutoComtrade.exe" to convert NxtPhase files to the Comtrade binary format for display. To 
view NxtPhase relay files double click or press enter on the original TPRO files. To obtain a 
copy of the “AutoComtrade.exe” file please contact NxtPhase. 

 
Files that have a “.TPR” extension are automatically tagged as NxtPhase TPRO files. 

 
See Also: Tesla Files in the File Manager Quick Start 
  Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

TPU/DPU/GPU DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the ABB TPU/DPU/GPU driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, E 
 
Comments: If the selected file is not a valid TPU or DPU or GPU file an error message is generated.  All 

files that have the “.CAP” extension are tagged as TPU/DPU/GPU files.   

TRACE SCALE MULTIPLIER (ASM) 
Location: Analysis (Window Properties Dialog)  
 
Description: Used as a multiplier to increase/decrease the amplitude of the visible analog channels 
 
Activation: Menu: Alt-F, T 
 
Range: Greater Than 1.00 
 
Default: 2.00 
 
Comments: When a channel's amplitude is increased, the trace scale value is multiplied with the 

Pixsdisp value, and when the channel's amplitude is decreased the trace scale value is 
divided by the Pixsdisp value . 

TRANSCAN DRIVER 
Location: File Manager (Universal Viewer) 
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Description: Change the driver at the cursor position to the Mehta Transcan driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, 7 
 
Comments: If the selected file does not have a corresponding SCF file an error message is generated.  

All files that have an extension that starts with “.X”, and there is a corresponding “.SCF” file 
in the same directory, are tagged as Transcan files. 

 
See Also: Associating File Types in the File Manager Quick Start 

TRIGGER-TIME  
Location: Waveform Summary (Events/Sensors Activity Log)  
 
Description: Displays the time the digital channel changed state.  This value is displayed in the third 

column of the Events/Sensors Activity Log.   
 
Comments: The Events/Sensors Activity Log displays a time-sequenced list of all the events and 

sensors activity. 

TRUERMS 
Location: Harmonics Table (Analysis)  
 
Description: Displays the RMS value for all the samples between the RMS bar (black dotted line) and the 

data bar (black solid line). 
  
Comments: This value is taken directly from the RMS column inside the analog information table.  
 
See Also: Harmonics Table 

TRUNCATE CYCLES 
Location: Analysis 
 
Description: Remove beginning, middle or end cycles from the active analysis window. 
 
Activation: Menu: Alt-D, T, L: Left-Start to Data Bar 

Menu: Alt-D, T, R: Data Bar to End 
Menu: Alt-D, T, M: Data Bar to Reference Bar 

 
Comments: There are 3 options available under the Truncate Cycles menu option.  Left removes the 

cycles from the first sample to the data bar (solid black vertical line).  Right removes the 
cycles from the data bar to the last sample.  Middle removes the cycles from the data bar to 
the reference bar (dotted blue vertical line) 

 
See Also: Truncate Cycles in the Analysis Quick Start 

TYPE COLUMN  
Location: File Manager 
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Description: Displays the fault type associated with the long file name.  The eighth field in the file name 
defines the type field for the IEEE long file-naming format.  This field represents the fault 
type or contents type of the file. 

 
See Also: Long File Naming Format in the File Manager Quick Start 

UN/MARK ROWS 
Location: All Tables 
 
Description: Mark or unmark the row at the cursor position. 
 
Activation: Direct: Spacebar - Ctrl-Mouse Button 

Menu: Alt-M, M 
 
Comments: Marked rows are displayed in red.  The TotMarks field displayed in the status bar is updated 

accordingly. 
 
See Also: Unmarked Marks 

Group Marked Rows 

UNMARK MARKS 
Location: All Tables 
 
Description: Unmark all the marked rows in the table. 
 
Activation: Menu: Alt-M, U 
 
Comments: Marked rows are displayed in red.  The TotMarks field, displayed in the status bar, is 

updated accordingly. 
 
See Also: Mark/Unmark Rows 

Group Marked Rows 

VIEW MARK(S) 
Location: Analysis  
 
Description: Hide all the unmarked channels and resize the marked channels. 
 
Activation: Direct: Enter 

Menu: Alt-C, V 
 
Comments: Individual channels are marked and unmarked by clicking the left mouse button on the 

channel’s corresponding display ID or channel information or by pressing the spacebar.  
Marked channels are displayed in red. 

 
See Also: Hide Mark(s) 

Show All Hidden 
Restore Mark(s) 
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VIEW RAW DATA FILE 
Location: Analysis  
 
Description: View the contents of the active displayed file in an ASCII editor or a hexadecimal editor.
 

Activation: Direct: Menu button 
Menu: Alt-F, V 

 
Comments: The waveform file is displayed in an ASCII editor if the contents of the file are in text format 

and displayed in a hex editor if the file is in binary format.
 
See Also: Viewing/Modifying ASCII Files

Viewing/Modifying Binary Fil

WAVEFORM DATA 
Location: File Manager 
 
Description: Plot the contents of the event file at the cursor position if there are no marked waveform 

files else plot all the marked waveform files.
 
Activation: Direct: <enter>, Plot menu button 

Menu: Alt-O, W, O 
 
Comments: A maximum of 10 oscillography/log files can be opened simultaneously.

WAVEFORM SUMMARY 
Location: File Manager and Analysis
 
Description: Generates and displays analog and digital summaries for the active file in the file table or 

the analysis window.
 

Activation: Direct: Sum menu buttons 
Menu: Alt-O, S – File Table, Alt

 
Comments: The summary file displays the following information:
  

Waveform Information
Station: Name of the Station associated with the waveform.
Filename: The name of the waveform file.
File Size: The size of the file in kilobytes.
Prefault-Time: The date and time of the first prefault sample.
Fault-Time: The date and time of the first fault sample.
Save-Time: The date and time 
Process-Time: The date and time the file was processed into this summary.
Start Date & Time: Date and time of the first s
End Date & Time: Date and time of the last sample in the file.
File Duration: Duration of the file measured in days, hours, seconds, milliseconds and/or 

microseconds, depending on the type of file.
Sampling Frequency: Sampling frequency and the time between each sample.
Line Frequency: Line Frequency defined in the file.
 

View the contents of the active displayed file in an ASCII editor or a hexadecimal editor.

Menu button  

The waveform file is displayed in an ASCII editor if the contents of the file are in text format 
and displayed in a hex editor if the file is in binary format. 

Viewing/Modifying ASCII Files 
Viewing/Modifying Binary Files 

Plot the contents of the event file at the cursor position if there are no marked waveform 
files else plot all the marked waveform files. 

<enter>, Plot menu button  
 

A maximum of 10 oscillography/log files can be opened simultaneously. 

Analysis 

Generates and displays analog and digital summaries for the active file in the file table or 
. 

Sum menu buttons  - File Table,  - Analysis  
File Table, Alt-F, S – Analysis 

The summary file displays the following information: 

Waveform Information 
: Name of the Station associated with the waveform. 

: The name of the waveform file. 
: The size of the file in kilobytes. 

: The date and time of the first prefault sample. 
: The date and time of the first fault sample. 
: The date and time the file was saved to hard disk. 

: The date and time the file was processed into this summary.
Start Date & Time: Date and time of the first sample in the file. 
End Date & Time: Date and time of the last sample in the file. 
File Duration: Duration of the file measured in days, hours, seconds, milliseconds and/or 

microseconds, depending on the type of file. 
Sampling Frequency: Sampling frequency and the time between each sample.
Line Frequency: Line Frequency defined in the file. 

View the contents of the active displayed file in an ASCII editor or a hexadecimal editor. 

The waveform file is displayed in an ASCII editor if the contents of the file are in text format 

Plot the contents of the event file at the cursor position if there are no marked waveform 

 

Generates and displays analog and digital summaries for the active file in the file table or in 

: The date and time the file was processed into this summary. 

File Duration: Duration of the file measured in days, hours, seconds, milliseconds and/or 

Sampling Frequency: Sampling frequency and the time between each sample. 



 

Fault Information 
Fault Information is displayed for SEL, DLP and Transcan files.  The fault information 

includes: Fault Type, Fault Time, Location, Targets, Triggers, Frequency, Event and
Targets. 

 
Maximum/Minimum Analog Summary
Max-Inst: Instantaneous
Min-Inst: Instantaneous
Max-RMS: RMS maximum values.
Min-RMS: RMS minimum values.
OneBit: The channel's full
Inst-Diff: The difference between the Max
RMS-Diff: The difference
pU: The channel's prefix and units.
Description: The number and title of the channel.

 
Events/Sensors Activity Summary
Fst: The state the channel started at, A=alarm, N=normal.
Lst: The state the channel ended at, A=alarm, N=normal.
Fst-Change: The date and time the channel first changed state.
Lst-Change: The date and time the channel last
Changes: The number of times the channel changed state.
Description: The number and title of the channel.
 
Events/Sensors Activity Log
State: The state of the channel at the triggered time,
Trigger Time: The time the channel changed state.
Description: The number and title of the channel.

 
Note: An xx:xx:xx.xxx in the events/sensors activity summary indicates that the digital channel's 

state did not change from the initial state (Fst).

WINDOW PROPERTIES 
Location: Analysis 
 
Description: Reposition the columns in the analog table, change the fields displayed in the combination 

view, change the background colors and trace colors; change the driver’s data type, change 
the trace/phasor scale multipliers and more refer to the fields below.

 

Activation: Direct: Properties M
Menu: Alt-F, T 

 
Fields: Analog Table Tab: 

 Analog Combination Tab:

 Comtrade: 

 Colors: 
 Values File: 
 Display Settings: 

 Append/Merge: 

Chapter 1

is displayed for SEL, DLP and Transcan files.  The fault information 
includes: Fault Type, Fault Time, Location, Targets, Triggers, Frequency, Event and

Maximum/Minimum Analog Summary 
Instantaneous maximum values. 
Instantaneous minimum values. 

RMS maximum values. 
RMS minimum values. 

: The channel's full-scale value divided by the channel's resolution.
: The difference between the Max-Inst and Min-Inst values. 

Diff: The difference between the Max-RMS and Min-RMS values. 
: The channel's prefix and units. 

: The number and title of the channel. 

Events/Sensors Activity Summary 
: The state the channel started at, A=alarm, N=normal. 

channel ended at, A=alarm, N=normal. 
: The date and time the channel first changed state. 
: The date and time the channel last changed state. 

: The number of times the channel changed state. 
Description: The number and title of the channel. 

Events/Sensors Activity Log 
: The state of the channel at the triggered time, A=alarm, N=normal.

: The time the channel changed state. 
Description: The number and title of the channel. 

.xxx in the events/sensors activity summary indicates that the digital channel's 
state did not change from the initial state (Fst). 

Reposition the columns in the analog table, change the fields displayed in the combination 
view, change the background colors and trace colors; change the driver’s data type, change 
the trace/phasor scale multipliers and more refer to the fields below. 

Properties Menu Button  

  Reorder/Show/Hide the columns in the analog table.
Analog Combination Tab: Change the display positions in the analog combination 

view. 
Define the Comtrade format for saving, the date and time 
format for display and set automatic conversion from RMS 
data to Peak data when using the “Save As Comtrade” 
feature. 
Change the background colors and trace colors.
Format the save displayed values feature.

 Change the trace/phasor scale multipliers and set general 
display properties. 
Set the append/merge properties. 
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is displayed for SEL, DLP and Transcan files.  The fault information 
includes: Fault Type, Fault Time, Location, Targets, Triggers, Frequency, Event and 

annel's resolution. 

A=alarm, N=normal. 

.xxx in the events/sensors activity summary indicates that the digital channel's 

Reposition the columns in the analog table, change the fields displayed in the combination 
view, change the background colors and trace colors; change the driver’s data type, change 

Reorder/Show/Hide the columns in the analog table. 
Change the display positions in the analog combination 

format for saving, the date and time 
format for display and set automatic conversion from RMS 
data to Peak data when using the “Save As Comtrade” 

Change the background colors and trace colors. 
s feature. 

Change the trace/phasor scale multipliers and set general 
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 Driver Data Type: 

 Filters: 
 

 
Options: OK:  Apply the selected changes and redraw the 

Cancel:  Exit the dialog without executing the changes.
 
Comments: All data windows are defaulted to the display settings.  

the data type specified.
 
See Also:  Customizing the Analysis

Viewing Analog Data in the Analysis Quick Start

ZIP FILES 
Location: File Manager  
 
Description: Zip a group of files or a single file using the “Zip Marked Files” option under the “File” menu. 

All support files needed to display the selected files will be automatically included in the zip 
file.  Support files include 
(*.INF) files, DFR’s analog and digital information files such as: Hathaway DAU files, 
Rochester preamble and header files, Faxtrax/Director CTL files, Transcan SCF and TCF 
files. 

 

Activation: Direct: Right Click Pop
Menu: Alt-F, Z 

 
Fields: New Zip File Name: 

EncryptHeaders: 
 
Comments: To zip files, mark the desired files in the file table and select the “Zip M

from the “File” menu or right click on the file table and select the “Zip” 
pop-up menu.  All support files needed to display the file(s) are automatically included.

 
See Also: Zip Files in the File Manager Quick Start

ZOOMING 
Location: DXF Animated CAD 
 
Description: Change the DXF display viewing area.
 
Activation: Menu: Alt-V, I, O 

Direct: “+” & “-“ keys, Menu buttons 
 
Comments: To zoom in press the 

menu buttons to change the viewing area.  If the Max X and Max Y variables, inside the 
status bar, are at 32000 then this feature is not be available

ZOOM IN 
Location: DXF Animated CAD 

 Set the current display driver’s data type to Peak type or 
RMS calibrated. 
Define to delete spikes and set up spike properties.

Apply the selected changes and redraw the analysis window
Exit the dialog without executing the changes. 

All data windows are defaulted to the display settings.  The analog data columns depend on 
the data type specified. 

Analysis Display in the Analysis Quick Start 
Viewing Analog Data in the Analysis Quick Start 

Zip a group of files or a single file using the “Zip Marked Files” option under the “File” menu. 
All support files needed to display the selected files will be automatically included in the zip 
file.  Support files include Comtrade configuration (*.CFG), header (*.HDR) & information 
(*.INF) files, DFR’s analog and digital information files such as: Hathaway DAU files, 
Rochester preamble and header files, Faxtrax/Director CTL files, Transcan SCF and TCF 

Right Click Pop-up menu Button  

 Enter a path and name for the new zip file. 
Click to encryptheaders. 

To zip files, mark the desired files in the file table and select the “Zip Marked Files” option 

from the “File” menu or right click on the file table and select the “Zip” 
up menu.  All support files needed to display the file(s) are automatically included.

Zip Files in the File Manager Quick Start 

 

Change the DXF display viewing area. 

“ keys, Menu buttons  &  

To zoom in press the “+” key, to zoom out press the “-“ key or use the Zoom In and Out 
menu buttons to change the viewing area.  If the Max X and Max Y variables, inside the 
status bar, are at 32000 then this feature is not be available 

 

Set the current display driver’s data type to Peak type or 

Define to delete spikes and set up spike properties. 

analysis window. 

The analog data columns depend on 

Zip a group of files or a single file using the “Zip Marked Files” option under the “File” menu. 
All support files needed to display the selected files will be automatically included in the zip 

Comtrade configuration (*.CFG), header (*.HDR) & information 
(*.INF) files, DFR’s analog and digital information files such as: Hathaway DAU files, 
Rochester preamble and header files, Faxtrax/Director CTL files, Transcan SCF and TCF 

arked Files” option 

option from the 
up menu.  All support files needed to display the file(s) are automatically included. 

“ key or use the Zoom In and Out 
menu buttons to change the viewing area.  If the Max X and Max Y variables, inside the 
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Description: Increase the drawing's resolution by multiplying 2.5 with the current X, Y resolution. 
 

Activation: Direct: “+” key – Zoom in menu button  
Menu: Alt-V, I  

 
Comments: The Max X and Max Y variables inside the status bar are updated accordingly. 
 
Restrictions: The Max X and Max Y resolution values cannot exceed 32000. 

ZOOM OUT 
Location: DXF Animated CAD 
 
Description: Decrease the drawing's resolution by dividing 2.5 by the current X, Y resolution. 
 

Activation: Direct: “-” key – Zoom out menu button  
Menu: Alt-V, O  

 
Comments: The Max X and Max Y variables inside the status bar are updated accordingly. 

ZOOM X, Y RESOLUTION PROPERTIES 
Location: DXF Animated CAD 
 

Activation: Direct: F2 - Properties menu button  
Menu: Alt-T, D 

 
Description: Set the drawings max X and max Y resolution values. 
 

Max X Pixel:  The maximum X resolution value. 
Max Y Pixel:  The maximum Y resolution value. 

 
Range: Less than 32000 
  





 

 

Index 
 

A 

active topic-help ........................................................... 1 
adjust file time .............................................................. 1 
align channel data ........................................................ 1 
analog mark/unmark all ............................................ 1, 2 
analog table .................................................................. 2 
append log files ............................................................ 3 
append open files ......................................................... 3 
append waveform files.................................................. 4 
as status field ............................................................... 5 
ascending sort .............................................................. 4 
ascii editor .................................................................... 4 

new file ................................................................... 48 
open file ................................................................. 49 
paste text ............................................................... 49 

ASCII event file ............................................................. 5 
copy text ................................................................. 16 
cut text ................................................................... 16 
delete text .............................................................. 18 
print ........................................................................ 52 
save as ................................................................... 59 

ASCII terminal mode .................................................... 5 
at file ............................................................................. 6 
atrec ............................................................................. 6 
attab ............................................................................. 6 
audio wave driver ......................................................... 6 
auto detect .................................................................... 6 
auto scale ..................................................................... 6 

B 

background color .......................................................... 7 
channels ................................................................. 11 

binary event file ............................................................ 7 
print ........................................................................ 52 
save as ................................................................... 59 
save as text ............................................................ 59 

binary terminal mode .................................................... 7 

C 

calibration report ........................................................... 8 
change device configuration ......................................... 8 
change dxf files ............................................................ 9 
change frequency ....................................................... 10 
change passwords ..................................................... 10 
change path .................................................................. 9 
change query operator ............................................... 11 
changes ...................................................................... 79 
channel information .............................................. 11, 66 
clear analog colors ..................................................... 12 
clear query criteria ...................................................... 12 
combination view ........................................................ 12 
combine log files ......................................................... 12 
comname properties ................................................... 13 
comname(s) rename .................................................. 13 

company name........................................................... 14 
compress comtrade files ............................................ 14 
comtrade .............................................................. 14, 50 
condense time ............................................................ 14 
copy device records ................................................... 15 
copy files .................................................................... 15 
copy text ..................................................................... 16 
create directory .......................................................... 16 
cut text ....................................................................... 16 
cut/copy/paste files ..................................................... 15 
cycle hop .................................................................... 17 

D 

d&t status field............................................................ 17 
data bar ...................................................................... 17 
data display 

adjust file time .......................................................... 1 
align channel data .................................................... 1 
analog mark/unmark all ....................................... 1, 2 
analog table ............................................................. 2 
append open files .................................................... 3 
as status field ........................................................... 5 
auto scale ................................................................ 6 
change frequency .................................................. 10 
channel background color ...................................... 11 
channel information ......................................... 11, 66 
clear analog colors ................................................. 12 
combination view ................................................... 12 
condense time ....................................................... 14 
cycle hop ............................................................... 17 
d&t status field ....................................................... 17 
data bar ................................................................. 17 
decrease amplitude ............................................... 17 
delta x .................................................................... 19 
delta y .................................................................... 19 
digital mark/unmark all ........................................... 20 
driver data type ...................................................... 23 
duplicate cycles ..................................................... 23 
email active file ...................................................... 27 
expand time ........................................................... 28 
fault bar .................................................................. 29 
fault reference time bar .......................................... 30 
freq status field ...................................................... 31 
group marked analog channels.............................. 33 
harmonic vectors ................................................... 34 
harmonics table ..................................................... 34 
hide marked channels ............................................ 35 
histogram ............................................................... 35 
horizontal bars ....................................................... 36 
increase amplitude ................................................. 37 
instpeak column ..................................................... 38 
instval column ........................................................ 38 
mark change in sign ............................................... 41 
mark peaks ............................................................ 41 
mark raw samples .................................................. 41 
mark/unmark all ..................................................... 40 
maxpeak column .................................................... 42 



 

 

maxval column ....................................................... 42 
maxwin column ...................................................... 43 
medium display ...................................................... 43 
merge open files .................................................... 43 
minpeak column ..................................................... 44 
minval column ........................................................ 44 
move reference bar to data bar .............................. 45 
move rms bar to reference bar ............................... 45 
phasor/circular chart scale multiplier ...................... 50 
pixsdisp column ..................................................... 50 
predefined views .................................................... 62 
primary values ........................................................ 51 
print ........................................................................ 51 
recorder channels .................................................. 53 
reference bar .......................................................... 54 
refval column .......................................................... 54 
reopen waveform file .............................................. 55 
resize sliding window ............................................. 56 
restore channels .................................................... 56 
restore original file .................................................. 56 
rms bar ................................................................... 57 
rmsval column ........................................................ 57 
sample based ......................................................... 58 
save displayed values ............................................ 60 
save user views ..................................................... 60 
secondary values ................................................... 61 
select lines/views ................................................... 62 
select user views .................................................... 62 
set opening frequency ............................................ 64 
shift marks down .................................................... 65 
shift marks up ......................................................... 65 
show all digital ........................................................ 66 
show all hidden channels ....................................... 66 
single ended fault location ...................................... 67 
software analog channels ...................................... 68 
software digital channels ........................................ 69 
super impose ......................................................... 71 
sync data cursors ................................................... 71 
time based ............................................................. 73 
total harmonics distortion ....................................... 74 
trace scale multiplier .............................................. 75 
truerms ................................................................... 76 
truncate cycles ....................................................... 76 
view mark(s) ........................................................... 77 
view raw data file ................................................... 78 
waveform summary ................................................ 78 
window properties .................................................. 79 

database viewer 
comma delimited .................................................... 12 
double quoted comma delimited ............................ 21 
tab delimited ........................................................... 72 

decrease amplitude .................................................... 17 
delete channels .......................................................... 35 
delete devices ............................................................ 18 
delete files .................................................................. 18 
delete text ................................................................... 18 
delta x ......................................................................... 19 
delta y ......................................................................... 19 
descending sort .......................................................... 19 
device field ................................................................. 20 
device manager 

animated cad-dxf ..................................................... 3 

ASCII event files ...................................................... 5 
ASCII terminal mode ................................................ 5 
atrec ......................................................................... 6 
bianry event file ........................................................ 7 
binary terminal mode ............................................... 7 
change device configuration .................................... 8 
change dxf files ........................................................ 9 
change passwords ................................................. 10 
copy device records ............................................... 15 
delete devices ........................................................ 18 
display dialog ......................................................... 20 
duplicate device ..................................................... 23 
dxf animated cad ................................................... 25 
edit device ............................................................. 26 
export ..................................................................... 29 
flip marks ............................................................... 30 
ftp connection ........................................................ 32 
function keys .......................................................... 33 
import ..................................................................... 37 
multiport interrogation display ................................ 46 
new configuration ............................................. 46, 47 
new device ............................................................. 47 
paste device records .............................................. 49 
resize columns ....................................................... 55 
save and archive dialog ......................................... 58 
sort ......................................................................... 19 
sort devices............................................................ 69 
sort field ................................................................. 69 
sort marked rows ................................................... 70 
tcp/ip connection .................................................... 73 
test devices ............................................................ 73 
totfiles status field .................................................. 74 
un/mark .................................................................. 77 
unmark marks ........................................................ 77 

digital mark/unmark all ............................................... 20 
digital state ................................................................. 79 
display dialog ............................................................. 20 
disturbance report ...................................................... 21 
dlp1/dlp3 .................................................................... 21 
drawing properties ...................................................... 22 
driver 

audio wave............................................................... 6 
driver column.............................................................. 22 
driver configuration ..................................................... 22 
driver data type .......................................................... 23 
drivers 

ascii ......................................................................... 4 
auto detect ............................................................... 6 
comma delimited table ........................................... 12 
comtrade ................................................................ 14 
configuration .......................................................... 22 
dfr I II IIB ...................................................... 2, 20, 38 
dlp1/dlp3 ................................................................ 21 
double quotes/comma delimited table ................... 21 
dxf .......................................................................... 25 
faxtrax & director .................................................... 30 
hexadecimal........................................................... 35 
mdar/rel 301/302 .................................................... 43 
RFL ........................................................................ 57 
sel load profile........................................................ 61 
sel relay ................................................................. 62 
tab delimited .......................................................... 72 



 

 

tesla ............................... 8, 28, 31, 39, 55, 70, 72, 75 
tis 73 
tpu/dup/gpu ............................................................ 75 
transcan ................................................................. 75 

duplicate cycles .......................................................... 23 
duplicate device .......................................................... 23 
dvreport.dtb .................................................................. 8 
dxf animated cad ........................................................ 25 

animated display ...................................................... 3 
attab ......................................................................... 6 
background color ..................................................... 7 
change dxf files ........................................................ 9 
drawing properties ................................................. 22 
dxf control .............................................................. 25 
max x pixels ........................................................... 42 
max y pixels ........................................................... 42 
print ........................................................................ 52 
set drawing properties ............................................ 64 
size to original ........................................................ 68 
size to window ........................................................ 68 
tottabs .................................................................... 74 
zoom in .................................................................. 80 
zoom out ................................................................ 81 
zoom x, y resolution constant ................................. 81 
zooming ................................................................. 80 

dxf control ................................................................... 25 
dxf display .................................................................. 25 

E 

edit dau-def ................................................................ 26 
edit device .................................................................. 26 
email active file ........................................................... 27 
email files ................................................................... 27 
equal to....................................................................... 28 
expand time ................................................................ 28 
export ......................................................................... 29 

F 

fault bar ...................................................................... 29 
fault date column ........................................................ 29 
fault information .......................................................... 79 
fault location ............................................................... 67 
fault reference time bar............................................... 30 
fault time ..................................................................... 78 
fault time column ........................................................ 30 
faxtrax & director ........................................................ 30 
file manager 

append log files ........................................................ 3 
append waveform files ............................................. 4 
ascii driver ................................................................ 4 
ascii editor ................................................................ 4 
at file ........................................................................ 6 
audio wave driver ..................................................... 6 
auto detect driver ..................................................... 6 
calibration report ...................................................... 8 
change path ............................................................. 9 
combine log files .................................................... 12 
comname properties .............................................. 13 
comname(s) rename .............................................. 13 
company column .................................................... 14 
compress comtrade files ........................................ 14 

comtrade driver ...................................................... 14 
copy files ................................................................ 15 
create directory ...................................................... 16 
cut/copy/paste files ................................................ 15 
delete files ............................................................. 18 
device column ........................................................ 19 
dfr I II IIB & 2000 driver ................................ 2, 20, 38 
disturbance report .................................................. 21 
dlp1/dlp3 driver ...................................................... 21 
driver column ......................................................... 22 
driver configuration ................................................ 22 
dxf driver ................................................................ 25 
edit dau-def ............................................................ 26 
email files ............................................................... 27 
fault date column ................................................... 29 
fault time column .................................................... 30 
faxtrax & director driver .......................................... 30 
file name column .................................................... 30 
folder tree .............................................................. 31 
free status field ...................................................... 31 
f-type column ......................................................... 29 
group marked rows ................................................ 33 
hexadecimal driver ................................................. 35 
hexadecimal editor ................................................. 35 
mark all .................................................................. 40 
mark/unmark rows ................................................. 41 
mdar/rel 301/302 driver .......................................... 43 
merge waveform files ............................................. 44 
move files ........................................................ 45, 51 
mrksize status field ................................................ 46 
open all marked waveform files ............................. 48 
optional columns .................................................... 49 
print ........................................................................ 52 
refresh directory ..................................................... 54 
rename file ............................................................. 55 
reports 

calibration ............................................................ 8 
RFL9300 driver ...................................................... 57 
run applications ...................................................... 57 
save as comtrade .................................................. 59 
save date column ................................................... 60 
save time column ................................................... 60 
sel load profile driver .............................................. 61 
sel relay driver ....................................................... 62 
set sort field ........................................................... 65 
show/hide channel titles ......................................... 65 
size column ............................................................ 68 
size status field ...................................................... 68 
soe list ................................................................... 63 
soe summary ......................................................... 63 
tab delimited driver ................................................ 72 
tesla driver ..................... 8, 28, 31, 39, 55, 70, 72, 75 
tis driver ................................................................. 73 
totfiles status field .................................................. 74 
totmarks status field ............................................... 74 
tpu/dup/gpu driver .................................................. 75 
transcan driver ....................................................... 75 
type column ........................................................... 76 
waveform file.......................................................... 78 
waveform summary ............................................... 78 
zip files ................................................................... 80 

file name column ........................................................ 30 



 

 

file size ....................................................................... 78 
filename ...................................................................... 78 
flip marks .................................................................... 30 
folder tree ................................................................... 31 
free status field ........................................................... 31 
freq status field ........................................................... 31 
Fst ........................................................................ 32, 79 
fst-change ............................................................. 32, 79 
ftp connection ............................................................. 32 
f-type column .............................................................. 29 
function keys .............................................................. 33 

G 

group marked analog channels .................................. 33 
group marked rows ..................................................... 33 

H 

harmonics 
histogram ............................................................... 35 
table ....................................................................... 34 
vectors ................................................................... 34 

help ........................................................................ 1, 34 
hexadecimal editor ..................................................... 35 
hide marked channels ................................................ 35 
histogram .................................................................... 35 
horizontal bars ............................................................ 36 
hp-dif .......................................................................... 36 
hpeak-dn .............................................................. 36, 79 
hpeak-up .............................................................. 37, 79 

I 

IEEE long file name .................................................... 37 
import ......................................................................... 37 
increase amplitude ..................................................... 37 
insert channels ........................................................... 56 
instpeak column ......................................................... 38 
instval column ............................................................. 38 

L 

latitude field ................................................................ 38 
less than ..................................................................... 38 
log files 

append ..................................................................... 3 
combine ................................................................. 12 

long file name 
company field ......................................................... 14 
device field ............................................................. 20 
latitude field ............................................................ 38 
start date field ........................................................ 70 
start time field ......................................................... 70 
substation field ....................................................... 71 
system files ............................................................ 72 
tcode field ............................................................... 72 

long filename 
company column .................................................... 14 
device column ........................................................ 19 
optional columns .................................................... 49 

lp-dif ........................................................................... 39 
lpeak-dn................................................................ 39, 79 

lpeak-up ............................................................... 39, 79 
Lst ........................................................................ 40, 79 
lst-change ............................................................ 40, 79 

M 

mark all rows .............................................................. 40 
mark change in sign ................................................... 41 
mark peaks ................................................................ 41 
mark raw samples ...................................................... 41 
mark/unmark all channels .......................................... 40 
mark/unmark rows ...................................................... 41 
max x pixels ............................................................... 42 
max y pixels ............................................................... 42 
maxpeak column ........................................................ 42 
maxval column ........................................................... 42 
maxwin column .......................................................... 43 
mdar/rel 301/302 ........................................................ 43 
medium display .......................................................... 43 
merge open files......................................................... 43 
merge waveform files ................................................. 44 
minpeak column ......................................................... 44 
minval column ............................................................ 44 
move files ............................................................. 45, 51 
move reference bar to data bar .................................. 45 
move rms bar to reference bar ................................... 45 
mrksize status field ..................................................... 46 
multiport interrogation display .................................... 46 

N 

new configuration ................................................. 46, 47 
new device ................................................................. 47 
new file ....................................................................... 48 

O 

onebit ................................................................... 48, 79 
open all marked waveform files .................................. 48 
open file ..................................................................... 49 

P 

paste device records .................................................. 49 
paste text ................................................................... 49 
path/filename (no ext.) ............................................... 50 
phasor/circular chart scale multiplier .......................... 50 
pixsdisp ................................................................ 50, 75 
pixsdisp column.......................................................... 50 
predefined views ........................................................ 62 
prefault time ............................................................... 78 
primary values ............................................................ 51 
print 

ascii event file ........................................................ 52 
binary event file ...................................................... 52 
data display............................................................ 51 
dxf animated cad ................................................... 52 
file manager ........................................................... 52 
printer setup ........................................................... 52 

printer setup ............................................................... 52 
process time ............................................................... 78 
pU .............................................................................. 79 



 

 

Q 

query all rows ............................................................. 52 
query fields 

change query operator ........................................... 11 
clear query criteria ................................................. 12 
equal to .................................................................. 28 
less than ................................................................. 38 
query all rows ......................................................... 52 
query marked rows ................................................ 53 
query unmarked rows............................................. 53 

query marked rows ..................................................... 53 
query unmarked rows ................................................. 53 

R 

recorder channels ....................................................... 53 
reference bar .............................................................. 54 
reference time bar ...................................................... 30 
refresh directory ......................................................... 54 
refval column .............................................................. 54 
rename file .................................................................. 55 
reopen waveform file .................................................. 55 
reports 

append log files ........................................................ 3 
calibration ................................................................. 8 
combine log files .................................................... 12 
soe list .................................................................... 63 
soe summary ......................................................... 63 

reposition channels .................................................... 65 
resize columns ........................................................... 55 
resize sliding window .................................................. 56 
restore channels ......................................................... 56 
restore original file ...................................................... 56 
RFL ............................................................................ 57 
rms bar ....................................................................... 57 
rmsval column ............................................................ 57 
run dialog .................................................................... 57 

S 

sample based display ................................................. 58 
save and archive dialog .............................................. 58 
save as ....................................................................... 59 
save as comtrade 

data display ............................................................ 59 
file manager ........................................................... 59 
path/filename (no ext.) ........................................... 50 

save as text ................................................................ 59 
save date column ....................................................... 60 
save displayed values ................................................ 60 
save time .................................................................... 78 
save time column ....................................................... 60 
save user views .......................................................... 60 
scaling ...................................................... 14, 18, 28, 37 
secondary values ....................................................... 61 
sel load profile driver .................................................. 61 
sel relay driver ............................................................ 62 
select lines/views ........................................................ 62 
select user views ........................................................ 62 
set drawing properties ................................................ 64 
set opening frequency ................................................ 64 
set sort field ................................................................ 65 

show all channels ....................................................... 66 
show all digital channels ............................................ 66 
show/hide channel titles ............................................. 65 
single ended fault location .......................................... 67 
size column ................................................................ 68 
size status field........................................................... 68 
size to original ............................................................ 68 
size to window ............................................................ 68 
soe list ........................................................................ 63 
soe summary.............................................................. 63 
software analog channels .......................................... 68 
software digital channels ............................................ 69 
sort ......................................................................... 4, 19 
sort devices ................................................................ 69 
sort field ..................................................................... 69 
sort marked rows ........................................................ 70 
start date field............................................................. 70 
start time field ............................................................. 70 
station ........................................................................ 78 
substation field ........................................................... 71 
super impose.............................................................. 71 
sync data cursors ....................................................... 71 
system files ................................................................ 72 

T 

tcode field ................................................................... 72 
tcp/ip connection ........................................................ 73 
tesla driver ......................... 8, 28, 31, 39, 55, 70, 72, 75 
test devices ................................................................ 73 
time based display ..................................................... 73 
tis driver ..................................................................... 73 
total harmonics distortion ........................................... 74 
totfiles status field ....................................................... 74 
totmarks status field ................................................... 74 
tottabs ........................................................................ 74 
tpu/dup/gpu driver ...................................................... 75 
trace scale multiplier .................................................. 75 
transcan driver ........................................................... 75 
trigger time ........................................................... 76, 79 
truerms (samples) ...................................................... 76 
truncate cycles ........................................................... 76 
type column ................................................................ 76 

U 

un/mark file ................................................................ 77 
unmark marked files ................................................... 77 

V 

view marked channels ................................................ 77 
view raw data file ........................................................ 78 

W 

waveform file .............................................................. 78 
waveform files 

append ..................................................................... 4 
waveform summary .................................................... 78 

changes ................................................................. 79 
description ............................................................. 79 
digital state............................................................. 79 



 

 

end date & time ...................................................... 78 
fault information ..................................................... 79 
file duration ............................................................ 78 
file size ................................................................... 78 
filename ................................................................. 78 
Fst .................................................................... 32, 79 
fst-change ........................................................ 32, 79 
hp-dif ...................................................................... 36 
hpeak-dn .......................................................... 36, 79 
hpeak-up .......................................................... 37, 79 
line frequency ......................................................... 78 
lp-dif ....................................................................... 39 
lpeak-dn ........................................................... 39, 79 
lpeak-up ........................................................... 39, 79 
Lst .................................................................... 40, 79 
lst-change ........................................................ 40, 79 
onebit ............................................................... 48, 79 
prefault time ........................................................... 78 

process time .......................................................... 78 
PU .......................................................................... 79 
sampling frequency ................................................ 78 
save time ............................................................... 78 
start date & time ..................................................... 78 
station .................................................................... 78 
trigger time ....................................................... 76, 79 

window properties ...................................................... 79 

Z 

zip files ....................................................................... 80 
zoom 

dxf animated cad ................................................... 80 
zoom in ...................................................................... 80 
zoom out .................................................................... 81 
zoom x, y resolution constant ..................................... 81 

 



 

 



 

 

Notes 



 

 

Notes 



 

 

Notes 


	CHAPTER 1
	Fields & Features
	Active Topic - Help
	Adjust Files Time
	Align Channel Data
	Ametek TR*/DL*/PQR128 Driver
	Analog Mark/Unmark All
	Analog Table View
	Animated CAD- DXF
	Append Logs
	Append Open Files
	Append Waveform Files
	Ascending Sort
	ASCII Driver
	ASCII Editor
	ASCII Event Files
	ASCII Terminal Mode
	AS Status Field
	AtFile
	AtRec
	AtTab
	Audio Wave Driver
	Auto Detect Driver
	Auto Scaling
	Background Color
	Binary Event File
	Binary Terminal Mode
	BPRO Driver
	Calibration Report
	Change Device Configuration
	Change Drive/Directory
	Change DXF Files
	Change Frequency
	Change Passwords
	Change Query Operators
	Channel Background Color
	Channel Information (On/Off)
	Clear Analog Colors
	Clear Query Area
	Combine Logs
	Combined View
	Comma Delimited Table Driver
	ComName Properties
	ComName(s) Rename
	Company Column
	Company Name (Save & Archive)
	Compress COMTRADE Files
	COMTRADE Driver
	Condense Time
	Copy/Cut/Paste Files
	Copy Device Records
	Copy Files
	Copy Text
	Create Directory
	Cut Text
	Cycle Hop
	D&T
	Data Bar
	Decrease Amplitude
	Delete Devices
	Delete Files
	Delete Text
	Delta X
	Delta Y
	Descending Sort
	Device Column
	Device Field
	DFR I II IIB & 2000 Driver
	Digital Mark/Unmark All
	Display Dialog
	Disturbance Report
	DLP1/DLP3 Driver
	Double Quotes/Comma Delimited Table Driver
	Drawing Properties
	Driver Column
	Driver Configuration Dialog
	Driver Data Type
	Duplicate Cycles
	Duplicate Device Record
	DXF Animated CAD
	DXF Control Dialog
	DXF Driver
	Edit DAU-DEF
	Edit Device Record
	Email Files
	EMAX Long Term Driver
	Equal To (=)
	Expand Time
	Export
	F-Type Column
	Fault Bar
	Fault Date Column
	Fault Reference Time Bar
	Fault Time Column
	Faxtrax II (12-bit) & Director Driver
	File Name Column
	Flip Marks
	Folder Tree
	FPRO Driver
	Free
	Fs
	Fst
	Fst-Change
	FTP Connection
	Function Keys
	Group Marked Analog Channels
	Group Marked Rows
	Harmonics Table
	Harmonic Vectors
	Help
	Hexadecimal Editor
	Hexadecimal Driver
	Hide Mark(s)
	Histogram
	Horizontal Bars
	HP-Dif
	HPeak-Dn
	HPeak-Up
	IEEE Long File Naming Format
	Import
	Increase Amplitude
	InstPeak Column
	InstVal Column
	IntelliRupter Driver
	Latitude Field
	Less Than (<)
	LP-Dif
	LPeak-Dn
	LPeak-Up
	LPRO Driver
	Lst
	Lst-Change
	Mark All Rows
	Mark/Unmark All Channels
	Mark/Unmark Row
	Mark Change in Sign
	Mark Peak Values
	Mark Raw Values
	Max X Pixels
	Max Y Pixels
	MaxPeak Column
	MaxVal Column
	MaxWin Column
	MDAR REL 301/302 Driver
	Medium Display
	Merge Open Files
	Merge Waveform Files
	MinPeak Column
	MinVal Column
	Move Files
	Move RMS Bar to Reference Bar
	Move Reference Bar to Data Bar
	MrkSize
	Multiport Interrogation Display (MID)
	New Device Configuration
	New Device Record
	New Device Configuration
	New File
	OneBit
	Open All Marked Waveform Files
	Open File
	Optional Columns
	Paste Device Records
	Paste Text
	Path/Filename (No Ext.)
	Phasor/Circular Chart Scale Multiplier (ASM)
	PixsDisp Column
	Play Channels Audio
	Primary Values
	Print All Data
	Print All Rows
	Print DXF File
	Printer Setup
	Print File
	Query All Rows
	Query Marked Rows
	Query Unmarked Rows
	Recorded Channels
	Reference Bar
	Refresh
	RefVal Column
	Rename File/Directory
	Reopen Waveform File
	Replay Plus Driver
	Resize Columns
	Resize Sliding Window
	Restore Mark(s)
	Restore Original
	RFL 9300 Driver
	RMS Column
	RMS Bar
	Run
	Sample Based Display
	Save & Archive Dialog
	Save As
	Save As COMTRADE (ASCII/Binary)
	Save As Text
	Save Date Column
	Save Displayed Values (Default Format)
	Save Time Column
	Save User Views
	Secondary Values
	SEL Load Profile Driver
	SEL Relay Driver
	Select Lines/Views
	Select User Views
	Sequence of Events List
	Sequence of Events Summary
	Set Drawing Properties
	Set Opening Frequency
	Set Sort Field
	Shift Marks Down
	Shift Marks Up
	Show/Hide Channel Titles
	Show All Digital Channels
	Show All Hidden
	Show Channel Information
	Single Ended Fault Location
	Size
	Size Column
	Size To Original Coordinates
	Size To Window
	Software Analog Channels
	Software Digital Channels
	Sort All Rows
	Sort Field
	Sort Marked Rows
	SR745/489 Driver
	Start Date Field
	Start Time Field
	Substation Field
	Super Impose
	Sync Data Cursors
	System Files
	Tab Delimited Table Driver
	TCode Field
	Tesla Driver
	TCP/IP Client
	Test Ports
	Time Based Display
	TIS Driver
	Total Harmonics Distortion
	TotFiles
	TotMarks
	TotRecs
	TotTabs
	TPRO Driver
	TPU/DPU/GPU Driver
	Trace Scale Multiplier (ASM)
	Transcan Driver
	Trigger-Time
	TrueRMS
	Truncate Cycles
	Type Column
	Un/Mark Rows
	Unmark Marks
	View Mark(s)
	View Raw Data File
	Waveform Data
	Waveform Summary
	Window Properties
	Zip Files
	Zooming
	Zoom In
	Zoom Out
	Zoom X, Y Resolution Properties



